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 Typefi Publish Overview 1

Typefi® Publish is a platform for professional, design-driven automated 
publishing, built on industry-standard tools and technologies. It provides 
a scalable solution for authoring and publishing more efficiently and cost-
effectively, without sacrificing design or typographic quality.

The five key components of Typefi Publish are the Typefi Publish Server, Typefi 
Engine and Adobe® InDesign® Server, Typefi Designer plug-ins for Adobe InDesign, 
Typefi Writer add-in for Microsoft® Word and the Typefi FileManager.

Typefi Publish Server
Typefi Publish Server is the web-based interface that makes it easy to set up 
publishing projects, manage project content and monitor the Typefi Publish 
composition workflow. Projects and their assets (templates, content, images, job 
options, jobs) can be defined, accessed or monitored throughout the publishing 
cycle using Server. Users access documents through a simple check-in and check-
out process.

Typefi Engine and Adobe InDesign Server
The Typefi Engine is the core component behind Typefi’s page composition. The 
Engine produces richly-formatted InDesign pages using template-driven page 
composition augmented with layout rules. PDF previews and final edition InDesign 
documents are generated within Adobe InDesign Server.
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Typefi Designer
Typefi Designer is a set of plug-ins for Adobe InDesign that enable production 
designers to develop intelligent layouts, without sacrificing professional design 
quality or requiring complex coding. By embedding layout rules and dynamic 
elements directly into InDesign templates, designs can be rapidly prototyped and 
adjusted to accommodate highly variable content.

With Typefi Designer installed, production designers can use the Typefi panels 
(including the Typefi AutoFit tool), preferences, menu and contextual commands 
to design dynamic InDesign templates.

Typefi Writer
Typefi Writer is an add-in for Microsoft Word that makes it simple to mark up 
Word documents for use with Typefi Publish. When the Typefi Writer is installed 
as an add-in for Microsoft Word, a Typefi menu and toolbar are added to the 
Word interface that provide tools for inserting Typefi markup; viewing document 
properties; printing full-designed documents to PDF format; and more. Typefi 
Writer makes it easy for authors to create structured, publish-ready content in 
Word.

Typefi FileManager
The FileManager is a small Java-based helper application that handles all file 
transfers to and from the Typefi Publish Server and enables communication 
between Typefi Writer and Typefi Publish Server (incl. monitoring Typefi Print job 
progress).

The FileManager is automatically included with Typefi Writer and Designer client 
installs and is configured to launch at system startup.

Production designer:  term used throughout this User Guide for those 
working on the production of dynamic InDesign templates developed 
with Typefi Designer and InDesign tools.

Author:  this term is used throughout this User Guide and includes 
content authors, editors, sub-editors or writers. 
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New Features in Version 5
This describes the new features in Typefi Server V5.

 ■ External Database Support
 ■ Run Jobs with Custom XML
 ■ Simplified User Interface for XSL based jobs
 ■ Dynamic Job Log Monitoring
 ■ View Server Log from Browser
 ■ General User Interface Improvements
 ■ WSI – Run jobs without using a defined project

INSTALLATION WARNING

It is highly recommended that you remove your /context/conf/generated.
properties file prior to installing V5 Server. The uninstaller does not delete this 
file in order to make upgrades easier. However, upgrading to V5 is a much larger 
process than typical maintenance releases. If you do not delete this file prior to 
installing V5, the Typefi Server will automatically update the existing HyperSQL 
DB database. This may not be what you desire. If instead you use the Migrate 
tool you can ensure that you create a new copy of your database without 
affecting your V4 database.

External Database Support
Prior to V5, the Typefi Server only supported the use of an embedded HyperSQL 
DB database. With this release the Server can now use MySQL and PostgreSQL 
databases as well as the built-in HyperSQL. Supporting other database servers The MySQL server configuration dialog.

What’s New
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allows larger installations to better manage their database environments than the 
built-in HyperSQL database.

The type of database used is configured during Server initialization. A ‘migrate’ 
utility is also provided to move existing Typefi Publish installations to an external 
database.

Configuring MySQL
The database type menu determines which database server to use. The default is 
Built In (HyperSQL). Selecting MySQL shows the following configuration options. 

JDBC Host is the IP address or Hostname of the server where the MySQL server is 
located.

JDBC Port is the port to connect on. The default is 3306 for MySQL.

Database Name allows you to change the database name used by the Typefi 
Server to avoid conflicts with other applications. 

Database User & Database Password are used to connect to the MySQL server.

The other new field, “XSL Support Files Location”, will be described later.

When you click Initialize Server, the connection credentials will be verified and you 
will be asked to confirm creation of the database and filestore.

The confirmation alert will indicate if the database or file paths do not exist.

Click OK to confirm creation of the database and/or filestore paths.

PostgreSQL Configuration
The PostgreSQL configuration page is similar to that for MySQL.

The default port for PostgreSQL is 5432. 

As with MySQL, you will be asked to confirm initialization if the database and/or 
file paths do not exist.

Built-In Database Configuration
Configuring the Built-In HyperSQL database is similar to previous releases.

Confirming the information entered during MySQL configuration

The PostgreSQL configuration dialog
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For V5, the default storage location for the filestore and database has been 
changed to use a Typefi folder at the root of your hard drive rather than a directory 
in the application folder. This avoids permission problems on Windows machines. 

Migrating an Existing Database
The database schema has changed for V5. A migrate utility is provided as part of 
the Typefi Publish Server install that facilitates moving your V3 or V4 database for 
use with V5. 

The migrate utility is run from a command line and must be executed prior to 
initializing the Server.

USAGE

usage: migrate [-s HSQLDB path] destination-db-options

-d,--dir         Target directory to store HSQLDB files.
  Required if type = hsqldb
 -e,--export      Optional. Export only. No import is done
 -h,--host        Host where database server is located
                 (ex: localhost).
                  Note that port can be added onto host if
                  necessary. Not used if dbtype = hsqldb
 -n,--dbname      Optional. Destination database name
                  (default: tpss). Not used if 
                  dbtype = hsqldb
 -p,--password    Database user password. 
                  Not used if dbtype = hsqldb
 -s,--srcdb       Source HSQLDB path
 -t,--dbtype      Database type. One of: 
                  [postgresql | mysql | hsqldb]
 -u,--user        Database user name.  
                  Not used if dbtype = hsqldb
 -w,--workdir     Optional. Where to store SQL files. 
                  (default: /Typefi//Migrate)

This migrates and upgrades data from a V3 or V4 HSQLDB database into a MySQL, 
PostgreSQL or HyperSQL database.

Examples:

Migrate to a MySQL database on localhost using a user name of ‘root’

The Built-in HyperSQL configuration dialog
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  migrate -s “/Program Files/Typefi/Publish/Database” -h localhost -t 
mysql -u root -p 12345678

Migrate to a PostgreSQL database named ‘typefi’ on localhost using a user name 
of ‘root’.

  migrate -s “/Program Files/Typefi/Publish/Database” -h localhost -t 
postgresql -u root -p 12345678 -n typefi

Migrate to HyperSQL with files stored in /Typefi/Publish/Database.

  migrate -s “/Program Files/Typefi/Publish/Database” -t hsqldb -d “/
Typefi/Publish/Database”

The migrate tool will create 4 SQL files in the working directory. 

  TPS-S0-SchemaDDL.sql      -- Schema definition for target database
  TPS-S1-CreateSchema.sql   -- Drops existing tables & creates new 
tables. No constraints are created at this stage.
  TPS-S2-PopulateTables.sql -- INSERT commands to populate tables
  TPS-S3-PostImport.sql     -- Applies constraints on tables

Additionally there may be “.bin” files created in the working directory. These files 
contain binary data stored in the ASSET table and are created when migrating to 
MySQL or PostgreSQL. When migrating to HyperSQL the .bin files are not used as 
the binary data is stored as hex bytes within the PopulateTables.sql commands.

During the migration the utility will log status messages back to the command 
prompt. Note that if the migrate fails for any reason, the best thing to do is to use 
the administration utility that is provided with the database server and drop the 
database that may have been created.

For example, with MySQL:

MyMac:bin $ /usr/local/mysql/bin/mysql -u root -p 
Enter password: 
Welcome to the MySQL monitor.  Commands end with ; or \g.
Your MySQL connection id is 1459
Server version: 5.1.51 MySQL Community Server (GPL)
Copyright (c) 2000, 2010, Oracle and/or its affiliates. All rights 
reserved.
This software comes with ABSOLUTELY NO WARRANTY. This is free 
software,
and you are welcome to modify and redistribute it under the GPL v2 
license
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Type ‘help;’ or ‘\h’ for help. Type ‘\c’ to clear the current input 
statement.
mysql> show databases;
+--------------------+
| Database           |
+--------------------+
| information_schema |
| bug4317            |
| mysql              |
| test               |
| tpss               |
+--------------------+
5 rows in set (0.00 sec)
mysql> drop database test;
Query OK, 0 rows affected (0.13 sec)
mysql> show databases;
+--------------------+
| Database           |
+--------------------+
| information_schema |
| bug4317            |
| mysql              |
| tpss               |
+--------------------+
4 rows in set (0.00 sec)
mysql> quit
Bye
MyMac:bin $

In the event you receive an out of memory error during the migration, drop the 
target database (if it exists) and edit the ‘migrate’ (Mac) or ‘migrate.bat’ (Windows) 
command file and increase the –Xmx1024m value. The default of 1024 MB should 
accommodate most databases.

Run Jobs with Custom XML
Some sites use custom XSL transformations to paginate XML that does not follow 
the CXML schema. Prior to V5 this required an extra process be executed before 
running a job. V5 makes this process easier.
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XSL Support Files
During Server initialization you specify a location to store XSL Support Files. By 
default this is /Typefi/Publish/XML. 

The Server will create 3 sub-folders within the XML directory: Catalogs, Library, and 
Transforms. 

The Catalogs directory is where XML catalog files are stored. Using XML catalogs is 
optional, but it can make manipulation of XML files faster and easier. XML Catalogs 
are generally used to redirect schema URLs to a local file. For example, you may 
have XML that has a DOCTYPE like: <!DOCTYPE book SYSTEM “book.dtd”>. Rather 
than relying on network access to locate the book DTD you can cache the DTD on 
the server machine and configure a catalog to redirect the URL to the local cache. 
For example,

<?xml version=”1.0” encoding=”UTF-8”?>
<catalog xmlns=”urn:oasis:names:tc:entity:xmlns:xml:catalog”>
 <systemSuffix systemIdSuffix=”book.dtd” uri=”file:///Typefi/
Publish/XML/Library/nlm2cxml/DTD/book/2.3/book.dtd”/>
 <systemSuffix systemIdSuffix=”journalpublishing.dtd” uri=”file:///
Typefi/Publish/XML/Library/nlm2cxml/DTD/journalpublishing/2.3/
journalpublishing.dtd”/>
</catalog>

 Catalog files are described further here: http://www.oasis-open.org/committees/
entity/spec-2001-08-06.html

The Transforms directory is where you place your XSL transformations.

The Library directory can be used to store files that are shared across multiple XSL 
transformations.

The Typefi Server has one collection of XSL files but each project can be 
configured to use a subset of that collection. 

Defining XSL Files
XSL files that convert non-Typefi XML into CXML are placed in the Transforms 
directory. 

An XSL file can include other XSL files using the <xsl:include> command. To 
include a file located in the Library directory use a path like:

%20http://www.oasis-open.org/committees/entity/spec-2001-08-06.html
%20http://www.oasis-open.org/committees/entity/spec-2001-08-06.html
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<xsl:include href=”../Library/allIncludes.xsl”/>

Paths in the include statement are relative to the file that contains the include. So, 
for example, for files in the Transform directory, the paths must be relative to the 
Transform folder. But files within the Library directory must use a path relative to 
the Library directory. 

Subfolders can be created within the Library and Transforms directories as desired; 
however, only XSL files within the Transforms directory are visible to the Server 
(subfolders are ignored).

Tip

The paths within the Catalog files must, obviously, be valid and point to existing 
files. If you see errors indicating a DTD or Schema cannot be found, the first place 
to check is your catalog files.

Configuring a Project
The Project page has been redesigned to isolate separate properties into 
individual tabs. A new tab, XSL Templates, has been added to support XSL 
processing. Each project can have its own set of XSL files and a separate XML 
catalog.

The new XSL Templates configuration tab (only 
needed by those using an XSL workflow).

XSL files located in the /XML/Transforms folder will be displayed in the “Not 
Available for Jobs” list. To make them available for this project, click on the desired 
XSL files and then click the right arrow button.
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An XML catalog from the /XML/Catalogs directory can be selected in the XML 
Catalog File menu.

Running a Job
A new button has been added to the Job Options page that allows an external 
XML file to be used when running a job.

When “Run Job with XML…” is selected, the user will be able to select an XSL 
transformation and upload a XML file. 

When Run Job is selected the XML file will be uploaded and transformed into 
CXML using the selected XSL template. 

If the Job was configured to Prompt for Job Option Overrides the run page will 
look like:

After choosing to ‘prompt for Job Option Overrides’, 
modifications can be made prior to running the Job.

The Content area allows the user to select the XSL template and the XML file to use 
for this job as well as specify any job override settings.

You can now run a job with an external XML file.

Selecting the XSL template to use with the Job
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 Note that when using the Run Job with XML feature any content defined in the 
Job Option itself is ignored. The user specified XML provides all the content for the 
job.

Simplified User Interface for XSL based jobs
Non-Administrator users can be provided with the full Typefi Server user interface 
or a streamlined version intended to be used primarily for running XSL based jobs.

The User properties page has a new menu, Typefi Console, which is used to select 
the interface for a given user.

Choosing ‘Simplified’ will restrict this user to just being able to run jobs using user-
supplied XML files.

When a user with a Simplified Typefi Console logs in they will see the following:

The Simplified Console showing Run Job choices

The Typefi Project menu will list all the projects this user has been assigned to. 
The XSL Transform menu displays the list of XSL files available within the selected 
project. The user provides an XML Content File by filling in the Content File field. 
The Job Option field is used to determine the job option to use. Note that the 
“Prompt for Job Option Overrides” setting is ignored in the Simplified Typefi 
Console. 

Choosing the type of interface a user will use 
when working with Typefi Publish
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Job Monitor
When a job is started, the Job Monitor is shown.

Job Monitor as seen in the Simplified Console view

The Job Monitor works similar to the Monitor in the full Console UI with the 
following differences:

 ■ The user will only see jobs they’ve started
 ■ Roundtripped jobs are not shown
 ■ Filtering by Job Option and/or Project is not supported

When a job is active, clicking on the job name will display a dynamic event log 
showing the progress of the pagination process. 

Simplified Console showing Job Monitor
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Once a job is finished, clicking the name will display the file contents of the job 
folder.

Simplified Console view of job folder contents

The simplified UI user does not use the FileManager and cannot check out or 
check in files. Instead files can be downloaded by clicking on the file icon or name. 
This will download the file using the normal browser download mechanism.

Note the clicking on the log displays the log events in the browser and does not 
download the actual file.

Files can be deleted by clicking the checkbox next to the file names and clicking 
the Delete button.

Dynamic Job Log
New in V5 is the ability to monitor the job log generated by the Typefi Engine 
during job composition. When a job is running clicking on its folder name will 
display the job event log. New events will be appended to the bottom of the list. 

After a job is finished, successfully or not, clicking on the job name will go to the 
job folder page.

View Server Log in Browser
A new menu option has been added to the Admin menu bar that allows remote 
viewing of the Typefi Server log. This view will automatically update as new 
messages are logged. 



 What’s New 14

The Server Log being dynamically updated

General User Interface Improvements
The general look of the server has been ‘lightened’. The dark backgrounds have 
been removed.

Here are some highlights of the UI changes:
 ■ Login & confirm override pages have been upgraded
 ■ The Project page is now tab-based, making it more obvious what will be saved 

when clicking the save buttons.

Tab-based interface for the Project page

 ■ The Server initialization page has been upgraded to work with MySQL and 
PostgreSQL databases. It also confirms creation of new filestore folders and/or 
databases.

 ■ The Add/Edit User page can now be used to edit the list of projects of a user 
belongs to.
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 ■ Import project automatically fills in the Project Name field based on the name 
of the TZIP (or ZIP) file.

 ■ In the Project – Condition page, the color swatch has been moved to the left of 
the condition name.

WSI Changes

New API call: runjob-raw
This call allows jobs to be queued to an engine without having a predefined 
project. It’s intended to be used by sites that maintain their own CMS and are using 
Typefi Publish for its pagination abilities.  The call allows specifying an arbitrary 
folder containing a template, a content XML file and an output location. The job 
will appear in the Job Monitor as a System job with no associated project. It uses 
the same basic API structure as runjob and runjob-cxml.

More details can be found in the WSI documentation.

WSI Updates
The results from the /listproject call now include the XSL template information for 
a project. Within the XML structure a new ‘xsl element has been added:

   <xsl>
     <transforms>
       <transform id=”123” | name=”abc.xsl”/>
     </transforms>
     <catalog name=”mycatalog.xml”/>
  </xsl>

This will list the XSL Transforms assigned to the project as well as the chosen 
catalog file.
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Typefi projects are all of the components of a publication, from images and 
content, to template and finished artwork. Typefi projects are defined by 
the Typefi Publish Server and provide access to related project templates, 
content, images, job options and jobs.

Server login
Before you can create, edit, import or export projects from the Typefi Publish 
Server, you must sign in.

Each Server installation comes with a default administrator user account that you 
can use as a first login option. (The sign in details for this account are: username 
‘admin’ and password ‘admin’).

Sign in to Server
To sign in to the Server through web browser access:

 ■ Enter the URL for the Typefi Publish Server in your web browser.

For example, http://typefiserver:8080/ (where ‘typefiserver’ is the name of your 
server).

The sign in screen appears.

Recommendation: change the default admin password after first login to 
prevent unauthorized administrator access.

Starting a Project

http://typefiserver:8080/
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Typefi Publish Server login from browser

 ■ Enter your Username and Password
 ■ Click Sign in.

Upon successful sign-in you’ll see a list of available Typefi projects.

Sign out of Server
When you’ve completed your work in a Project, we recommend that you save the 
files and check in the files you’ve recently worked on prior to signing out of the 
Server (see also Check in / Check out, p. 29).

 ■ To sign out, click Sign out link in the top right corner of the screen.

The Typefi Publish Server returns to the Sign-in screen.

User accounts
Creating, editing and deleting users can be done only by a user with administrator-
level access to Typefi Publish Server.

To add a new user to the system:
 ■ Navigate to the Admin tab.
 ■ Next click User Management.
 ■ Click the Add User…  button.
 ■ Enter the Name, Username and Password and set the privileges for the user.

Sign out link in Typefi Publish Server.

Non-administrator Users only see a Job Monitor tab not the Admin tab.
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Add a new User to the Typefi Publish System

Username is the name the user enters when logging into the Typefi Publish Server, 
whereas Name is simply for display purposes.

Administrator privileges will give a user access to all projects.

Enabled allows an administrator to temporarily and globally disable a user’s access 
without actually removing the user from the Server.

Typefi Console offers the choice of two options: Full, and Simplified. The Simplified 
Console reduces choices considerably.

 ■ Click Save to add the new user.

New Administrator user with Full Console access. Account is enabled.

Administrator users are automatically granted access to every project on a Typefi 
Publish Server. Non-admin users will need to be explicitly added to each project 
(see Edit membership list, p. 23).
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Projects
Only Administrative users can create new projects on a Typefi Publish Server. 

As some settings are dependent upon the templates and content in the project, they may need to be set 
or revised as the project progresses.

To create a new project:
 ■ Navigate to the Project tab.
 ■ Click New…

The Create Project window appears.
 ■ Enter the project’s Name and Description (optional).
 ■ Click Create.

A new project is created and the Project Settings window displays:

The Project Settings.

A Project’s settings determine which users have access (Membership), what 
content is automatically tracked for cross-references within Writer (Cross-
references), and various other options related to configuring default Project Field 
values, defining project Conditions, and selecting display name fields for Sections. 
In addition, entire projects may be exported to a TZIP archive. 

Cross-references configuration

Click the Cross-references Link to open the Cross-references window

Starting a project

Note: A non-administrator user who selects Projects sees only the 
‘Export’ and ‘Monitor Jobs’ buttons in the header of the Project Settings 
window.
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The Cross-references link brings up a screen in which you can determine the 
availability of Cross-reference sources (Allow as Source) for Typefi Writer (see Cross-
References in the Typefi Writer User Guide), eliminating the need to manually 
insert a Cross-reference destination marker (or bookmark) for these sources. The 
choices you make limit the possible sources for cross-referencing, so the authors 
only see the styles and fields that are needed for cross-references.

When a production designer is still working on an InDesign template, the options available within the 
Cross-references section may be incomplete. After the template has been finalized and checked into the 
Server, revisit Cross-references.

Project Fields

‘Project Fields’ allow a consistent item of text throughout a project and are 
Allow(ed) as Source cross-references by default.

Project Fields may be selected as cross-refererence sources

To enable Project Field usage as a Cross-reference source:
 ■ Check the Allow as Source option for a Project Field.
 ■ Click Select All to allow all Project Fields to be used.

To disable Project Field usage as a Cross-reference source:
 ■ Uncheck the Allow as Source option for a Project Field, to enable its use as a 

Cross-reference source.
 ■ Click Deselect All to disable usage of any Project Field.

Section Fields

Section Fields, such as a Chapter Title, are unique to each section in which they 
exist. By default each Section Field has been enabled as a Cross-reference source.

Cross-references are textual references within a publication that direct 
the reader from a source point in the text to a destination located 
elsewhere in the same publication.

Section Fields may also be selected as required 
to be used as cross-reference sources.
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To enable Section Field usage as a Cross-reference source:
 ■ Check the Allow as Source option for a Section Field.
 ■ Click Select All to allow all Section Fields to be used.

To disable Section Field usage as a Cross-reference source:
 ■ Uncheck the Allow as Source option for a Section Field, to enable its use as a 

Cross-reference source.
 ■ Click Deselect All to disable usage of any Section Field.

Paragraph Styles

Paragraph Styles are used to apply text formatting to paragraphed text. A Typefi 
project may contain many Paragraph Styles and each of these styles may be used 
as a Cross-reference source. The list of available Paragraph Styles contains each 
paragraph style made available to the Typefi Writer from the InDesign template.

By default no Paragraph Styles are enabled as a Cross-reference source.

Paragraph style listings.

To include a Paragraph Style as a possible Cross-reference Source:
 ■ Select one or more Paragraph Styles from the Not Allowed as Source list.
 ■ Click the right-pointing arrow .

Or
 ■ Click the right pointing double arrow , to include all Paragraph Styles. 

To exclude a Paragraph Style as a Cross-reference Source:
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 ■ Select one or more Paragraph Styles from the Allowed as Source list.
 ■ Click the left pointing arrow .

Or
 ■ Click the left pointing double arrow , to exclude all Paragraph Styles. 

Saving Cross-references settings

To save the changes made to the Cross-references Settings:
 ■ Click Save.

General
The General section contains the Typefi Project name and description.

To edit the name of a Typefi Project:
 ■ First ensure all files belonging to the project are checked into the system and no 

one is accessing files from the project. 
 ■ Edit the name.
 ■ Click Save.

If there are files checked-out of the project, the Typefi Publish Server displays a 
warning ‘There are assets currently checked out. Users will receive errors when 
attempting to check those assets in. Do you want to rename the project anyway?’

 ■ Click Cancel to allow all users to check their files in prior to changing the Project 
Name and return to the Project Settings.

 ■ Click OK to ignore this warning and edit the Project Name. Note that in this case 
any checked-out files will not be able to be checked back in to the Project after 
the name change.

To edit or add a Project Description:
 ■ Edit or Enter the description text.
 ■ Click Save.

Deleting projects
Only Administrators can delete projects from the Typefi Publish Server. Removing 
a project deletes a project and all its related files, such as templates, content files, 
images and published jobs, from the project window and Server. (However, it does 

To select a range of consecutive style names click the first style, then 
Shift+click the last style name. To select non-consecutive multiple styles, 
Cmd+click (Mac) or Ctrl+click (PC) each style name.

Note: Renaming a project results in renaming of the directories in the 
Typefi Filestore on the Server.
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not remove any files you have checked out to your computer, or Word files not 
checked into the server.)

 ■ Click a project name in the Project lists.
 ■ This displays the Project Settings window.
 ■ Click Delete.

Alternatively:
 ■ Click the Projects tab to display a complete list of projects.
 ■ Check the projects you’d like to delete.
 ■ Click Delete.

Remove all projects
To delete all projects from the Typefi Publish Server:

 ■ Click the Projects tab to display a complete list of projects.
 ■ Check  Projects to select all projects in the project list.
 ■ Click Delete. 

A warning dialog box appears:
 ■ Click OK to delete the project and all its related files from the Typefi Publish 

Server.
 ■ Click Cancel If you decide not to proceed.

Edit membership list
While Admin users are automatically made members of every project on a 
Typefi Publish Server, non-Admin users must be explicitly added to a Project’s 
Membership List.

Select the ‘Membership’ link and place a check beside each user to grant full read-
write access to a project, its templates, content, images and jobs.

Warning dialog box

Note: it is not possible to remove an Admin user from a project’s 
Membership List.
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Editing a project’s Membership List.

Engine selection
Installation of Typefi Publish installs at least one Engine called Sample Engine 
that is a Generic Engine Type. The Generic Engine Type is capable of handling all 
composition jobs and is configured with the default PDF Export presets as defined 
by Adobe InDesign.

PDF Export Presets are the Engine Type’s reference to PDF Settings files 
(.joboptions) installed on InDesign Server. Engine-assigned presets are available 
for selection when running jobs either from the Typefi Publish Server (see also 
Running a Job with Full Console access, p. 43 ) or from the Typefi Writer in Word.

Project Field
A Project Field is a field for which the value is consistent throughout the project, 
print job or run job (see also Job Options with ‘Full Console’ access, p. 35). Project 
Fields, for example, are used to enter a publication title, author name, ISBN, part 
title or part number, publication date, etcetera.

Once a production designer has added Project Fields to the InDesign template 
(using Typefi Designer) and the template has been checked back into the Server, 
then Project Fields become available in the Typefi Publish Server.
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Edit Project Fields
A Project Field Value is the text that populates a Project Field (See also Project 
Fields, p. 20) that is created in the InDesign document during page composition. 
This text is requested at Project level or when the author runs the Print Typefi 
Document command from within Word. 

Entering Project Field Values.

To edit an existing Project Field value or create a new value at Project level:
 ■ Click a Project Name on the Typefi Publish Server.
 ■ Click the Fields heading.

The Project Fields window is displayed for the current project.
 ■ Type in the values for each of the project fields. 
 ■ Click Save.

The Project Field Values are now locked in, unless they are edited at a later date. 
(Project Field Values appear as the default in Typefi Word documents, where 
different values may be entered if needed.)

Conditions
Conditions are qualifications used to mark up specific parts of content for inclusion 
or exclusion when a job is published. Conditions provide the author with the 
ability to write a single Word document that could generate different output, 
based on which conditionalized content is to be included and which isn’t. 

Example of Word text marked-up with both US 
and UK English language conditions.
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Conditionalized output is controlled through Job Options (see also Job Options 
with ‘Full Console’ access, p. 35).

Let’s take this User Guide for example. The guide is published in UK and US English 
versions. Rather than writing two separate documents, language-specific text is 
marked up with either a “UK English” or “US English” condition. The document is 
then output twice, once with the UK English condition enabled, and once with 
the US English condition enabled, resulting in two different publications. Another 
example of use of conditionalized content would be the publication of Student 
and Teacher editions of a text book. 

Only conditions that are inserted as part of the Project options are accessible to 
content authors in the Typefi Writer.

For the daVinci project we included the following two conditions:
 ■ Student note
 ■ Teacher note

New condition
To create a New Condition:

 ■ Click on the Conditions heading in the main Project window.
 ■ Click the New button in the Condition Settings.

The Create Condition dialog is displayed.
 ■ Enter the name of the new condition.

The condition Name is also the name that displays in the Typefi > Insert > 
Condition, Insert Condition dialog in Word. 

 ■ Enter a Description. The description is useful, but optional.
 ■ Click the Writer Display Color icon to choose the display color used by the Typefi 

Writer for content marked up with this condition.
 ■ Click Create.

The new condition has now been added and is ready for use by the Typefi Writer, 
as soon as the document has been refreshed or is checked out again.

You are currently reading the US English version. (This note changes to 
the relevant version of English).

New Condition.

Create Condition window.
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Edit condition
Conditions may be edited later. Keep in mind that a change in the Condition 
Name requires an update of all content files in which it has been used. Editing 
the Condition Description or Writer Display Color has no adverse impact on the 
Word content file. When the author checks out the Word document after the 
conditions have been edited, the condition colors and description details are 
automatically updated (see Check in / Check out, p. 29). Additionally updating a 
Word document that’s already checked out will refresh the condition appearances 
(see Content / Sections, p. 34).

To edit a Condition: 
 ■ Click the Condition heading. 

The Conditions window is displayed:

 ■ Make the appropriate changes to Name, Description or Writer Display Color.
 ■ Click Save. 

Delete condition
To remove a condition:

 ■ Check  the box preceding the Condition Name.
 ■ Click Delete.

To remove all conditions:
 ■ Check  the box preceding ‘Condition’ (at the top of the conditions).
 ■ Click Delete.

Section
A Section Title Field defines how content files are displayed in the Content > 
Sections list (see also Content / Sections, p. 34) and Job Option configuration (see 
also Job Options with ‘Full Console’ access, p. 35). Sections themselves are 
defined by the Typefi Designer in InDesign (see Typefi Sections in the Typefi 

Editing Condition settings.

Section Title Sample
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Publish Designer Guide). They provide instructions that control the order in which 
the Typefi Engine applies Master Pages during page composition. 

Text-based Section Fields used by a Typefi Section are selectable as Title Fields for 
the section (see Typefi Sections in the Typefi Publish Designer Guide). 

As sections are extracted from Documents they populate the Sections content list 
(see Content / Sections, p. 34), and are displayed as: “Section: Title Field”.

For instance, let’s assume the author has inserted a new Chapter section in 
the Word document using Typefi Writer. As the section is inserted, the author 
is prompted to enter the ChapterTitle (e.g. ‘Biography’). When this section is 
uploaded from the Word file into Documents (see Content / Documents, p. 34), 
and its Section content extracted, the Biography chapter (see Content / Sections, 
p. 34) will list it as “Chapter: Biography”.

To edit the Section Field values that are displayed in Content > Sections: 
 ■ Choose an available Title Field from the drop-down list next to the Section 

Name.
 ■ Click Save.

Section Fields containing the word ‘Title’ are automatically considered as 
Title Fields.
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A Typefi project is contained in five directories: Templates, Content, Images, Job 
Options and Jobs.

Check in / Check out
Typefi Publish Server works with a simple check in and check out process for users 
who are editing the files that are part of a project. 

Prior to editing a file, the file must be checked out of the system. This pushes a 
copy of the file from the server to your local machine and limits access to the file 
on the server by other users to ‘Read Only’.

Files that are part of a project on the Typefi Publish Server can be in two different 
states:

 ■ Checked-in and readily accessible to any member of the project.
 ■ Checked-out and only accessible to the member of the project that has the file 

checked out.

Colored symbols preceding the file names indicate the current state of the file. 

Files that are checked-in are preceded by a green arrow symbol. 

Files checked out by another user than you are marked by a red stop-sign symbol. 
The user who’s checked out the file is listed under the Checked Out By column.  
Once a file is checked out, other users will not be able to check out the same file. 
They can view the file in read-only format.

Files checked out by you are marked by a blue arrow symbol.

To edit a file that’s part of a Project:
 ■ Ensure it’s not checked out by anyone else.

File checked into the system.

File checked out by other user.

File checked out by you (if your name is Brady Ogus...)

Project Folders
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 ■ Check the file out.
 ■ Make the changes.
 ■ Save the changes.
 ■ Close the file.
 ■ Check the file back into the Typefi Publish Server.

Check out
To check out a file:

 ■ Check the box preceding the file name and
 ■ Click Check Out.

Alternatively, click the green icon or click the File Name link itself.

Check in
To check in a file:

 ■ First ensure the file has been saved (in Word, for example) and closed.
 ■ Check the box preceding the file name and
 ■ Click Check In.

Alternatively, click the blue arrow icon.

Continue work on checked-out file
To continue working on a file that was previously closed and saved but not yet 
checked back into the system:

 ■ Either Check In the file first, then Check the file Out or
 ■ Click the File Name Link to reopen the file from your local computer and 

continue editing the file.

Templates
The Templates folder contains all available InDesign templates that are part of a 
Project. A Typefi template is a normal InDesign document that has been prepared 
by a production designer for automatic page composition. A production designer 
uses the Designer plug-ins added to InDesign to prepare such templates. (Please 

Checking out a template file.

Checking in a template file.
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refer to the ‘Typefi Designer’ part of this User Guide for extensive notes on 
preparation of the InDesign Templates.)

Working with Typefi templates begins with the creation of master pages in 
InDesign. The master pages are the foundation of Typefi’s automation and are 
designed using familiar InDesign techniques. Repeating logos, page numbers, 
headers and footers and background images are all commonly found on master 
pages. In addition, the master pages contain specially-tagged Typefi text frames 
for run-in of content. Content flow can be general editorial content or table of 
contents data.

The templates further contain paragraph, character and object styles used during 
document- and content-creation, as well as elements that are repeatedly used 
throughout the layout—such as photo-plus-caption elements, pull quotes, margin 
notes, etc...

Adding a template
Templates are InDesign documents that contain special markup added using 
Typefi Designer plug-ins. When you create a new project, there are two default 
templates you may use (or delete). One of them is suitable for InDesign CS4, and 
one for CS5. You will probably want to create a new InDesign document, save it, 
and add it to the project.

You might want to re-use a template created earlier for another project that 
already contains all the relevant markup (sections, fields, elements, etc.) added 
by Typefi Designer. Or you might have a regular InDesign document you’d like to 
use as the basis for the dynamic template development with Typefi Designer in 
InDesign. In either case you can add the InDesign document to the project from 
within the Typefi Publish Server. 

To upload an InDesign document (.indd not .indt) to the Templates directory: 
 ■ Click the Add Files button in the Templates window. 
 ■ The File Manager is launched and a window appears in which you can choose 

the file.

On the Windows platform, the File Manager usually doesn’t come to the front, and you may need to 
activate it through Windows Task Manager (CTRL-SHIFT-ESC).

 ■ Next locate the InDesign (.indd) document on your system and select it.

New Project with default templates.
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 ■ Click Choose (Mac) or Open (PC) to add the file to project Templates folder.

The file is automatically uploaded to the Project > Templates folder on the Typefi 
Publish Server. 

The yellow warning triangle to the right of the file name indicates that template 
XML file (.txml) for the template is missing. This file is required and contains a 
summary of all the Typefi information within the InDesign document.

To create the missing .txml file:
 ■ Check out the file.
 ■ Save it from InDesign.
 ■ Close the file and check it back in.

The .txml file is updated after each InDesign file check-in to the Typefi Publish 
Server. 

Note: You might see .txml files sitting in the same directory as InDesign files with the same name. When 
the Designer plug-in is installed in InDesign, each time you save an InDesign file the associated .txml file 
is created.

Deleting a template
To delete a template from a Typefi Project: 

 ■ Click the Project name link on the Typefi Publish Server browser interface.
 ■ Click Templates in the directory list. 
 ■ Select any template you want to delete.
 ■ Click Delete.

A warning dialog is displayed: 
 ■ Click OK to go ahead and delete the template file from your project.
 ■ Click Cancel to stop the deletion and return to Templates.

Using multiple templates
A project can contain multiple templates. Using multiple templates is particularly 
handy where the same content must be published to different layouts or page 
sizes.

An InDesign Template recently added to the project

Warning upon deleting a template.
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For example: A company publishing books in different countries might use 
templates based on document setups. A US document size might be based on 
ANSI Letter, where the Australian publication requires printing on ISO standard A4.

Content
The Content folder icon reveals the Project content files and contains two content 
tabs: Documents and Sections. 

Documents store the project’s Word documents (.doc) and Rich Text Files (.rtf) 
The new .docx format is not acceptable at the moment. Each document in the 
Documents list contains one or more Sections (if marked up correctly).

Save new Word 2007/2010 .docx file types as earlier Word .doc file types to avoid any problems with 
checking files into the Typefi Server.

‘Sections’ are the files that are extracted from Documents in XML format when 
‘Update Sections’ is clicked.

Add documents
To add one or more Word documents to a Typefi project:

 ■ Click Add Files in the Content window.
 ■ Next locate the Word (.doc or .rtf) documents on your system and select them. 
 ■ Click Choose (Mac) or Open (PC) to add the file to the Contents folder.

The file is automatically uploaded to the Project > Contents > Documents folder 
on the Typefi Publish Server. The Word document can then be edited after check 
out using the Typefi Writer. On conclusion of the editing process the author will 
check the files back in, so that they become available to other users again.

Display documents

To display Documents: 
 ■ Click the Content link to display Documents content. 
 ■ To display the Documents when Sections content is active, click Documents.

To display Sections content: 
 ■ Click Sections. 

Template Sections, Elements, Table Styles and Paragraph and Character 
Styles set to ‘Export to TemplateXML’ become available to Typefi Writer 
(any Styles in folders are automatically excluded, but may be manually 
chosen).  It is highly recommended that Section, Element and Style names 
across templates are consistent. This is to ensure that all Sections, 
Elements and Styles used in the Word content by the author exist in 
whichever template is used when Printing or Running a Job (see also Job 
Options with ‘Full Console’ access, p. 35).

Click the Documents tab for a list of documents, or the 
Sections tab to see extracted Sections listed.
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Content / Documents
‘Documents’ is the content location from where the author can check in/out Word 
documents for editing purposes. Files in Documents are stored in .rtf or .doc 
format. 

The yellow warning triangle right of the uploaded file in Documents indicates that 
the document is new to the project and that Sections have not yet been extracted 
from it. 

Content / Sections
Sections list all the individual XML-based section files that were extracted from 
files in Documents. (This repository may also be used in work-flows where editing 
is done via check-in and check-out of the individual SXML files.)

Adding sections

After applying the Update Sections command to a selected Word document in 
Documents, the XML content will be added to Sections.

To Update Sections:
 ■ Click Contents to display Documents.
 ■ Ensure that Word documents are checked in.
 ■ Place a check next to the Word documents from which sections must be 

extracted.
 ■ Click Update Sections.
 ■ When the section extraction is complete, the check disappears.

Updating Sections of a Content file 

Sections have now been extracted into .sxml documents that represent the 
individual sections. 

A recently-added content file.

Extracted Sections listed.
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 ■ Click Sections to display the extracted sections.

Once sections are updated they become available to the Job Options (see Job 
Options with ‘Full Console’ access, p. 35).

Each time the Word documents are updated by the author, you should ‘Update 
Sections’ to ensure the Sections repository contains the latest content.

Images
The Images folder icon reveals the Project graphics referenced by authors in their 
content files. 

Images are added either when the author checks in a Word document after editing 
it, or by choosing Add Files.

All file formats other than .rtf, .doc and .indd will be automatically added to the 
Images repository.

To add images:
 ■ Click Add Files.
 ■ Next locate the image file(s) on your system and select those to be added. 
 ■ Click Choose (on Mac) or Open (on Windows) to add the file to the project 

Images folder.

Job Options with ‘Full Console’ access
Job Options are used by the Typefi Engine during automated page composition 
and they define which templates, extracted sections, conditions, engines, and 
scripts must be used during the composition process. They bring together content 
and template and output professionally-designed InDesign documents (and other 
file formats if required).

To display available Job Options (with Full Console):
 ■ Click the Job Options icon in the project window. 

A list of available Job Options is displayed.

New Job Options
To create a new job option: New job options for project
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 ■ Click New. 

The ‘Create Job Option’ window opens that contains all of the settings available for 
page composition.  

 ■ Enter the Job Option Name. 

Choose a meaningful name (such as a description of the final output format), as 
the Job Option will appear in the Typefi Publish Server Web Interface as well as the 
Typefi Writer Print dialog in Word.

 ■ Select the Typefi Template that is used for the output to InDesign. 
 ■ Enter any other Job Option-specific settings.
 ■ Click Create to add the Job Option to the Project’s Job Options List. 

General settings

JOB OPTION NAME

Job Option Name is what appears first in the list of Job Options. In addition to 
using this to publish from Typefi Publish Server directly, the Job Option name is 
referenced when publishing from Word (and through the WSI, such as when 
publishing non-Word content (XML) from a Content Management System to Typefi 
Publish). 

TYPEFI TEMPLATE

From the list of available templates, select the InDesign Template that is to be used 
during page composition. For projects containing one template only, the available 
template is automatically selected when a New Job Option is created. 

NB: Further automated template selection occurs when a template referenced by a 
Job Option is removed from the project (it may not be the one you want, so check 
after deleting templates).

In cases where a specified template is no longer available, the first available 
template (alphabetically chosen) is automatically selected.

In cases where there are no templates available at all, the Typefi Template setting 
in the Job Option displays a clear warning that ‘There are no templates for this 
project’.

NB: Without an available template no jobs can be published through Typefi 
Publish.

The Create Job Option window with the option to create a PDF.

Automatically-selected template

Project with a missing template.
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CREATE ADOBE PDF

Enable this option to generate a PDF document when publishing jobs through 
Typefi Publish. 

Then choose a suitable Adobe PDF Settings from the dropdown menu. 

Note: Available PDF Settings are based on settings added by the Administrator for 
the Typefi Engine used to run a job. The ‘-–use engine type default --’ setting uses 
the default PDF Export Preset set for the selected Engine Type.

INDESIGN OUTPUT FORMAT

‘Single Document’ generates a single InDesign document during page 
composition, merging all sections that make up the selected content (see Content, 
p. 40) into a single file.

‘Book’ generates a book file that references individual InDesign documents 
created during page composition. Each selected section used as Content (see 
Content, p. 40) generates an individual output file. 

NB: As InDesign does not permit a TOC to be targeted at a particular page range, 
the preferred method for creating section-based TOCs is to ensure you generate 
these publication parts as separate jobs using the ‘Create Book’ option.

START PAGE NUMBERING AT

‘Start Page Number At’ defines the page number for the first page of the first 
section that is being published. 

Note: In some cases you might see an additional page added to a document as a result of setting a first 
page number. Most likely this will relate to the InDesign document setup that is used as a template. 
The document might be set-up in such a way that it forces a left or right-hand page start. If this occurs, 
please review the InDesign document template.

LABEL OUTPUT USING

When enabled, the ‘Label Output Using’ setting controls the naming of published 
files based on a Project Field value. This Project Field could be specifically set-up 
for the purpose of naming the files. 

General settings in a Job Option.
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Jobs published without the use of an output label will use the Job Option name to 
name the resulting files. For example: if the Job Option Name is “Print Book” the 
published files would be named: Print Book.indd; Print Book.pdf; Print Book.log; 
Print Book.cxml

UNRESOLVED CROSS-REFERENCES

When enabled, ‘Unresolved Cross-references’ defines the way to handle cross-
references that cannot be properly generated during page composition. Select 
‘Keep Last Known Text’ to insert the cross-reference text last used or ‘Replace Text’ 
and enter the preferred text that is to replace an unresolvable cross-reference. 
When ‘Specify How to Handle Unresolvable Cross-references’ is not enabled, the 
default Replace Text “UNRESOLVABLE CROSS-REFERENCE” is inserted during page 
composition.

PROCESS ‘SOFT-STYLE’ CHARACTER FORMATTING

Character-level formatting applied in Word (using the buttons such as B (Bold), I 
(Italic), Underline (U) as well as Superscript and Subscript Font Effects) is retained 
and passed on to InDesign when this option is enabled.

SOFT-STYLES IN WORD AND INDESIGN

Soft-Style success is heavily based on the font choices made by the production 
designer developing the InDesign templates. Generally speaking, the author 
working with Typefi Writer in Word would not be using the same fonts, but more 
likely some common word-processing fonts such as Times or Arial when writing or 
editing their content.

If a font used by a Paragraph Style defined in InDesign contains a  ‘Bold’, ‘Italic’ and 
‘Bold Italic’ font-style, you’ll probably see a successful soft-style conversion into 
InDesign.  Generally you can test the inclusion of soft-styles in InDesign by using 
the soft-style shortcuts Cmd+Shift+B / Ctrl+Shift+B for Bold and Cmd+Shift+I / 
Ctrl+Shift+I for Italic. Combining the two would generate the “Bold Italic” soft style.  
However, even when InDesign Desktop correctly applies the soft-styles, you might 
not be guaranteed success. 

The following table gives you an idea of what works and might not work:

For rare cases where the Designer plug-in cannot find a reporesentation 
for ‘Bold’, ‘Italic’, or ‘Bold Italic’ than CAN be found by InDesign, please 
file a bug report for the specific font with Typefi. It may be necessary to 
provide the font as well.
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Regular/Roman 
font in InDesign 
template

Soft 
Style in 
InDesign

Result Soft Style in 
Word

Published Result

Adobe Caslon Pro B Semibold Arial + B Bold
Adobe Caslon Pro I Italic Arial + I Italic
Adobe Caslon Pro B + I Semibold 

Italic
Arial + B + I Bold Italic

Century Old Style 
Std

B Bold Arial + B Bold

Century Old Style 
Std

I Italic Arial + I Italic

Century Old Style 
Std

B + I Bold Arial + B + I [Bold Italic]  
missing style

Arno Pro B Bold Arial + B Bold
Arno Pro I Italic Arial + I Italic
Arno Pro B + I Bold Italic Arial + B + I Bold Italic
ITC Avant Garde 
Gothic Std

B Bold Arial + B Bold

ITC Avant Garde 
Gothic Std

I BookOblique Arial + I [Italic]  
missing style

ITC Avant Garde 
Gothic Std

B + I BoldOblique Arial + B + I BoldOblique

PROMPT JOB OPTION OVERRIDES

With the ‘Allow Job Option Parameters to be Overridden’ enabled, any or all 
Project Field values assigned in the Project options can be overridden when a job 
is run from the Typefi Publish Server. Furthermore, Engine Configuration, Options 
and Condition and Scripting Options can be edited before run-time.

STORE TYPEFI PRINT/WSI JOBS

When the Store Typefi Print/WSI Jobs setting is enabled, Typefi documents 
published from Word or through a third-party application (such as from a Content 
Management System) are stored in the Jobs directory of the project. 

On the Typefi Publish Server, the jobs are stored inside the Filestore/Projects 
Name/Editions directory.
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Engine Selection

Engine availability is dependent on the installation of Typefi Publish Server and the 
configuration of Engines. Typefi Engines can be set up to run specific composition 
jobs, or have specific PDF Presets assigned to them as well as Filestore locations 
and user access.

To select an Engine or Engine type that differs from the Engine settings defined at 
Project level:

 ■ Check  the Override Project Settings box.
 ■ Select Engine Type.
 ■ Select Engine.

‘Engine Type’ sets the appropriate engine type for your job. A standard Typefi 
Publish Server install will install a Generic engine.

‘Engine’ selects the appropriate engine for your job.

Engine Configuration

The ‘Set Max Time Per Page’ option defines the maximum amount of time spent 
on a page composition during the automatic composition process.

‘Set Max Layouts Per Page’ defines the maximum number of layouts the Typefi 
Engine can try out during the automated composition process.

Condition

From the list of available conditions, check the conditions for which conditional 
content must be included during page composition. Uncheck conditions for which 
content is to be excluded during page composition.

Content

 The ‘Content’ section of a Job Option allows you to choose which sections will be 
included when publishing the job from Typefi Publish Server. All content available 
comes from the sections that were extracted from Content/Documents or loaded 
to Typefi Publish from source ContentXML (see also Content / Sections, p. 34).

Engine Selection.

Engine Configuration.

Content marked up for student edition is included 
when publishing using the selected Job Option.
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Only sections listed under ‘Selected Sections’ are included in the output of the job. 
Sections listed under ‘Selected Sections’ can be sorted by selecting them from the 
list and clicking the ‘Up’ or ‘Down’ buttons at the bottom of the Selected Sections 
list.

To add sections to the ‘Selected Sections’ list, select the sections from the 
‘Available Sections’ list, then click . To add all sections from ‘Available Sections’ to 
‘Selected Sections’, click .

Remove sections
To remove sections from ‘Selected Sections’, select the section name (or names) to 
be removed then click . The removed section is added at the bottom of Available 
Sections. You may only sort sections in the ‘Selected Sections’ list.

To remove all sections from ‘Selected Sections’, click . All sections are now listed 
under Available Sections.

Scripting Options

Scripts are files of code that enable alterations to the default configuration settings 
Typefi Publish applies. Scripts must be installed in their appropriate script folder 
(such as ‘BookStart) on the Typefi Publish Server. The Job Options will run generic 
scripts (referred to by name in the Job Option setting itself, such as ‘BookStart.jsx’), 
which will access the specific scripts from these predefined locations. Job Scripts 
and Designer Scripts run before, during or after page composition; or at other 
times such as the start or end of a job. 

Job Scripts are server-based scripts and are installed in the scripts folder inside the 
Typefi/Publish/Server folder. Job Scripts are invoked by the Typefi Publish Server 
either before a job is run, or on completion of the job (see also Running a Job with 
Full Console access, p. 43). Designer Scripts are InDesign Scripts developed in 
JavaScript (Mac- or PC-compatible), and are installed in the InDesign CS5 Server/
Scripts folder.

Override Script Presets: Enabling the Override Script Presets option allows for Job 
Option-based calling of Job and Designer scripts. With the setting enabled, type 
the exact name of the script (including its file extension) in the relevant Event field.

A list of ‘Available Sections’, with some sections moved to 
‘Selected Sections’ for inclusion in the job to be published.

Job option that uses a feature enhancement in the form 
of a script at the start of creating an InDesign Book.
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Editing Job Options
To edit a Job Option:

 ■ Click the Job Options folder.
 ■ Check  the appropriate Job Option.
 ■ Click Edit…. 

Or:
 ■ Click the Job Option Name link.
 ■ Click Edit Job Option.

The Edit Job Option window is displayed.
 ■ Make the relevant changes in the options.
 ■ Click Save at the top or bottom of the Edit Job Option window to acknowledge 

and store an updated version of the job options.
Save Job Options.

Job Options with User access
With limited access, users are presented with a simpler screen (depending on 
whether they were given Full, or Simplified Console access). Here are the screens 
you would see as a non-Admin User with Full Console access to assigned projects.

Full Console access to assigned projects

Editing a Job Option.
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Full Console access to Job Monitor

Running a Job with Full Console access
One or more Job Options can exist for each project. In order to commence 
automated page composition a job must be run. 

To publish a Job from the Typefi Publish Server with Full Console access (for 
Simplified Console, see Run Jobs with Custom XML on p. 7):

 ■ Click the Job Options folder to display a list of available job options. 
 ■ Check the Job Option name.
 ■ Click Run Job. 

Page composition will commence and the Typefi Publish Server automatically 
displays the Job Monitor listing all Jobs published and being published for the 
selected Job Option.

When a Job Option is currently being used to publish a job, a progress bar appears 
next to the Job Option name. If the last job for a particular Job Option failed, a red 
cross icon will appear next to the Job Option Name. 

Run selected job.
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On successful completion of a job, the Typefi Publish Server will briefly display a 
red message window stating that the Job has completed successfully:

Job Monitor
The Job Monitor lists all failed jobs; jobs in progress; pending jobs; jobs that were 
roundtripped; and completed jobs in reverse chronological order.

Job Monitor for Jobs Option
To Monitor Jobs for selected Job Option:

 ■ Click the Job Options folder.
 ■ Check the Job Option.
 ■ Click Monitor Jobs.

The Job Monitor appears, listing jobs that have been run, and the results. 

Filter By option

The default ‘Filter By’ option is set to ‘Project’ so that only jobs for the selected 
project are displayed. Changing the ‘Filter By’ option to ‘Show All’ displays all jobs 
for the selected project regardless of which selected Job Options are listed. 

To list all failed, completed, or in-progress jobs for any project: 
 ■ Change the Filter By option to Show All.

Monitor Jobs from Project
An alternative method to use for displaying all jobs for a particular project is to:

 ■ Click the project name in the Projects list.
 ■ Click the Jobs folder link. 

The Job Monitor for Project ‘project name’ window lists all jobs in reverse 
chronological order. To list all failed, completed, or in-progress jobs for any project: 

 ■ Change the Filter By option to Show All.

Monitor Jobs for selected Job Option.
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New in V5 is the ability to monitor the job log generated by the Typefi Engine 
during job composition. When a job is running clicking on its folder name will 
display the job event log. New events will be appended to the bottom of the 
list. 

After a job is finished, successfully or not, clicking on the job name will go to the 
job folder page.

(This new feature is very handy, as you don’t have to wait until the Job is 
finished to see any errors. The Job can be cancelled; any errors dealt with; and 
the Job run again.)

Admin Jobs Monitor
Users with administrator-level access to Typefi Publish Server can view all jobs for 
all Projects through the Admin tab in the Typefi Publish Server.

To access the Job Monitor as an Administrator:
 ■ Click Admin.
 ■ Click Job Monitor.

User Jobs Monitor
Users with non-administrator level access to Typefi Publish Server, will only see 
jobs belonging to projects of which they are a member.

To access the Job Monitor as a User:
 ■ Click Job Monitor. 

Monitor Jobs settings
There are three Job Types: Completed, Roundtrip and Print Jobs.

To edit the Monitor Jobs settings:
 ■ Check the checkboxes for the preferred Job Types.

Job Monitor with Admin Access

Job Monitor with only User Access
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Job types
Completed Jobs lists jobs published from the Typefi Publish Server. These jobs are 
run by selecting a Job Option, then clicking ‘Run Job’. 

Print Jobs list jobs printed from Word using the Typefi Print… command, and 
contain a small printer icon to the right of their name. (They also include any jobs 
sent for publication through the WSI):   

Roundtrip jobs list jobs that were created after a previously-run job was updated. 
When a job has been created via Typefi Print… or Run Job…, the composited 
InDesign file may be checked out and edited. After editing the InDesign file, save 
it, close it and check the file in and Update Sections to update the Section content 
repository. When this updated content is used to Update a Word document and 
the Word document is published, the job is classified as being ‘roundtripped’. 
Roundtrip jobs are marked by a small yellow symbol:   

Failed jobs are preceded by a red ‘x’ icon. This icon will also appear for jobs that 
have been manually cancelled (see Cancel Job, p. 47):   

Jobs in Progress are preceded by a small document and clock icon:    

Jobs that are Pending are preceded by a clock icon:    

Successfully published Jobs generate content.cxml; a completed InDesign 
document; a log file; and (optionally) a PDF (other possible output includes ePub). 
For jobs set to output an InDesign ‘Book’, the job generated contains multiple 
InDesign files as well as an InDesign Book Document (.indb). 

To access job components:
 ■ Click the job name link in the list of Monitored Jobs.
 ■ Click on the particular component (usually the PDF, but often the log and the 

INDD are very informative).

Jobs that are still in progress are marked by a small clock icon:    

Typefi Publish Server automatically updates the Monitor Jobs window if the Freeze 
option isn’t selected, and a progress bar indicates the job progress. To manually 
update the list of monitored jobs click Refresh. 

In version 5, the Job Log is live – you can watch the progress of the Job and pick up any problems as they 
occur. Just click on the Job Name as soon as it starts, and you will go directly to the Log.

Post-job processing result.
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Delete Jobs
To remove a job from the Typefi Publish Server and the Monitor Jobs list:

 ■ Select the job in the Job Monitor.
 ■ Check the Jobs you’d like to remove.
 ■ Click Delete. 
 ■ A warning “Are you sure you want to delete selected jobs?” appears. 
 ■ Click OK to delete the job or
 ■ Click Cancel to return to the Typefi Publish Server without deleting the job.

Cancel Job
To Cancel a job that is in progress from the Monitor Jobs list:

 ■ Select the job in progress in the Monitor Jobs list.
 ■ Check the job you’d like to cancel.
 ■ Click Cancel. 
 ■ A warning “Are you sure you want to cancel selected jobs?” appears. 
 ■ Click OK to cancel the job or 
 ■ Click Cancel to return to the Typefi Publish Server without cancelling the job.
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Project export collects all Templates, Content, Images and Job Options belonging 
to the active project and combines these in a compressed .tzip file (Typefi ZIP). 

Project export
To export a project:

 ■ Select the project from the Projects list in the Typefi Publish Server.
 ■ Click Export. 
 ■ Alternatively click the Project Name and click the Export Project button.

The exported project is saved as .tzip file and will contain all job options, 
templates, contents and images that form part of the project.

Exporting projects is a great way to archive projects (and provide Typefi with work 
files to trouble-shoot). However, keep in mind that the actual jobs require separate 
archiving as they are not collected as part of the project export. If jobs require 
separate archiving you’ll have to copy them from the ‘Editions’ folder inside the 
Project folder on the Server. With version 5, you can combine multiple projects 
into a single ‘.tzips’ archive. Just select multiple projects and then click Export.

Note: Project scripts, fonts, and jobs are not included in a Project Export. 
In addition, any Engine override settings are not kept for export.

Exporting a project.

Exporting a Project



 Importing a Project 49

A previously-exported Typefi Project in compressed .tzip file format can be 
imported, and added to the Typefi Publish Server.

Project import
Import of Typefi Projects can be useful where existing projects form the basis of 
a new project or where a project must be recreated on a different Typefi Publish 
Server or system. In the first scenario, previously-created project template(s) 
are reused; project field values amended to suit the new project; job options 
amended; and content regenerated or updated.

Only projects exported from the Typefi Publish Server can be imported. Exported 
Project files are saved with the .tzip extension. Use the following instructions to 
import a Typefi Project .tzip file as a new project using the Typefi Publish Server.

Importing a project
In order to import a project you must be a user with administrator user access. 
Log in to the Typefi Publish Server from your web browser using the Typefi Publish 
Server address details, then enter username and password supplied to you by the 
Typefi Publish Server administrator.

 ■ Click the Projects tab.
 ■ Next click Import. 

The Import Project window is displayed.
 ■ Click Browse (or Choose… on Mac) to navigate to the .tzip file for the project 

you’d like to import. Importing a project from a .tzip file. The name and 
description are imported in the process.

Importing a Project
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 ■ Select the .tzip file then click Open (PC) or Choose… (Mac) to add the location of 
the .tzip file to the Archive Path. 

The Archive Path now displays the location of the .tzip file.
 ■ Next click Import. 

The project is (or projects are) added to your project list and the Templates, 
Content, Images and Job Options that were saved as part of a previous project 
export are available again.

Note: No jobs will be added when a project is imported to Typefi Publish Server, as jobs are not included 
when projects are exported.

Production designers and authors can now continue work on InDesign templates 
using Typefi Designer and content files using Typefi Writer as well as run jobs and 
print jobs. The project is ready to go.



Typefi Publish User Guide - Designer
June 2011

Typefi Publish

http://typefi.com
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With the installation of Typefi Designer, several panels, tools, menus and 
preferences are added to Adobe InDesign. Typefi Designer is a set of plug-
ins for InDesign used to transform regular InDesign templates or documents 
into files that can be used in the Typefi Publish automated publishing 
process. 

Production designers use familiar InDesign panels and techniques to add the 
automation parameters to the InDesign documents. 

Once an InDesign document is prepared for automation, it is uploaded as a 
template for a publishing project on the Typefi Server (see ‘Adding a template’ in 
the Typefi Systems Server User Guide). The template is then specified within a Job 
Option (see ‘Job Options’ in the Typefi Systems Server User Guide) so that content 
can be published. 

Typefi Designer performs several functions: user-based automation design, 
Typefi Engine-controlled document automation, (post-)editing of Typefi specific 
additions and round-tripping/export of contents. 

This part of the User Guide explains how to convert a layout or an existing 
InDesign template into a ‘dynamic’ template using Typefi Designer, and explains 
what automation options are available to you.

The structural information added to the templates is synchronized by the server 
with all content in the project – once the template is checked in to the server. This 
ensures authors have access to all the necessary tools in Typefi Writer to format 
their Word documents for automated publishing using Typefi Publish. 

Typefi Designer Plug-In 
for Adobe InDesign
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Typefi Designer for InDesign
The Typefi Designer plug-ins install new panels, an additional tool, extra menu 
commands and a number of Typefi preferences into Adobe InDesign. It also installs 
additional panels inside the InDesign dialogs to edit paragraph, character and 
table styles. Typefi Designer installs the following five Typefi panels in InDesign:

 ■ Typefi Sections 
 ■ Typefi Fields
 ■ Typefi Frames
 ■ Typefi Elements
 ■ Typefi AutoFit

Each of the panels plays an important part in using Typefi Designer and is used 
to create dynamic InDesign templates useable for automated page composition 
through Typefi Publish.

Typefi Sections

Sections are the divisions within a document that break it into logical chunks such 
as chapters. Sections specify which master pages to use, and in what order. (See 
Typefi Sections on p.69)

Typefi Fields

Fields are text placeholders that automatically update if the author changes the 
definition. (See Typefi Fields on p.94)

Typefi Frames

InDesign frames are modified to be dynamic Typefi Frames – they are 
automatically filled with text or graphics according to specifications. (See Typefi 
Frames on p. 81)

Typefi Elements

There are three types of elements: Fixed, Inline and Floating Elements. They can 
be formed from a single frame, or a group of frames, and can also include line or 
shape objects. In addition, Elements can contain Element Content or Image frames 
as well as Fields. (See Typefi Elements on p. 103)
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Typefi AutoFit

The Typefi AutoFit tool allows project designers to define parent-child 
relationships between objects by clicking on them in sequence. When the parent 
object is moved or resized as a result of content fitting – for example, more text 
would make a frame grow – the child object will reposition or resize as well. The 
AutoFit panel is used to select from which point it may grow; and to provide limits 
on its growth/shrinkage. (See Typefi AutoFit on p. 65)
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When you develop InDesign templates to be used for publishing through 
Typefi Publish, it requires a lot of careful planning and preparation.

Good template design requires you use InDesign ‘best practices’ such as multiple 
Master pages; ‘heirarchical’ Paragraph and Character styles (styles based on other 
styles); Table and Cell styles; Text Variables for running headers; and so on.

Typefi’s automatic page composition process relies on the definition and setup 
of Typefi Sections that call on Master Pages which, in turn, determine the flow 
of content on document pages. Paragraph, Character, Object and Table styles 
enable the efficient assignment of text, table, and object-level formatting. Design 
elements are defined as Typefi Elements that are automatically placed during the 
composition of a document. Standard InDesign frames are converted into Typefi 
Frames, which are receptacles for text and image content. So where do we start?

Analyzing the design
The structural information added to an InDesign template defines the styling and 
other presentation information that is part of that design. Any two templates that 
have the same underlying structure can process the same content, even if those 
templates use different page sizes, element formatting, colors and fonts.

Five important components form the structure of a template: Typefi Sections, 
Typefi Fields, Typefi Frames, Typefi Elements, and tables. Paragraph and Character 
styles are also integral to the process. We will focus on these in-depth in this user 
guide.

Example: A publication might be published in different page sizes, such 
as US Letter and A4 for print, and a layout intended for on-screen reading 
as well. Building multiple templates with identical structure but different 
layouts enables run-in of the same content with different output results.

Preparing InDesign Templates
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Starting work on the template
You can create a Typefi template from a new document, or you can base it on an 
existing design or InDesign layout. When creating a Typefi template from a new 
blank document, a good starting point is to develop a mock-up layout of the 
publication. This layout will then form the basis for the template creation. Styles 
are used to maximize the design-driven composition Typefi Publish offers. 

Recurring items in a design such as graphics with captions, margin notes, pull-
outs, quotes etc. are made into Typefi Elements. These elements are accessible to 
the author in Word and populated and positioned during page composition with 
author-defined content.

We will use a mock-up as a starting point for the User Guide Typefi Project.

Sample publication.

Master Pages
When reviewing the use of master pages at the start of your template creation 
consider the following: Does your design contain different parts? If yes, what are 
these parts? These parts would probably become InDesign Sections as you are 
creating the document.
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As an InDesign ‘best practice’, InDesign sections are created in InDesign’s 
Numbering & Section options. The pages belonging to a section are based on 
master pages and can include a section marker. When preparing a design for 
development of a structured and dynamic Typefi InDesign template, reviewing the 
consistency in design choices and usage of master pages is a good starting point.

When looking at the daVinci design you might notice some of the following:

The Front Matter of the Document is built up as follows:
 ■ First Odd Page is Half Title Page.
 ■ Next Even Page is Blank.
 ■ Next Odd Page is Title Page.
 ■ Next Even page is Copyright Information.
 ■ Following the Copyright information a Table of Contents is inserted.
 ■ This is followed by Preface, Introduction and Chapters.
 ■ End Matter finishes the publication.

A Chapter:
 ■ Always starts on an ‘recto’ or right page which contains the chapter title and 

number, and an image.
 ■ The next even page starts on a ‘verso’ or left page and contains a full page 

photo.
 ■ The editorial text that follows after a chapter start always commences on a right 

page and has its own master applied to it. This master contains the Publication 
Title in the left header and the chapter number and chapter title in the right 
header.

With other projects you will discover other patterns. For example, a Higher 
Education publication might be structured this way:

 ■ Chapter starts on right/odd page.
 ■ Next left/even page is a picture page.
 ■ Next odd page is a Learning Objectives page.
 ■ Next even page continues Learning Objectives.
 ■ Next odd page is where the Chapter text starts.

Reviewing the daVinci project design. Different section 
setups for text pages and chapter starts.
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Typefi Sections
Typefi Sections determine how particular InDesign document sections such as 
Chapters are constructed and populated with core content. Sections define which 
InDesign Master pages are used during the composition process and in which 
order they appear. 

Layers
The use of layers in InDesign allows you to easily show and hide objects contained 
within a single layer. As an InDesign ‘best practice’ approach you could consider 
using layers for some of the following:

 ■ A Background layer to place objects that sit in the background, such as 
background tints behind pages.

 ■ A Running Headers or Footers Layer where it is important that these items 
retain their order in the ‘stack’.

For Typefi content you could consider using:
 ■ A Main Content layer that is used for the automated page composition for the 

run-in of the core body content flow.
 ■ An Elements layer in which Typefi Floating and Fixed Elements are placed.

Styles
InDesign contains several different style-formatting tools, each used to provide 
consistently looking text formatting in the fastest possible way.

Paragraph and Character Styles
InDesign paragraph and character styles are highly efficient for text formatting. 
It is important that all of the core content text that is going to be provided by the 
author can be formatted through use of paragraph and character styles in Word or 
XML. 

Layers are a ‘best practice’ method that helps control the stacking order 
of content in InDesign. Isolating content into separate layers ensures that 
there is consistency in the stacking order and that objects sit above or 
below other objects as expected. In addition, Layers are also a great way 
of isolating content types, making it easier to select and edit content.
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For those Typefi Publish projects that work in conjunction with Typefi Writer and 
Word, you can control (from within InDesign) which styles are to be made available 
to the authors in Word. Paragraph styles can make use of the ‘next style’ feature as 
well as the ‘nested style’ feature available to InDesign.

Style names: Although InDesign has no restriction on style names, you should refrain from using style 
names such as: “Heading 1, Heading 2, Heading 3, Title, Subtitle” (case-in-sensitive), as these style 
names are reserved by Microsoft Word and could cause conflicts for the Typefi Engine. To use a similar 
naming convention you could remove the space in these style names or add a prefix (e.g. A_Heading_1). 
Ensure that each style name used is unique and do not use leading or trailing space for style names nor 
bullet characters. (It also causes problems for the Typefi Engine if you only use numbers for style names 
– not that you would do that!)

Typefi Inline Image Settings

With the installation of Typefi Designer plug-ins, the Paragraph and Character Style 
Options include an additional category: Typefi Inline Image Settings. The Typefi 
Inline Image Settings define how Typefi Designer will handle the sizing of Inline 
images and the leading. 

Inline images are images inserted at the cursor position inside a paragraph that 
behave as individual characters do. They can be positioned:

 ■ At the start of a paragraph.
 ■ At the end of a paragraph.
 ■ Anywhere inside a paragraph.
 ■ In a separate single line paragraph.

When defining character styles you should create styles that apply 
minimal formatting, such as all caps, bold, italic, superscript or subscript. 

By default, inline images are automatically resized to fit inside the 
text frame that contains them (as long as interactive preferences are 
disabled).
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Typefi Inline Image Settings

Image Height and Leading

The Ignore Leading option retains the original leading for the line in which the 
Inline image is placed. If the Inline image height exceeds the leading height, the 
top of the graphic will overlap the text in preceding lines. 

Note: Leading is by default a character attribute in InDesign. Enabling the Apply Leading to Entire 
Paragraphs in the standard InDesign Type Preferences will result in a leading setting change for all lines 
of paragraphs - including lines containing Inline images.

Apply Auto Leading ensures that the leading for the line in which the Inline image 
is placed is set to ‘auto’. InDesign’s default Auto Leading setting is set as part of 
the Justification settings for a paragraph. The default setting is 120% of the font-
size. For Inline graphics, the height of the graphic is the basis for the leading. For 
example if the Inline graphic is 1inch high, the leading will be set to 1.2inch.

Inline Image in single line paragraph with 
Apply Auto Leading option enabled.
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Limit Inline Height to Font Size ensures that the height of the Inline image does not 
exceed the font size and images are only resized when their original height is 
larger than the font size. For example, if the original height of the image is smaller 
than the font size, the image is placed at its original size and not resized. If the 
original image height is larger than the font size the image is scaled down to 
match the font size.

Set Inline Height to Font Size resizes the height of the Inline image to the font size 
regardless of its original size at placement. For example when the original image 
height is smaller than the font size the image is scaled up. When the original image 
height is larger than the font size the image is scaled down.

Limit Inline Height to Leading ensures that the height of the Inline image does not 
exceed the leading and images are only resized when their original height is larger 
than the leading. For example, if the original height of the image is smaller than 
the leading, the image is placed at its original size and not resized. If the original 
image height is larger than the leading the image is scaled down to match the 
leading.

When placing small pixel based images and using the Set Inline Height to Font Size or Leading option, 
upscaling will result in loss of image quality due to reduction of image resolution.

Set Inline Height to Leading resizes the height of the Inline image to the leading 
regardless of its original size at placement. For example when the original image 
height is smaller than the leading the image is scaled up. When the original image 
height is larger than the leading the image is scaled down.

INLINE IMAGE SETTINGS FOR CHARACTER STYLES

Inline Image settings applied as part of paragraph style settings are always 
positioned on the baseline of the line of text in which they are placed. In order to 
apply a baseline shift to an inline image, a character style must be used. Set the 
Typefi Inline Image Settings for this character style and set the baseline shift as 
part of this style.

After the inline graphic is inserted using the Typefi Writer, a character style must be 
applied over the top of it.

Original image size smaller than Font Size. Image Height 
and Leading set to Limit Inline Height to Font Size.

Original image size smaller than Font Height. Image Height 
and Leading set to Set Inline Height to Font Size.

Original image size smaller than Leading. Image Height 
and Leading set to Limit Inline Height to Leading.

Original image size smaller than Leading Image Height 
and Leading set to Set Inline Height to Leading.

Inline image with baseline shift applied through character style settings.
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Image Size and Text Frame Size

The Image Size and Text Frame Size define the maximum width or height of an 
Inline image. If the original image exceeds this size, the image will be resized 
based on the Percentage of Text Frame Width or Percentage of Text Frame Height 
settings. For instance, if the ‘Percentage of Text Frame Width’ is set to 25%, the 
width of the graphic will not exceed more than a quarter of the width of the Text 
Frame in which it is placed.

Expansion and Reduction Limits define the maximum and minimum upsize and 
downsize scaling percentage for an image during placement.

Maintain Aspect Ratio: When enabled, this ensures that images are resized 
proportionately.

Style Groups 

Style Groups are a way of organizing Paragraph or Character Styles. The Export to 
Template XML option is disabled for style groups by default. This means that none 
of the styles that are part of the group will be accessible to the Typefi Writer in 
Word.

Before individual styles can have their export options enabled or disabled, the 
Export to Template XML option for the entire Style Group must be enabled.

Using similarly-named styles could result in the Engine selecting the wrong style 
during page composition. Although InDesign’s Style Groups allows duplicate style 
names, Typefi Publish only references styles by name, and during text formatting, 
styles are assigned on a ‘first-style’ basis. Typefi Publish searches for exported 
styles first, then non-exported styles. After that, the second level styles (inside 
Style Groups) marked for Export to Template XML are considered and so on.

Each Paragraph or Character style with Export to Template XML enabled is 
available to the author working on a project’s content with Typefi Writer in Word. 
Disable the Export to Template XML option for those styles that need not be 
accessible to the author in Typefi Writer (such as Table of Contents styles).
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Export to TemplateXML

For Paragraph or Character Styles to be available to the author in Typefi Writer, 
the Export to TemplateXML option must be enabled for the particular style in 
InDesign. For each Paragraph or Character style created that is not part of a style 
group, the Export to TemplateXML option is enabled by default.

To enable or disable the Export to TemplateXML option for a Paragraph or 
Character Style:

 ■ Click the style name in the Paragraph or Character Styles list.
 ■ Select Export to TemplateXML from the Paragraph or Character Styles panel 

menu.
 ■ Alternatively select a Style Group containing a series of styles and enable Export 

to TemplateXML for the Style Group.

Enabling ‘Export To TemplateXML’ for a Paragraph Style 
Group to make its styles available in Writer.

Note: The [Basic Paragraph] Paragraph and [None] Character Styles are 
never exported to Template XML. The command is disabled for these 
styles.
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Object styles
Object styles are useful for many reasons, most relating to working more 
effectively in InDesign. When looking at Typefi structured formatting, you can use 
object styles for reasons other than efficient control of object appearances (such as 
stroke, fill, corner effects, paragraph styles, transparency settings etc.). In addition, 
bear in mind the use of object styles when:

 ■ determining how Inline Elements are positioned during page composition. Both 
Inline and custom anchored-object settings can come in handy.

 ■ assigning Text Wrap settings for Floating and Fixed Elements.
 ■ formatting element content frames. Appearance and the text content of the 

frame can be formatted using an object style. If the paragraph style referenced 
in the object style contains reference to a next style and this feature is enabled, 
then the paragraph following the first style is automatically formatted.

 ■ formatting of element image frames.

Elements
Elements are design components that are not part of the main paragraph-based 
text flow but must be positioned within or near it. Typical elements include 
illustrations, figures and photos, ‘marginalia’ such as sidebars, callouts, quotes and 
notes, and graphics that can be used to mark a break between topics. 

Table Styles
Use InDesign Table Styles and Cell Styles for formatting of tables in your design. 
Typefi’s table style-specific features are integrated with InDesign’s Table Styles, 
adding additional functionality (see Table Styles, p. 127).

The Tables Styles you design in InDesign may form the basis for Typefi enhanced 
prototype tables. The prototype layout of a table is part of the Table Style 
definition. 

One thing to remember at this stage is that although your original table design 
in InDesign might contain merged cells, the structured prototype table that 
you build with the InDesign’s Table Style and tools is not allowed to contain any 
merged cells (see Table Styles, p. 127).
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The Typefi AutoFit panel and tool are used to define relationships between 
objects, frames and lines, enable automatic text frame resize behaviors, and 
enforce minimum and maximum object size limits. AutoFit relationships, 
resize styles and min/max size limits enable designers to create dynamic 
page objects that react and respond automatically as content changes.

New features in Publish v5 include:
 ■ AutoFit relationships, resize styles, and size limits are now preserved when 

exporting to a snippet file, an object library or InDesign Interchange (INX) or 
InDesign Markup (IDML) files.

 ■ Corners are now supported as reference points for AutoFit relationships.
 ■ Bi-directional and multi-parent relationships are also now supported.
 ■ Relationships can now be created between a graphics frame and its content.

AutoFit tool
The AutoFit tool is used to create parent/child relationships between two objects. 
Resizing or moving the parent object simultaneously triggers a resize or 
movement of the child object.

 ■ Select the AutoFit tool from the toolbar.
 ■ Using the parent pointer ( ), select a reference point of the bounding box of 

the first object.
 ■ Using the child pointer ( ), select a reference point of the bounding box of the 

second object.
The Typefi AutoFit tool – added to the Tools panel

Typefi AutoFit
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Relationships are between reference points of the bounding box, not anchor 
points on the object path. They can be created between objects that are placed on 
different layers, but not between inline objects, inline and page objects, or to an 
entire group (individual objects within a group are allowed). Complex relationships 
can be created by daisy chaining multiple parent/child relationships, using the 
same parent with multiple children (one-to-many or many-to-one), or by defining 
bi-directional (parent-to-child and child-to-parent) relationships.

Reference types
AutoFit relationships have different behaviors depending on which reference point 
of the bounding box is selected for the child:

 ■ Center reference points ( ) move rather than resize the child object.
 ■ Edge reference points ( ) resize a child object by stretching the frame along an 

invisible axis perpendicular to its edge.
 ■ Corner reference points ( ) resize an object by stretching the bounding box 

diagonally along an invisible axis radiating from the center through its corner.

AutoFit will not scale stroke width or the frame contents when resizing objects, 
however, it can now create relationships between a graphics frame and its content. 
Objects may also have multiple relationships, where moving or resizing the parent 
point or object will trigger multiple child relationships.

Changing a relationship
To redefine an existing AutoFit parent/child relationship, simply move the child 
reference point or object—you can’t change a relationship by moving or resizing 
the parent because the child automatically resizes or moves according to the 
original relationship.

While AutoFit previously allowed you to invert a parent/child relationship by 
reversing the selection—using the AutoFit tool to reselect the child first, followed 
by the parent—these steps now create a bi-directional relationship, where moving 
or resizing either object triggers a change in the other object.

When an AutoFit 
parent moves…

…its child also 
moves or resizes
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Removing relationships

AutoFit relationships can be removed by using the AutoFit tool to trace over an 
existing relationship—reselect the parent reference point first and then reselect 
the child. Or, choose Remove Relationships from the AutoFit panel menu to 
remove all relationships from the selected object(s).

AutoFit panel
The AutoFit panel is used to enforce minimum and maximum object size limits, 
and enable automatic resize styles for text frames. When combined with AutoFit 
parent/child relationships, the AutoFit panel options enable the design of adaptive 
layouts that dynamically react to content changes.

Minimum and maximum object size
The top portion of the AutoFit panel enables you to limit the width and height of 
individual page objects. The two controls on the left affect the minimum width 
and height*, while the two controls on the right affect the maximum width and 
height.

You can type limits into the fields, or click the minimum or maximum width or 
height buttons to copy the measurements of a selected object. When multiple 
objects are selected, AutoFit copies and applies the measurements of each object 
as unique limits.

Removing object size limits

To remove a limit, delete the entered value or enter 0. To remove all limits from a 
selected object (including any AutoFit resize styles), choose Remove Attributes 
from the AutoFit panel menu.

Automatic resize styles
While you can manually fit a text frame to its content by double-clicking any frame 
handle, AutoFit-enabled frames dynamically resize as content changes. AutoFit can 
also automatically balance columns** for multi-column text frames.

*  Regardless of the AutoFit minimum height, InDesign forces a minimum 3pt height for text frames.
**  Balancing columns is automatic for InDesign CS4, but AutoFit uses the native feature in InDesign CS5, which 
is controlled by Object > Text Frame Options > Balance Columns.

panel
menu

max size

resize
style

max 
vertical
gap

min size

Resize from Top

TYPEFI AUTOFIT

Resize from Top

Set current height as minimum

TYPEFI AUTOFIT
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There are four types of AutoFit resize styles:
 ■ Keep Frame Size (default) does nothing and is equal to a normal InDesign text 

frame. Use this option to turn off automatic resizing.
 ■ Resize from Top creates a ‘soft bottom’ text frame where the top of the frame 

remains fixed while the bottom of the frame snaps to fit all text in the frame.
 ■ Resize from Center evenly distributes the height of the text frame above and 

below the center point while fitting all text in the frame.
 ■ Resize from Bottom preserves the position of the bottom of the frame while 

the top of the frame snaps to fit all text in the frame.

AutoFit attempts to resize text frames to fit all contained text. If the frame is not 
constrained by an AutoFit maximum height limit, the frame may extend to the 
limit of the pasteboard. In addition, if the frame contains an inline object whose 
height is greater than allowed by the AutoFit or pasteboard limit, or if it contains 
text that is wider than a column (due to Hyphenation Settings, nonbreaking 
spaces, or the No Break character attribute), the frame will extend only to the last 
displayable line of text.

Removing resize styles

To remove a resize style, change the frame to Keep Frame Size or choose Remove 
Attributes from the AutoFit panel menu (the latter option will also remove any 
min or max size limits and any applied max vertical gap).

Maximum vertical gap***

The maximum vertical gap provides additional padding, up to the value specified, 
between the top or bottom (or both) of the frame depending on its Vertical 
Justification options.

Publish v5 no longer calculates and automatically applies a maximum vertical gap 
when creating an AutoFit parent reference point on a text frame.

Scripting AutoFit
AutoFit fully supports scripting as part of Typefi Designer. You can use the object 
browser offered by the various languages to examine the objects and methods 
added by AutoFit.

***  The maximum vertical gap setting may be removed in a future AutoFit release.

Resize from Top

[Not Applicable]
Keep Frame Size
Resize from Top
Resize from Center
Resize from Bottom

TYPEFI AUTOFIT



 Typefi Sections 69

Typefi Sections are similar to InDesign Sections you might use during 
manual page-compositions. They will assign particular master page designs 
to document pages; define the type of section content; allow activation of 
section fields; define the page numbering method; etc..

They define the order in which master pages will be used during automated page 
composition as Typefi Publish inserts content in the InDesign document that it 
creates. Additionally, Sections define the page numbering method used, and 
whether any Section Field data should be inserted (see Section Fields, p. 96).

Designing a Section
Prior to creating a new section, review the InDesign design file and determine 
how you would construct a section. For example, imagine that each chapter in 
your publication is a book section. Each new chapter must start on a right hand 
page (or ‘recto’), which means that the preceding chapter might require insertion 
of a filler page when it ends on a right hand page. This first page of a new chapter 
has its own significant design. The rest of the editorial pages that form part of the 
chapter will reference their own master page, and might have running headers or 
footers.

To create a section, consider how the section would be constructed using InDesign 
master pages you have already generated in your document.

Let’s look at some examples.

Typefi Sections
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A chapter starts on a right hand page and has the Cs – Chapter Start master page 
applied to it. This master page contains a Fixed Element (see Fixed Elements, 
p. 103) for the graphic, and two Section Fields (see Section Fields, p. 96) are 
inserted for the Chapter Title and Number.

Cs – Chapter Start.

The rest of the pages in the chapter are created using the Cn – Chapter Next 
master page. These pages are repeated until there is no more content for the 
chapter. As a rule the rest of the pages must start on a right page.

Cn-Chapter Next.

The header on the left master page contains a Project Field (BookTitle) (see Project 
Fields, p. 95). The header on the right master page contains two Section Fields for 
the Chapter Title and Number. Both left and right master also include ‘Main Story’ 
frames.
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 ■ A single filler page is used immediately following the right page that starts a 
chapter, so that the textual pages will start on a right hand page and no blank 
pages appear in the document.

 ■ A blank filler page is used when a textual section finished on a right page, as the 
next new chapter must start on a right page as well.

Cf-Chapter Filler.

Before defining a new Typefi section ensure that:
 ■ All relevant Master Pages required for the creation of a Typefi Section are 

available. This includes filler masters.
 ■ Masters that are part of a Standard Section used for core content run-in contain 

a ‘Main Story’ frame.
 ■ Masters that form part of a Table of Contents Section contain a ‘Table of 

Contents’ frame.
 ■ Fixed Elements are placed only on Master Pages that are used once per Section. 

(For instance, the first page of the chapters could contain a Fixed Element for 
placement of the graphic on that page.)

 ■ Section Fields such as a ChapterTitle or ChapterNumber are inserted where 
relevant – for instance, in headers or footers and title pages. 

 ■ Project Fields are added where relevant – for instance, BookTitle on cover page, 
and in a footer.

New Typefi Section
To define a new Typefi Section:
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 ■ Select New Typefi Section… from the Typefi Sections panel menu (Window > 
Typefi).

 ■ Alternatively click the New Section icon at the bottom of the panel.

The Typefi Section Options dialog box is displayed.

Typefi Section Options

The Typefi Section Options defines how a section is named (Section Name), 
what type of section it is (Standard or Table of Contents), how pagination occurs 
(Masters), how the Page Numbering occurs, and whether any Section Fields are 
part of the section.

 ■ Next enter the Section Name (see Section Name, p. 73).
 ■ Set the Section Type (see Section Type, p. 73).
 ■ Set the Pages settings.
 ■ Enable or Disable Repeat Last Master option.
 ■ Set the Page Numbering settings.
 ■ Then click Fields and set the Field settings.
 ■ Click OK to save the Section to the Typefi Sections Panel.

New Typefi Section…
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Section Name
The section name is a unique name. Use a meaningful name, as the author must 
start each Word document by inserting a Typefi Section. The Section Names are 
also referred to by name at the Typefi project level on the Typefi Publish Server 
(see Starting a Project in the Typefi Systems Server Guide ).

Section Type
There are two Section Types, Standard and Table of Contents

 ■ Standard sections are used for general page composition and content run-in.
 ■ Table of Contents sections are used for the run-in of a Table of Contents. 

Section Type vs. Content

The choice of section type establishes which type of content takes precedence 
in determining whether or not more pages must be inserted during page 
composition. A ‘Standard’ section contains the main body of the content; a ‘Table 
of Contents’ section contains the text that is generated for the Table of Contents. 
Typefi continues to add pages during page composition until the content type that 
has precedence has all been formatted and placed. (Usually it is one content type 
or the other, not both.)

Section Type vs. Typefi Frame Type

In order for Typefi Publish to be able to insert content and generate continuous 
pages, the Typefi Section defines the sequence in which master page designs are 
applied to document pages during composition. These master pages must contain 
‘Main Story’ or ‘Table of Contents’ text frames. The main body of content fills Main 
Story frames and the Table of Contents text fills Table of Contents frames (see also 
Typefi Frame types, p. 81). The goal of the Typefi Engine is to add as many pages 
as necessary to have no text overset on the type of frame it is focused on.

When the Typefi Engine cannot find a Main Story frame in a Standard section 
type after it created a page from the possible master pages, the Engine stops 
the pagination of the section. Similarly, when the Engine cannot find a Table of 
Contents frame in a Table of Contents section, it complains and stops.
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Standard section and Table of Contents frames

The first Master used by a Standard section may contain a Table of Contents 
frame. When the Typefi Engine encounters such a frame, it will trigger the Table 
of Contents creation and insert the text into that frame. Such a Table of Contents 
frame could be used for creation of a short section based Table of Contents for 
instance.

If the TOC text exceeds the frame length, the text becomes overset when:

a) There is more TOC content, but no more Main Story content, which means the 
Engine stops adding more pages.

b) There is more TOC content, but the master page designs used to run-in the 
overset text for the Main Story frames do not contain TOC frames.

Table of Contents Section and Main Story frames

A TOC Section First Master may contain a Main Story frame. When the Typefi 
Engine encounters such a frame, it inserts main body content added by the author 
into the Main Story frame following the Table of Contents Section insert. (Such a 
Main Story frame could, for example, be used when writing up an introduction at 
the start of each chapter.)

If the Main Story text exceeds the frame length, the text in this Main Story frame 
becomes overset when:

a) There is more Main Story content, but no more Table of Contents content, which 
means the Engine stops adding more pages.

b) There is more Main Story content, but the master pages used to run-in the 
overset text for the Table of Contents do not contain Main Story frames.

Pages 
The next part of the Section Options dialog sets the order in which Master pages 
are used and repeated as content is flowed into the document.

There is no limit to the number of Master Pages that can be applied to document 
pages during page-composition. Master pages are used in a top-down order. This 
means that the first Master page listed is used first, then the next one and so on.

Using short section based TOCs requires publishing to a Book rather than 
a Single Document (see InDesign Output Format in the Typefi Systems 
Server Guide).
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Assigning a Master Page to a Section

A New Typefi Section always defaults to the inclusion of the first Master page listed 
in the Pages Panel. 

To assign Master Page(s) to a section:
 ■ Select the Master to be used.
 ■ Set the Start On preferences (see Starts On, p. 75).
 ■ Set the Filler preference (see Filler Master, p. 76).

To assign more master page(s) to a section:
 ■ Click the ‘Add Master’ button.
 ■ Then set the ‘Master page’, ‘Start On’ and ‘Filler’ settings.
 ■ Continue to click ‘Add Master’, until you’ve added all master pages that build a 

Typefi Section.

For instance, for a Front Matter section of a publication you might set the Pages 
settings to: 

STARTS ON

Starts On determines whether the first page of a section starts on left or right side, 
or either side, and whether all pages in the master spread are used or not. See the 
following table for a detailed overview of the Start On options.

Starts On option Description
Either Side The first page of the section can start on either a Left or Right page and is 

determined by the last page of the previous section. For instance, if the 
previous section finishes on a Right page, then the section will start on a 
Left page.

Right Side The first page of the section must be a Right page, regardless of whether 
the previous section ends on a Left or Right page. The Left page is not 
used and depending on further settings the Next Master might be used or 
a last used master repeated.

Left Side The first page of the section must be a Left page, regardless of whether 
the previous section ends on a Left or Right page. The Right page is not 
used and depending on further settings the Next Master might be used or 
a last used master repeated.

Left Side,  
Use All pages

The first page of a section must be a Left page. Both Left and Right pages 
must be used. This means that the Right Page will be inserted whether 
there is content for it or not.

Adding more Master Pages to the Section definition

Front Matter Section using 4 different master 
pages during page composition.



 Typefi Sections 76

Starts On option Description
Either Side, 
Use All Pages

The first page of a section can start on either a Left or Right page 
depending on the last page of the previous section. Both Left and Right 
page must be used. This means that if the section starts on a Left page, 
the Right page will be added whether there is content for it or not (or vice 
versa).

Right Side, 
Use All pages

The first page of a section must be a Right page. Both Left and Right page 
must be used. This means that the Left Page will be inserted whether 
there is content for it or not.

Left Side,  
Use All pages

The first page of a section must be a Left page. Both Left and Right pages 
must be used. This means that the Right Page will be inserted whether 
there is content for it or not.

FILLER MASTER

A Filler Master is a page that is inserted at the end of a section to ensure the 
following section can start on a required left or right hand page. For instance, if 
the next master must start on a Right page, and the previous page is a Right page, 
then a filler master would insert one additional page. The filler master can be a 
specifically designed master page or [None], which inserts a blank page. (Since 
[None] is the default, it can often be left unchanged).

Repeat Last Master
The Repeat Last Master option, when enabled, will continue to apply the last 
master page design during page composition as pages are added to the InDesign 
document that is being created. The Typefi Engine continues to add pages to the 
document until all content is inserted (see also Section Type vs. Typefi Frame 
Type, p. 73).

Page Numbering
The Restart Page Numbering option determines whether the page number of a 
section starts at 1 or follows on from the previous section’s page numbering. This 
setting automatically sets the Start Page Numbering at option in InDesign’s 
Numbering & Section Options. 

Repeat Last Master enabled.

Page Numbering settings in Section Options dialog.
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Style

The Page Numbering Style defines the type of page numbering that is used 
for a Section. The default style is Arabic. Alternate numbering styles are Roman 
numerals (i, ii, iii etc.) and Alphanumeric (a, b, c etc.) in lower- and upper-
case variants. The Page Numbering Style setting automatically sets the Page 
Numbering > Style option in InDesign’s Numbering & Section Options.

To edit the Page Numbering Style for a section:
 ■ Change the preferred numbering style from the Style drop-down.

Mode

The Page Numbering Mode is used to define at which stage automated page 
numbering is reset to “1”.

CONTINUE FROM PREVIOUS SECTION

‘Continue from Previous Section’ means that the page numbering follows-on from 
the last page number of the previous section that is being published, regardless 
of which section is preceding the defined section. For example, you might have a 
document that contains a special Back Matter Section that needs to continue its 
page numbering from the last Chapter of the document.

RESTART AT FIRST SECTION

‘Restart at first section’ means that the page numbering is reset to ‘1’ for the first 
occurrence of the defined section in the publication. Any sections following this 
section will continue their numbering sequentially, including another occurrence 
of the same type of section. 

You could use this setting when the first chapter of a publication restarts its page 
numbering at 1 after the usual front matter, and the following chapters continue 
their page numbering, 

RESTART AT EVERY SECTION

‘Restart at Every Section’ means that the page numbering is reset to ‘1’ each time 
the defined section appears in the publication. 

Due to a bug, the UI chooses “001, 002, 003” as default in the UI instead 
of “1, 2, 3”. This is easily changed to the single digit style.
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Section Prefix
The Prefix is a label that precedes the automatic page numbering in InDesign. The 
prefix value will also appear in a Table of Contents that includes page numbers.

 ■ All of the Prefix data precedes the placement of the page-numbers.
 ■ Text Before and Text After allows for the inclusion of literal text strings (any text 

you want).
 ■ Field data is sourced from either a Section or a Project Field value.
 ■ During page composition in InDesign the Prefix data is inserted as: “Text 

Before” + “Field data” + “Text After” + “Current Page Number”.

Section Marker
When a Section Marker has been included in a Text Frame on a Master Page (Type 
menu > Insert Special Characters > Markers) the Section Marker value added will 
appear in its place on the document pages.

 ■ All of the Marker data entered populates the Section Marker data in InDesign’s 
Numbering & Section Options during page composition.

 ■ ‘Text Before’ and ‘Text After’ allows for the inclusion of literal text strings.
 ■ Field data is sourced from either a Section or a Project Field value.
 ■ During page composition in InDesign the Section Marker data is inserted as: 

“Text Before” + “Field data” + “Text After”.
 ■ Prefix and Section Marker values are non-changeable values once set by the 

InDesign Section Options. When you’re looking at using a changeable prefix or 
section marker in your designs, consider using a Section Field instead. 

Assigning Section Fields to a Section

Any fields that are part of the Section must be included in the Section. Fields are 
discussed in depth in their own chapter (see Typefi Fields, p. 94).

To assign Section Fields to a Section:
 ■ Click Fields in the Typefi Section Options dialog to display the Field section of 

the dialog.
 ■ Enable those Fields that are to be used by the Section.

Or alternatively, if the Section Field has not yet been defined:
 ■ Define a new Section Field by clicking the New Field icon. Assigning Section fields to a Section
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 ■ Name the Field.

For all of the Fields assigned to the Section, the author is prompted to provide 
input data when inserting this element with Typefi Writer in Word.

DELETING A SECTION FIELD

The Field area in the Typefi Section Options can also be used to delete Section 
Fields. However, this only works for Section Fields you’ve just defined in Typefi 
Section Options. Fields added to the Section Fields list whilst the Typefi Section 
Options dialog is open are listed in Italics when they are not selected, so that they 
can be distinguished from any Fields defined earlier.

If any other Section Fields need to be deleted please refer to Deleting a Typefi 
Field, p. 102.

To delete a field:
 ■ Enable the field you’ve added earlier.
 ■ Click the Delete icon at the bottom of the Fields list (see image).

Apply Section
You can apply Typefi Sections in InDesign if needed. The Apply Section command 
controls whether a section starts on a left or right page, but does not apply 
Master page designs to master pages that are part of a section. Typefi Section 
field behaviour can be tested in the InDesign document when a Section has been 
applied.

To Apply a Typefi Section:
 ■ Show the Typefi Sections panel (Window >Typefi menu).
 ■ Select the document page in the Pages panel that is to become the start page 

of a section.
 ■ From the Typefi Sections panel menu choose Apply Section. .
 ■ The Typefi Section has now been applied.

Break Link to Section
Breaking a Link to a Typefi Section, does not remove the InDesign Section marker 
that has been added to a section, nor does it alter the document pagination.

Fields may be used to store hidden meta-data that does not appear in 
the final output, but is required for the content and the XML into which 
the content is ultimately transformed.

Deleting selected field using the Rubbish Bin icon in the Fields list

Apply Section command and button
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To Break the Link to a Section that has been applied:
 ■ Show the Typefi Sections panel (Window >Typefi menu).
 ■ Select the document page in the Pages panel that is the start page of a section.
 ■ Select Break Link to Section from the panel’s menu.
 ■ Alternatively click Break Link to Section at the bottom of the Typefi Section 

panel.

The pages in the section are now no longer associated with the Typefi Section.

Delete Section
To delete a Section from the Typefi Section Panel:

 ■ Show the Typefi Sections panel (Window >Typefi menu). 
 ■ Select the Section that is to be removed.
 ■ Choose Delete Section from the panel menu.
 ■ Alternatively click the Delete Section icon at the bottom of the panel.
 ■ Click OK to go ahead and delete the Section.

The Section will no longer be listed in the Typefi Sections panel and Applied 
Section references are removed from the document.

Break Link to Section.
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Frames are containers for text or other objects, such as graphics. InDesign 
defines three types of content for frames: Text, Graphic and Unassigned. 
Typefi Frames are InDesign frames that contain additional attributes that 
turns them into frames that can dynamically receive content during page-
composition. 

Typefi Frame types
The Typefi Frames panel provides an easy way to designate InDesign text and 
graphic frames as Typefi Frames and to add additional parameters to control how 
those frames should behave when paginated.

There are four types of Typefi Frames:
 ■ Main Story
 ■ Table of Contents
 ■ Element Image
 ■ Element Content

To help distinguish Typefi Frames from InDesign frames, the borders of the frames 
are colored with a 2.5 pt stroke. 

Frame Type

Main Story Red
Table of Contents Dark Blue
Element Content Cyan
Element Image Yellow

When Typefi Publish flows content into Typefi frames, existing content 
that appears in these frames is automatically replaced during population 
of the frames at time of page composition.

Typefi Frames
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Borders only display when View > Show Frame Edges is enabled, Object> 
Overprint Preview is disabled and the document Screen Mode is set to Normal. The 
default Typefi Border can be altered by editing the Typefi Border preferences (see 
Typefi Borders, p. 150)

Main Story
Main Story frames are the more common Text Frame type seen in Typefi 
Templates. Main Story frames are placed on Master Pages used by Typefi Sections.

Typefi publishes content into Sections and uses the Master Pages defined by the 
sections during the composition process to create document pages. Typefi Publish 
automatically runs content into Main Story frames, creating new document pages 
and filling these frames, until all content is placed according to the rules defined in 
a Standard Section (see Typefi Sections, p. 69).

An exception applies for a Table of Contents (TOC) section that contains a Main 
Story frame on only the first page of the section and not the following pages. 
In this case the main story content only runs into the first page of the section, 
even if the TOC runs over multiple pages. However, if a TOC section does include 
Main Story frames on following pages, then the Typefi Designer plug-in will 
automatically run main story content into following pages for the length of the 
TOC section.

Creating a Main Story frame
To create a Main Story frame:

 ■ Open the Master page and insert a normal InDesign Text Frame on the left and 
right master. 

 ■ Select the Text Frame with the selection tool. 
 ■ Choose Typefi Frame Type > Main Story from the Object menu. 
 ■ Alternatively right-click the frame.
 ■ Select Typefi Frame Type > Main Story from the contextual menu that displays 

or select Main Story from the Typefi Frames panel menu.

The Main Story Options prompts you to select the First Paragraph Style. 

Typefi Frame Type.

Main Story Options.
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First Paragraph Style

With the First Paragraph Style set to either [Basic Paragraph] or any Paragraph 
Style, the first paragraph style that appears in the Main Story thread is formatted 
using the defined first paragraph style, regardless of the style assigned by the 
author for that first paragraph.

The First Paragraph Style option is a useful way to apply drop caps or special first 
paragraph formatting to the content without having to specifically set that style 
at content level. This can enhance the reuse of that content. For example, when 
content is reused for web-purposes, it might be irrelevant that the first paragraph 
was formatted with a drop cap originally.

Setting First Paragraph Style to [None] gives the author full control over the text 
formatting. (This is the default setting, so often doesn’t need changing.)

 ■ Select the preferred First Paragraph Style.
 ■ Click OK.

The Main Story Frame Type has now been applied and is distinguished by its thick 
red frame edge.

Table of Contents
Table of Contents (TOC) frames are special text frames designed specifically to be 
populated with table of contents data. The data that fills the TOC frames is based 
on the InDesign Table of Content Style assigned to the frames. Pagination of TOC 
frames occurs after all other pages have been composed. This is because all of the 
source data that is going to be used to populate the TOC frames must be laid out 
in the paginated document first so that their assigned page location is known.

TOCs may be created at publication or section level. Publication level TOCs source 
their content from all sections of a publication. Section level TOCs source their 
content from the section to which they belong.

About section level TOCs:

As InDesign does not permit a TOC to be targeted at a particular page range, the preferred method for 
creating section level TOCs is to ensure each section is produced as an individual InDesign document 
that ultimately will be bound into a book. To automatically compose multiple sections and build section 
level TOCs use the Create Book option in the Job Options for page composition (see also New Job Options 
in the Typefi Systems Server Guide).

Main Story frame property applied to Text Frames 
on Left and Right Ch_ChapterNext page.
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Like Main Story frames, Table of Contents frames are placed on master pages that 
are used as part of Sections.

Table of Contents Styles
Table of Contents are always based on InDesign’s native Table of Contents Styles. 

Start by creating one or more Table of Contents Styles as part of your InDesign 
template prior to assigning the Typefi Frame Type - Table of Contents to a Text 
Frame. 

To create a Table of Content Style in InDesign:
 ■ Select Layout > Table of Contents Styles.
 ■ Click New.
 ■ Name the Style (e.g. TOC_Figures).

Under the Other Styles list, all of the paragraph styles used in the document are 
listed. From this list:

 ■ Select any styles that are applied to content you’d like to see extracted into the 
fully populated TOC frame. 

 ■ Click Add, to add these styles to the Include Paragraph Styles list.

Using the Table of Contents Styles dialog you can set additional settings for 
formatting of the TOC data that is extracted from your document pages during 
page composition, such as the position of the page number, the style with which 
particular data is formatted and the level. For full details on all of the options and 
settings available for creation of Table of Contents Styles in InDesign, please refer 
to InDesign’s Help menu.

If you’ve created separate Paragraph Styles for formatting of the various content 
levels in your Table of Contents, consider placing these in a separate Style Group 
that has Export To TemplateXML disabled. None of the TOC paragraph styles need 
to be accessible in the Typefi Writer in Word.

When used within TOC sections (see Section Type, p. 73), Typefi Publish 
automatically generates the table of contents, creating new Table of Contents 
frames and pages until all TOC content is placed. This happens after all other 
Standard sections are paginated. 

The settings in the Table of Contents dialog that allow you to choose 
‘Replace Existing Table of Contents’ and ‘Include Book Documents’ are 
NOT used when the TOC frame gets updated by the Typefi process, 
however they would be used if called upon by a script, or by the InDesign 
User Interface.

Bk_Contents Table of Contents Style preset created 
for the daVinci project in InDesign.
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Note: Because TOC sections are created as the last step in the process, Typefi Publish forces the first 
Standard section following a TOC section to start on the right side and does not allow pages to ‘shuffle’. 
This may result in a filler master being inserted after a TOC section.

Creating a Table of Contents (TOC) frame
To create a TOC frame:

 ■ Open the Master page and insert a normal InDesign Text Frame. 
 ■ Select the Text Frame with the selection tool.
 ■ Choose Typefi Frame Type > Table of Contents from the Object menu..
 ■ Alternatively right-click the frame and select Typefi Frame Type > Table of 

Contents from the contextual menu that displays. Alternatively select Table of 
Contents from the Typefi Frames panel menu.

The Table of Contents Options dialog prompts you to select the InDesign Table of 
Contents Style on which to base the Typefi TOC.

 ■ Select the appropriate InDesign TOC style.
 ■ Click OK.

The Table of Contents Frame Type is applied and is recognizable by its thick dark 
blue frame border.

About TOC frames
A TOC frame can also be included on a normal master page in the document, and 
can share that page with a Main Story frame. This permits inclusion of smaller TOCs 
throughout a document. For instance, you could use this to include a section-
based TOC on the first page of a new section. The section itself doesn’t need to 
be defined as a TOC Section (see also Section Type, p. 73). Such a TOC frame will 
not thread onto further pages if the TOC becomes overset on the first page of the 
section (The TOC frame will thread to a next page of a section if there is another 
page in the section that uses a TOC frame for the same TOC style. Within a normal 
section, the Engine will not add pages just because there is an overset TOC frame). 
InDesign does not permit a TOC to be targeted at a particular page range, so the 
preferred method for creating section-level TOCs is to ensure they are separate 
documents that ultimately will be bound into a book. You can select a Book 

Table of Contents Options.

Table of Contents frame property applied on Text 
Frame on TOC Contents master page.
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output from the Job Options in the Server (see also New Job Options in the Typefi 
Systems Server Guide).

Use multiple TOC frames to generate different TOC types such as Table of Tables, 
Table of Figures and so on. Due to the limitations of InDesign’s TOC styles, 
these must currently exist as separate frames. Although additional TOCs can be 
appended to the main TOC, this would require a Typefi feature enhancement to be 
added to your project in the form of a script. 

Element Image
Element Image frames are placeholder graphic frames used within Typefi Elements 
(see Typefi Elements, p. 103) and provide a number of options to control the 
fitting and placement of images. For an Element Image frame to become active 
it must become part of an element and it must have an image associated with it 
from content.

Creating an Element Image Frame
To create an Element Image frame: 

 ■ Select an InDesign Graphic Frame, created with one of the frame tools, with the 
selection tool.

 ■ From the Object menu select Typefi Frame Type > Element Image. 
 ■ Alternatively right-click the frame and select Typefi Frame Type > Element Image 

or select Element Image from the Typefi Frames panel menu or select Element 
Image from the Typefi Elements panel menu Typefi Frames submenu.

The Element Image Options dialog prompts you to select the image expansion 
and fitting options. 

 ■ Select the appropriate Fitting setting.
 ■ Set the Expand From option.
 ■ Set the Expansion and Reduction Limits.
 ■ Click OK.

An Element Image frame can also be used directly on a master page. 
In that case, an inline image from the content of the main story could 
be placed in that frame rather than being placed as an InDesign inline 
image (a feature since the first version of Typefi).

Element Image Options
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Element Image Frame (left) and Original Image Size (right)

The Element Image Frame Type has now been applied and is distinguished by its 
2.5pt Yellow frame border.

Element Image Options
Let’s review the Element Image Options using a few examples.

Fitting

The fitting options automatically adjust the size of an image or its frame when 
placing a graphic into the element image frame during page composition.

Frame resize behavior in turn may also be dependent on the inclusion of minimum 
or maximum frame width and height settings applied to the frame by AutoFit.

FIT FRAME TO CONTENT

‘Fit Frame to Content’ resizes the Element Image frame to the full image size, 
therefore the image is always placed at 100%.

Fitting Options
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Fit Frame to Content

FIT CONTENT TO FRAME

‘Fit Content to Frame’ resizes the image to fit in the Element Image frame. No 
frame resizing occurs. Where the image proportion doesn’t match the frame 
proportion the image is placed non-proportionally and may appear stretched.

Fit Content to Frame

FIT CONTENT PROPORTIONALLY

‘Fit Content Proportionally’ resizes the image to fit in the Element Image frame. 
The image is resized proportionally. No frame resizing occurs, perhaps resulting 
in part of the frame appearing empty if the proportions of the image differ from 
those of the frame.
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Fit Content Proportionally

(This setting could be used where image frame sizes must remain consistent 
throughout the page composition and no part of the image may be masked. This 
setting is suitable for instances of illustrative or technical graphics that must be 
placed without cropping.)

FILL FRAME PROPORTIONALLY

‘Fill Frame Proportionally’ resizes the image to fill the entire Element Image Frame. 
The image is resized proportionally. No frame resizing occurs, often resulting in 
part of the image being masked out.

Fit Frame Proportionally

(This setting could be used where image frame sizes must remain consistent 
throughout the page composition and part of the image may be masked. It is a 
setting normally used for photo placements.)
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FIT CONTENT AND FRAME PROPORTIONATELY

‘Fit Content & Frame Proportionally’ starts by resizing the image to fit in the 
Element Image frame. (The image is resized proportionally and displayed without 
cropping.) Immediately following the image resizing, the frame is reduced in size 
and fitted to the content.

Fit Content & Frame Proportionally

Expand From

This option allows project designers to automatically align imported graphics to 
any edge of an Element Image frame.

Select the side and corner of the image frame that will act as the reference points 
for any size change of the image. These are ‘frozen’ and the frame will resize from 
those points.

Fitting set to Fit Content & 
Frame Proportionally enabled
Expand From set to Top, Right. 

Expand From example.

For example (see graphic above) when fitting is set to Fit Image to Frame, setting 
Expand From to Top | Right, causes the Bottom | Left corner of the image to resize 
to the frame, and then the frame resizes to match the new graphic size.
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Bottom

Top

Left Center Right

Middle

Expand From settings.

Setting Expand From to Middle causes the corners to move equally in opposite 
directions. For example, selecting Middle | Center will cause the image or frame to 
shrink or grow precisely from the center point of the image or frame.

Top, Middle and Bottom generate horizontal positioning, and Left, Center and 
Right generate vertical positioning.

Expansion Limit

The expansion limit sets the maximum scaling percentage allowed for an image 
during fitting to the Element Image frame. The minimum value is 100%. Select a 
preset expansion limit from the pop-up list, type your own percentage, or choose 
No Limit to ignore this option.

Reduction Limit

The reduction limit sets the minimum scaling percentage allowed for an image 
during placement in the Element Image frame. The maximum value is 100%. Select 
a preset reduction limit from the pop-up list, type your own percentage, or choose 
No Limit to bypass this option.

To apply absolute height or width limits, for example 1.25 inch wide, use 
the Typefi AutoFit panel.
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Element Content
Element Content frames are placeholder Text Frames used within Typefi Elements. 

Note: Fields placed inside Element Content frames are deleted during page-generation, and are 
therefore best placed inside normal InDesign Text Frames.

Creating an Element Content Frame
To create an Element Content frame: 

 ■ Select the Text Frame with the selection tool.
 ■ From the Object menu select Typefi Frame Type > Element Content. 
 ■ Alternatively right-click the frame and select Typefi Frame Type > Element 

Content or select Element Content from the Typefi Frame panel menu or select 
Element Content from Typefi Element panel menu, Typefi Frame Type submenu.

The Element Content Options dialog prompts you to select the First Paragraph 
Style. This is the paragraph style that is to be applied for the very first paragraph 
that populates the Element Content frame.

 ■ Select the First Paragraph Style.
 ■ Click OK.

Element Content Options.

First Paragraph Style

Similar to the Main Story frame, the First Paragraph Style setting overrides the 
style of the first paragraph that appears in the content. You can use this in the 
same way to apply specialized formatting to the element content regardless of the 
actual paragraph style applied by the author in Typefi Writer. 

(For example, you could use this setting to automatically apply a first paragraph 
heading style or a special formatting to sidebar content without the author 
needing to set the style manually in Typefi Writer.) As with the Main Story frame 
option, this enhances content reuse without having to change markup.

Element Content Frame.

Element Content Frame with default border  color(cyan) 
property applied to Text Frame (bottom).
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The Element Content Frame Type has now been applied and can be distinguished 
by its thicker cyan frame edge.

Clearing Typefi Frame Type
Note: the Script labels displayed in the Typefi Frames panel are used by scripts to read information 
about Typefi Frames, Typefi Elements and Typefi Anchors.

To clear a Typefi frame property from an InDesign frame: 
 ■ Select the frame with the selection tool.
 ■ Choose Typefi Frame Type > None from the Object menu.
 ■ Alternatively right-click the frame and select Typefi Frame Type > None or 

select None from the Typefi Frames panel menu or select None from the Typefi 
Elements panel menu Typefi Frames submenu. 

You can also click the Clear Frame property icon at the bottom of the Typefi 
Frames panel.

Clearing Typefi Frame Property.
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Typefi Fields are content placeholders that carry values assigned by the 
author at the element, section or project level. The text that populates fields 
is automatically inserted into each instance of that field that appears in the 
InDesign document during page composition. 

Fields can exist on document title pages; as part of a running section header; or 
in a Typefi Element. When determining whether a field is relevant for usage in 
your InDesign template, look for text that repeats itself throughout a layout. For 
example, you can use them for chapter titles, chapter numbers, project names, 
dates, document references, author name, ISBN and so on. 

The following table provides some examples of Typefi Field uses:

Field Type Scope Sample uses Value supplied from
Project Field value can be used 

across all pages and 
sections in the current 
project.

Document title, author 
name, customer name, 
reference number, 
publication date, 
product name, part 
number

Project home page on 
Typefi Server

or

Inserted during Typefi 
Print… from Word.

Section Field value can be used 
across all pages in the 
current section.

Part title, chapter 
title, section number, 
component name

Section Insert in Typefi 
Writer

Element Element Fields for the 
inclusion of content in 
an element.

Captions, copyright 
data, figure number, 
date

Element Insert in Typefi 
Writer

Typefi Fields
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Project Fields
A Project Field is a field in which the value remains the same throughout all 
sections of a publishing project, regardless of the section in which it might appear. 

Imagine you are working on a publishing project that is part of a series of 
publications. Each publication would have different titles, subtitles and author 
details. 

When we look at the title page design for the publication, several potential Project 
Fields could be identified:

 ■ Publication title - this text is repeated on the left page of the general content 
pages for the publication.

 ■ Publication subtitle - this field text doesn’t repeat, but in a series of publications, 
this content could be entered at project level, so that during running of the job 
this text is automatically inserted.

 ■ Publication author - this field also doesn’t repeat. However, in a series of 
publications, this content could be entered at project level similar to the 
Publication subtitle.

 ■ Publisher – this field could repeat on the copyright page.
 ■ Inside cover contains copyright information. The copyright year and owner 

could be set as a Project Field. 

Create Project Field
To create a New Project Field: 

 ■ Display the Window > Typefi > Fields panel. 
 ■ Select New Field from the panel menu. Alternatively click the New Field 

Definition icon at the bottom of the panel.

The Field Options dialog is displayed.
 ■ Enter a unique Name.
 ■ Set the Type to Project.
 ■ Click OK to create the new Project Field. 

The Project Field is added to the Typefi Fields panel. In addition, any Project Fields 
that you add will appear as part of the Project Settings on the Typefi Server (see 
also Starting a Project in the Typefi Systems Server Guide).

Title page design for daVinci project.

New Field.

Field Options dialog.
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Section Fields
While Project Field values remain the same throughout a publication (unless they 
are manually changed at ‘Run Job’ level), Section Fields only retain their value 
throughout a single Typefi Section (see also Typefi Sections, p. 69).

Section Fields, in addition to text, can include counters. Counters are useful for 
tracking chapter numbers, or could be used as a prefix for figure numbers that 
belong to a certain chapter number. The value (number) of the counter does not 
need to be explicitly defined within the content by the Author. Instead, counters 
are automatically updated by the Typefi Designer plug-ins during page 
composition. 

Note: When editing the published InDesign file post page-composition: Counters are updated 
automatically only when new Typefi Sections are inserted. Insertion of standard InDesign sections will 
not result in Counters being updated. This is because Section Fields are only associated with Typefi 
Sections.

Regardless of the order in which Sections are published through Typefi Publish, 
Counter Fields will count sequentially.

Examples of text that may be formatted using Section Fields include:
 ■ Chapter Number
 ■ Chapter Title

In some cases chapters might form part of an InDesign ‘book’. Each part name or 
number could also be a Section Field.

Create Section Field
To create a new Section Field: 

 ■ Display the Window > Typefi > Fields panel. 
 ■ Select New Field from the panel menu. Alternatively click the New Field 

Definition icon at the bottom of the panel.

The Typefi Field Options dialog is displayed.
 ■ Enter a unique Name.
 ■ Set the Type to Section.
 ■ Set the Format to either Text or Counter.

Potential Section Fields.

Create New Field.
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 ■ Click OK to create the new Section Field. 

Field Format settings define the field’s data type. Section Fields have their Format 
set to either Text or as a Counter. 

Text

Fields with Format set to ‘Text’ are populated with literal text data provided by 
users at Section level.

To create a text-based Section Field:
 ■ Set Format to Text. 
 ■ Click OK to accept the setting and create the Section Field.

The New Section Field is added to the Typefi Fields panel.

Counter

Fields with Format set to ‘Counter’ are populated with numbers automatically. The 
numbering mode is defined as part of the Typefi Section definition (see Typefi 
Sections, p. 69).

A Counter Field carries a numerical value that is incremented automatically as 
page-composition inserts each Typefi Section. For example, consider a project 
job option set to publish a number of chapters that are each generated as an 
individual section in the publication. As each section is compiled, the chapter 
number is automatically incremented. If you opt to alter the order of sections at 
Run Job level, the numbering will adjust accordingly.

To create a Section Field that works as an automatic counter:
 ■ Select Counter as the Content Type for the Field. 
 ■ Click OK to accept the setting and create the Section Field.

The new Section Field is added to the Typefi Fields panel.

Note: Section Fields can also be defined as part of the Typefi Section (see Typefi Sections, p. 69).

Field Options: Section Field with Format set to Text.

Field Options, Section Field with Format set to Counter.



 Typefi Fields 98

Element Fields
An Element Field is a Field that is used by a Typefi Element. In contrast to Section 
Fields, Element Fields do not support counters and are given a value during 
element insertion. The content author is prompted to enter a Field value when an 
Element containing Fields is inserted with the Typefi Writer in Word.

As the elements are inserted during the automated pagination the Element Fields 
are filled with the author-assigned values.

Create Element Field
To create a New Element Field:

 ■ Display the Window > Typefi > Fields panel. 
 ■ Select New Field from the panel menu. Alternatively click the New Field 

Definition icon at the bottom of the panel.

The Typefi Field Options dialog is displayed.
 ■ Enter a unique Name.
 ■ Set the Type to Element.

The Format for Element Fields is automatically set to Text.
 ■ Click OK to apply the settings and create the New Element Field.

The New Element Field is added to the Typefi Fields panel.

Note: Element Fields can also be defined as part of the Typefi Element (see Assigning Element Fields to 
an Element , p. 112)

Applying Fields
Fields are always inserted in standard InDesign text frames and never in Typefi 
Frames, as any pre-existing content in Typefi Frame types is replaced by actual 
content during the page-composition process.

Apply Field with text highlight
When applying a field to highlighted text, the text becomes the default data value 
for this Field. 

Note: When including an Element Field as part of a Typefi Element, 
ensure that the Text Frame is a normal InDesign Text Frame and not a 
Typefi Element Content frame. Typefi Frame content is totally refreshed 
during the pagination process, thereby removing the field markers.

Create New Field.

Field Options: Element Field with Text as Content Type.

Applying Selected Field.
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To apply a field to highlighted text inside a text frame: 
 ■ Highlight some text with the Type tool.
 ■ Select the Field Name in the Typefi Fields panel.
 ■ Select Apply Field from the panel’s menu or click Apply Selected Field at the 

bottom of the Typefi Fields panel.
 ■ Alternatively double-click the Field Name to add Field Markers around the 

highlighted text.

Field Markers appear as red square brackets around the highlighted text and 
indicate that the Field Definition is applied to the text. If you opted to apply a field 
at the text cursor insertion point, without highlighting text, you will see the Field 
Name surrounded by Field Markers instead. 

To display Field Markers:
 ■ Enable Show Field Markers option from the Typefi Fields panel menu.

During page composition the template text marked up with Project Field Markers 
is replaced by the assigned Project Field values. When publishing a job from the 
Typefi Server the field values are picked up from the Project Settings (see also 
‘Starting a Project’ in the Typefi Systems Server Guide). When printing a job from 
Typefi Writer, the values are picked up from the values entered in the Typefi Print 
dialog (see also ‘Publishing from Word’ in the Typefi Systems Server Guide).

Apply Field without text highlight
To insert a field in a text frame without having existing text highlighted:

 ■ Place your cursor at the insertion point in the Text Frame.
 ■ Select the Fieldname of the Field in the Typefi Fields panel.
 ■ Select Apply Field from the panel’s menu. 
 ■ Alternatively double-click the Field name to add Field Markers around the 

highlighted text or click Apply Selected Field at the bottom of the Typefi Fields 
panel.

For example, let’s assume the Element design requires the author to enter the 
name of a painting, as well as the date and painter’s name. To prompt the author 
for data entry when the Element is inserted into the Word document with the 
Typefi Writer, you could assign three Element Fields as part of the Element 

Typefi Fields applied.

Apply Element Field example.
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definition. One Element Field is used for the name of the painting; a second field 
for the date; and a third for the painter’s name.

An InDesign Text Frame can contain multiple Fields as well as pre-defined text. The 
Element example here contains a Text Frame that not only fills two different Fields 
with text but also pre-populates the Text Frame with the words ‘Name’ and ‘Year’. 
When the author inserts the Element in Word using Typefi Writer a prompt will 
appear asking the author to assign values to ‘PaintingName’ and ‘PaintingYear’ 
fields.

Field synchronization
When you change the content of any one Field, Typefi Designer updates all other 
instances of that Field throughout the document. You can use this feature to test 
how your document will react to certain Field values. Will a lengthy chapter title 
prove too long for the current page header design? If so, you can either redesign 
the page header or use AutoFit (see Typefi AutoFit, p. 65) to adjust the frame as 
needed.

Synchronizing Project Fields
When a Project Field value is amended in a text frame that is positioned on a 
Master page, the field value is updated on all other master pages on which it 
appears. However, if document pages contain overridden text frames, the original 
project field values are retained.

Project Field values that reside within overridden text frames on document pages 
change globally across all document pages when their value is amended.

Synchronizing Section Fields
Where a Section Field value is amended in a text frame that is positioned on a 
Master page, changes are applied only to occurrences of the Section Field within 
the Master Spread pages.

Section Field values (when changed within an overridden text frame on a 
document page) only change on document pages that are part of the section to 
which the overridden text frame belongs.

Element with two Element Fields (left) and example pagination (right).
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When Section Counter fields are amended, a follow-on effect will occur in those 
Sections following it, as the counter values are set automatically.

Synchronizing Element Fields
Element Field values that are changed are only updated within the Element to 
which they are applied. If the Element contains nested Elements, and the field 
repeats within these nested Elements, the nested Element field values update as 
well.

Breaking Links to Fields
To Break the Link to a Field that has been applied:

 ■ Place your type cursor anywhere between the open and close Field Markers.
 ■ Select Break Link to Field from the panel’s menu.
 ■ Alternatively click Break Link to Field at the bottom of the Typefi Fields panel.

The Field Markers should now no longer be visible, indicating that the text has not 
been marked up with a Field Marker.

Renaming a Field
To rename a Field:

 ■ Select the Field from the Typefi Fields panel.
 ■ Select Field Options… from the panel menu and change the Name. 
 ■ Click OK to acknowledge the name change. 
 ■ Alternatively, locate a text frame in your InDesign document that references 

the Field and place the type cursor anywhere between the Field Markers, then 
double-click the highlighted fieldname in the Typefi Fields panel to access the 
Field Options… and change the name.

Each of these methods will update the Field name, but not the text that is listed 
between the Field Markers. To alter the text between the Field Markers you must 
edit it manually.

Break Link to Field.
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Deleting a Typefi Field
When a Typefi Field is deleted from the Typefi Field panel, the Field Markers 
throughout the template are removed. The text between the original field markers 
is then ‘normal’ text and therefore not affected by the removal of the field markers 
when the Typefi Field definition is removed.

To delete a Field from the Typefi Fields Panel:
 ■ Show the Typefi Fields panel (Window >Typefi menu). 
 ■ Select the Field that is to be removed.
 ■ Choose Delete Field from the panel menu.
 ■ Alternatively click the Delete Selected Field icon at the bottom of the panel.
 ■ Click OK to go ahead and delete the Field.

The Field will no longer be listed in the Typefi Fields panel, and related Field 
Markers are removed from the document.
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Typefi Elements can be compared to assets stored in an InDesign Object 
Library. A Typefi Element – like a library asset – is created once, and then 
re-used throughout the InDesign layout with different content for each 
instance that is placed.

Elements work in conjunction with Typefi Frame Types (see Typefi Frames, p. 81) 
and (not in every case) Typefi AutoFit (see Typefi AutoFit, p. 65) and can be formed 
from a single frame, or a group of frames, and can also include line or shape 
objects. In addition, Elements can contain Element Content or Image frames as 
well as Fields. 

There are three types of elements: Fixed, Inline and Floating Elements.

Fixed Elements
Fixed Elements are elements for which each instance appears in a predefined 
context and location. This is in contrast to Inline and Floating Elements which 
are placed and positioned based on their contextual relationship to content and 
layout rules during page composition.

The positioning and placement of Fixed Elements is based on their original master 
page position. The master page on which they are placed must be part of a Typefi 
Section (see also Typefi Sections, p. 69). During page composition the content of 
this element is inserted and the Element position is based on its original position 
on the Master page. You can use only one instance of a particular Fixed Element 
per section.

Typefi Elements
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Fixed Elements may also be used as a nested Element inside Fixed, Inline or 
Floating Elements (see Nested Elements, p. 123). Fixed Elements also differ from 
Inline and Floating Elements in that they are not based on a prototype element.

Inline Elements
Inline Elements compare best with InDesign’s inline or anchored objects. They are 
inserted into the main story text flow during page composition. The Inline position 
of these elements can be controlled by an External Paragraph Style (see External 
Paragraph Style, p. 111) or anchored object options applied through an Object 
Style.

Floating Elements
Floating Elements are designed objects that are placed outside the main content 
thread. The Typefi Engine places and positions them on a page according to layout 
rules and priorities. Floating Elements may use ‘variants’, which are layout design 
alternatives. They can be automatically selected during page-composition based 
on layout rules that you specify, or the design choice can be made by the author as 
the Element is inserted in the Word document. (Where Floating Elements overlap 
Text Frames, enable Text Wrap settings on the Element Group.)

The layout rules are only applied by the Typefi Engine during page composition. They are not 
considered if the user edits a document manually or if a script is applied. In other words, in contrast to 
all other features of the Typefi Designer, the Typefi Designer plug-in does not update floating element 
positions (neither automatically nor on demand).

Element creation process
Elements use various Typefi components such as Typefi Frame Types, Typefi 
AutoFit, Typefi Fields. Elements can also contain normal InDesign objects such as 
Text Frames, Graphic Frames or Lines. When creating a Typefi Element you could 
use the following steps as a ‘best practice’ approach:

 ■ Step 1 – Create the Element artwork in InDesign 
 ■ Step 2 – Set AutoFit relationships and attributes
 ■ Step 3 – Define Typefi Frames and Element Fields
 ■ Step 4 – Apply Frame Types

Variants

Fixed Element

(with custom 
anchored object 

applied)

Float Element

Section
Master

Section Master

Non-Section
Master

Non-SectionMaster 4-5

2-3

2-3

2-3

1

Inline Element

Elements overview (simplified diagram).



 Typefi Elements 105

 ■ Step 5 – Define Elements and apply Fields
 ■ Step 6 – Apply the defined Element to artwork
 ■ Step 7 – Define Floating Elements, Variants and Layout Rules

As an example of how you’d run through the element creation process, we’ll use 
the ‘Painting Element’ that’s part of the da Vinci publication. This element is going 
to be a Floating Element.

Step 1 – Create the artwork
Start by creating the artwork in InDesign, and then determine what type of 
element you will be creating: Inline, Fixed or Floating. The element you create is a 
prototype that Typefi uses throughout its page composition process whenever the 
element is inserted by the author in the content. 

Elements that appear more than once in a section, with different content in each 
element, are always either Inline or Floating. Each appearance of such an element 
throughout the paginated document is an occurrence of the Element prototype, or 
an occurrence of the Element prototype variant. Such elements cannot be Fixed, 
as only one occurrence of a Fixed Element can exist within a section. 

The artwork for our example element has already been created (see next graphic).

Placement of elements

Although – in contrast to Fixed Elements – Inline and Floating Elements can be 
placed for use during page-composition on document pages in the InDesign 
template, it is good practice to keep the number of normal pages in a template 
document down to a minimum.

Therefore, as ‘best practice’, create your Inline and Floating Elements on separate 
master pages that are not used by Typefi Sections and create individual masters 
for each element type. Typefi Publish will use these elements as objects that it 
can draw from during the page composition process. To have more control over 
Floating Elements consider placing them on their own layer. Avoid placing Inline or 
Floating elements in the Pasteboard area.

Tip: For more accurate placement of Floating Elements, position them on Master Pages that are based 
on pages used by sections, so that margin and column settings are retained.

There is nothing to prevent you from creating more than one instance 
of a fixed element of a given name within a section or within another 
element.

In work-flows that don’t use the Writer (like plain XML-based work-flows), 
any number of fixed elements with the same name can occur in the 
layout for a single section or a single element instance. The Designer 
plug-in will just create the anchors to these elements in an order that 
depends on the order of elements in the containing section or the 
containing element.

However, it is not recommended to use more than one fixed element of 
the same name in a section or another element, since it is not obvious for 
a user in which order the fixed elements will be filled. And if the Typefi 
Writer is used, it will not allow you to use more than one instance of a 
fixed element per section or element.

The very ‘best practice’ would be if the template document is limited 
to just one normal page with no content and the master page [None] 
applied to it. This is just a recommendation if performance matters, since 
the more normal pages a template document contains, the more time 
it will take the Typefi Designer plug-in to open and clear the normal 
content pages. During template development, however, it could be 
helpful to have a lot of example content to experiment with. That is one 
of the reasons why inline and floating element prototypes on normal 
pages are allowed (the other one is that it makes it fairly straight forward 
to mark-up a document with an already desired layout for use as a 
template document).
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Step 2 – Setting AutoFit relationships and attributes
Next analyze the artwork and determine the AutoFit relationships and fitting 
attributes for the various objects that make up the Element. Use the AutoFit tool 
and AutoFit panel to set these relationships and fitting attributes.

Let’s review the sample element again:

What are the relationship and fitting requirements?
 ■ When the graphic frame is resized as a result of image sizing, the Line 1 must be 

moved with it, as it must retain a fixed distance to the top of the graphic frame. 
This is a parent-child relationship between the top of the graphic frame and the 
line.

 ■ The Text Frame containing the caption must be repositioned as the bottom of 
the graphic frame is repositioned. This is a parent-child relationship between 
the bottom of the graphic frame and the top of the Text Frame.

 ■ The Text Frame itself must grow from the top down as more content is entered. 
This is an AutoFit attribute: Size from Top.

 ■ As the bottom of the Text Frame grows to make text fit, the line below it must 
move. Hence, there must be an additional parent-child relationship between 
the bottom of the Text Frame and Line 2.

 ■ We assume that the element has a fixed width, as it is going to appear as a 
marginal note. You could consider setting a maximum width on the graphic 
frame, that does not exceed this margin width.

Consider width and height requirements

When working on elements consider the use of frame height restrictions, such as 
maximum height for the purpose of ensuring that an element cannot grow past 
the page dimensions.

Minimum size settings could be handy when an author inserts an element, but has 
not yet received content for that particular element. A minimum size setting would 
ensure that a certain amount of space is reserved in the layout for the element 
during page composition.

Line 1, always same 
distance from top of image

Line 2, fixed distance from 
bottom of text frame

Text frame containing 
painting details.

Image of painting, must 
display full-painting, no
wider than current width,
but can size up or down.
Image must be placed
proportionately

Sample Element comprising multiple objects

Set AutoFit Relationships and Attributes.
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Step 3 – Typefi Frames and Element Fields
With the AutoFit relationships and fitting attributes set, it is time to determine 
which element items or components are going to be defined by Fields and which 
will become Typefi Frames. 

Consider the following:
 ■ Element Fields are generally used for entry of data by the author that is limited 

in length and would be inserted in standard InDesign Text Frames.
 ■ Fields inserted inside Element Content frames will always have their entire 

content overwritten, thereby clearing any literal and Field data that pre-existed 
in these frames. 

 ■ The Element Content frame is normally applied to the Text Frame that is to hold 
the bulk of the element’s text, and can hold multiple paragraphs of text. 

 ■ An Element can only contain one unthreaded Element Content frame. Where 
multiple Element Content frames are required, they must be threaded, then 
grouped. To use multiple Element Content frames within an Element, use 
nested Elements (see Nested Elements, p. 123). Text frame threading must be 
retained within the element and may not thread to frames in other (nested) 
elements.

 ■ An Element can contain one or more Element Image frames. However, as the 
placement order for the images depends on the order in which the images were 
added to the Element Group, it is difficult for the Typefi Designer to control 
placement of images in intended order. An alternate solution would be to build 
a series of fixed elements containing element image frames and nest these 
inside the Element.

In our example we can use three Fields to set the detailed information for painting 
name, date and painter, as this data resides in a single Text Frame. If we were to 
use an Element Content Frame instead, then the author would have to remember 
in which order to type in these details, as all content must be provided by the 
author. In addition, the words ‘by’ in front of the painter’s name and ‘date’ in front 
of the year in which the painting was first finished must be included. The graphic 
frame would become an Element Image frame.

Element Example
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Step 4 – Apply Field(s) and Frame Types.
Set the Element Content and Image Frame Types. Then for the remainder of the 
Text Frames apply the Fields. (For more information about defining and applying 
Fields see Nested Elements, p. 123. For additional information on Frame Types see 
Typefi Frames, p. 81.)

Step 5 – Define Elements
In order to create an element prototype from the artwork you’ve created, you must 
first define the element itself. 

To define a new element:
 ■ Select New Element from the Typefi Elements panel menu. 
 ■ Alternatively, click the New Element icon at the bottom of the Typefi Elements 

panel.

The New Typefi Element dialog box appears.
 ■ Set the Element Type to either Fixed, Floating or Inline.
 ■ Next enter the rest of the settings as appropriate.
 ■ Click OK to save add the Element. 

The newly defined Element is now listed in the Typefi Elements panel.

Defining a Fixed Element

To define a Fixed Element:
 ■ Select New Typefi Element from the Typefi Elements panel menu. Alternatively 

click the New Element icon at the bottom of the Typefi Elements panel.
 ■ Enter a unique Element Name. 
 ■ Set the Element Type to Fixed.
 ■ Set the Default Paragraph Style.
 ■ Click Fields and Assign Element Fields that are to be used by the Element (see 

Assigning Element Fields to an Element, p. 109.)
 ■ Click OK to add the New Element to Typefi Elements.

Defining a New Element.

Setting Fixed Element options.
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DEFAULT PARAGRAPH STYLE

The Default Paragraph Style is the paragraph style assigned to the Element 
Content area when the Element in question is inserted through Typefi Writer in 
Word and is therefore only meaningful in Typefi Publish processes that include 
Typefi Writer usage. 

If the Element Content frame options define a First Paragraph Style other than 
[None] (see First Paragraph Style, p. 92), the first paragraph of the Element 
Content will be formatted using the First Paragraph Style during pagination, 
regardless of the Default Paragraph Style that is applied at content level by Typefi 
Writer. 

The Default Paragraph Style formats subsequent paragraphs, and may be 
overridden with other styles if needed by the author using the Typefi Writer. 

Where the First Paragraph Style is set to [None] for the Element Content frame, 
text will be formatted based on paragraph styles applied at element content level 
by the author in Typefi Writer. Setting the Default Paragraph Style in that case 
could be an efficient way of formatting the majority of the element content.

For example, if an Element Content frame is to contain lots of normal text 
paragraphs with the occasional subheading, you’d set the Default Paragraph Style 
to ‘Normal Text’ (or whatever the style is named), so that the author would only 
need to apply the ‘subheading’ styles for text that is different.

ASSIGNING ELEMENT FIELDS TO AN ELEMENT

Any fields that are part of the Element must be included in the Element. For 
extensive information on Element Fields and insertion of Fields in Text Frames (see 
Element Fields, p. 98).

To assign Element Fields to an Element: 
 ■ Click Fields in the Typefi Element Options dialog to display the Field section of 

the dialog.
 ■ Enable those Fields that must be used by the Element.

Alternatively, if the Element Field has not yet been defined:
 ■ Define a new Element Field by clicking the New Field icon.
 ■ Name the Field .

Element Content Options.

Enabling Element Fields in Typefi Element Options.



 Typefi Elements 110

For all of the Fields assigned to the Element, the author is prompted to provide 
input data when inserting this element with Typefi Writer in Word.

Fields may be used to store hidden meta-data that does not appear in the final output, but is required 
for the content and the XML into which the content is ultimately transformed.

DELETING AN ELEMENT FIELD

The Field area in the Typefi Element Options can also be used to delete Element 
Fields. However, this only works for Element Fields you’ve just defined in Typefi 
Element Options. Fields added to the Elements Fields list whilst the Typefi Element 
Options dialog is open are listed in Italics when they are not selected, so that they 
can be distinguished from any Fields defined earlier.

If any other Element Fields need to be deleted please refer to Deleting a Typefi 
Field, p. 102.

To delete a field:
 ■ Enable the field you’ve added earlier.
 ■ Click the Delete icon at the bottom of the Fields list.

Defining an Inline Element

To define a New Inline Element:
 ■ Select New Typefi Element from the Typefi Elements panel menu. Alternatively 

click the New Element icon at the bottom of the Typefi Elements panel.
 ■ Enter a unique Element Name.
 ■ Set the Element Type to Inline.
 ■ Set the Default Paragraph Style.
 ■ Set the External Paragraph Style.
 ■ Click Fields and Assign Element Fields that are to be used by the Element.
 ■ Click OK to add the Element to Typefi Elements.

DEFAULT PARAGRAPH STYLE

The Default Paragraph Style is the paragraph style used by Typefi Writer in Word 
(see Default Paragraph Style, p. 109 for more extensive information).
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EXTERNAL PARAGRAPH STYLE

An Inline Element is usually placed within its own paragraph into the main story 
content during page composition in InDesign. (Like images, inline elements can 
appear within or outside a paragraph. The external paragraph style is therefore 
not applied if an inline element is inserted within a paragraph). The External 
Paragraph Style points to a paragraph style that formats this paragraph in which 
the Inline Element is placed. 

Consider creating unique paragraph styles for Inline Element placement in 
InDesign. The style would contain at least a setting for alignment and leading. 
Auto Leading adjusts the leading according to the height of the Element, thereby 
preventing it from overlapping text.

ASSIGNING ELEMENT FIELDS TO AN ELEMENT

Any fields that are part of the Element must be included in the Element (see 
Assigning Element Fields to an Element, p. 109). For more information on 
Element Fields and insertion of Fields in Text Frames (see Element Fields, p. 98).

Defining a Floating Element

To define a Floating Element:
 ■ Select New Typefi Element from the Typefi Elements panel menu. Alternatively 

click the New Element icon at the bottom of the Typefi Elements panel.
 ■ Enter a unique Element Name. 
 ■ Set the Element Type to Floating. 
 ■ Select the Default Paragraph Style.
 ■ Enable Keep floats in order if required.
 ■ Click Fields and Assign Element Fields that are to be used by the Element.
 ■ Click OK to add the Element to Typefi Elements.

DEFAULT PARAGRAPH STYLE

The Default Paragraph Style is the paragraph style used by Typefi Writer in Word 
(see Default Paragraph Style, p. 109)

Inline Element – Typefi Element Options.
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KEEP FLOATS IN ORDER

Keep floats in order ensures that the order of appearance of Floating Elements is 
retained during page composition. Disabling the option means that the Typefi 
Engine is at liberty to change the order of the Floating Elements during pagination, 
if this provides a better placement option.

ASSIGNING ELEMENT FIELDS TO AN ELEMENT 

Any fields that are part of the Element must be defined as part of the Typefi 
Element (See Assigning Element Fields to an Element, p. 109).

In the example above, we’re defining the Floating Element for PaintingDetails. 
The three Element Fields added earlier must all be listed in the Used Fields list, so 
that the author will be prompted to enter the specific information requested by 
each of the Fields. E.g. Name of the Painting (PaintingName), Date of the painting 
(PaintingDate) and the Name of the painter (PaintingBy). 

Assigning Element Fields to the Typefi Element.

Element listing

All Elements are listed in the Elements panel. Each element type is preceded by an 
element specific icon. To display all Element Types in the Elements panel, select All 
from the Element Type pop-up menu.

Defining a Floating Element.
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For projects containing a large amount of elements, you might want to view only 
elements of one particular type. From the Element Type pop-up menu select the 
Element Types (Inline, Fixed, Floating) you’d to like display in the Elements panel. 

Step 6 – Apply the element.
At this stage we’ve prepared all of the artwork and defined a new Typefi Element. 
We have not yet defined the artwork itself as an Element Prototype. Applying the 
Element to selected artwork defines the Element Prototype.

To apply a defined element to your artwork, whether it is a Fixed, Inline or Floating 
Element:

 ■ Select all of the frames and lines that make up the element with the Selection 
tool.

AUTOMATICALLY GROUP SELECTIONS

Artwork that is going to have an Element applied to it must be grouped. However, 
you won’t need to manually group the objects before applying the Element. 
Simply enabling the Automatically Group Selections option in the Typefi Elements 
panel menu will do.

 ■ From the Typefi Elements panel menu verify that the Automatically Group 
Selections option is enabled. 

 ■ Select the Element Name from the Typefi Elements panel. If you can’t see the 
Element name, ensure that the Element Type menu lists All elements.

 ■ Select Apply Element from the panel menu. Alternatively click Apply Selected 
Element at the bottom of the panel.

 ■ A default Light Blue colored border appears around the group for Floating or 
Inline Elements, with a name tag in the lower left hand corner. Fixed Elements 
display a default Green border.

ELEMENT PROTOTYPE

Element designs for Inline and Floating Elements must be Element Prototypes 
of an Element in order for them to be useable by Typefi Publish during page-
composition. 

Floating

Inline

Fixed

Different Element Types.
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The default Element Prototype Typefi Border color is Light Blue. Disabling the 
Element Prototype option from the Typefi Elements menu turns the Element into 
an instance of an Element. The default Element Instance Typefi Border color is 
Green. 

Element Prototype and Instance Typefi Border colors could appear differently for 
documents with alternate Typefi Border Preference settings (see Typefi Borders, 
p. 150).

Apply Fixed Element

An example of a Fixed Element would be a graphic that appears on the Chapter 
Title page:

To apply a Fixed Element:
 ■ Select all objects that form part of the Element design. 
 ■ Select the Element in the Typefi Elements panel 
 ■ Choose Apply Element from the panel menu. 
 ■ Alternatively click Apply Selected Element at the bottom of the panel.

The Green Border indicates you’ve created a Fixed Element Instance. 

Apply Inline Element

To apply an Inline Element: 
 ■ Select all objects that form part of the Element design. 
 ■ Select the Element in the Typefi Elements panel.
 ■ Choose Apply Element from the panel menu. 
 ■ Alternatively click Apply Selected Element at the bottom of the panel.

A blue group border indicates the Inline Elements is applied to the artwork and 
the artwork is marked up as the Element Prototype. 

After applying the element to the artwork, consider applying an Object Style to 
the element that sets specific anchored object settings that position the Inline 
Element during page composition. 

Note: As Typefi places content dynamically, please ensure that the ‘Prevent Manual Positioning’ option 
in the Anchored Object Options is disabled when applying an Object Style to Inline Elements.

Applying a Fixed Element to a selected group of objects.

Inline Element applied.
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Apply Floating Element

To apply a Floating Element: 
 ■ Select all objects that form part of the Element design.
 ■ Select the Element in the Typefi Elements panel.
 ■ Choose Apply Element from the panel menu.
 ■ Alternatively, click Apply Selected Element at the bottom of the panel.

The default blue group border indicates the Floating Elements is applied to the 
artwork. As a Floating Element must have at least one variant, a single variant is 
listed immediately below the Element, with a [1] marker next to it, indicating that 
this is Floating Element variant 1. 

The default Light Blue group border further indicates that the selected variant is 
marked up as the Element Prototype. Disabling the Marked as Element Prototype 
option from the Typefi Elements panel menu turns the Element into an instance of 
the selected variant. The default group border color changes to Green.

As Floating Elements are often placed over the Main Story content, applying 
Text Wrap to them will ensure that the content of the Main Story flows around 
the elements. (To apply consistent and easily changeable Text Wrap settings to 
Floating Elements you could create and apply an Object Style to the element that 
only sets the Text Wrap settings to the element.) 

Step 7 – Define Floating Element Variants and Layout Rules 
Floating Elements differ from Inline Elements as their prototypes are always 
variants. Each variant has its own set of layout rules controlling variant selection 
and placement during page composition. An Inline Element, in contrast, has only 
one prototype that must exist for pagination.

Floating Element Variants

Variants represent a design for a Floating Element. Every Floating Element must 
have at least one variant, but may also have more than one variant. Variants can be 
used to create asymmetrical versions of the same element. One element design 
may be targeted at a left-hand page, and another at the right. Variants can also be 
used to define different horizontal span sizes for elements. For example, a variant 
may span both columns in a two-column design, while another variant of the same 
element fits neatly into a single column.

Floating Element applied.
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Positioning of variants is controlled through layout rules. The layout engine will 
choose and place the variants based on these rules. Authors could limit that 
choice further, by specifying that a particular variant should be used as they are 
inserting the element in content. This also permits variants to be defined and used 
for special purposes such as for reserving the right amount of space on the page 
for an illustration that is still to come. One variant could reserve a full page, while 
another could reserve half a page.

Let’s take a closer look at Variants and Layout Rules for Floating Elements.

Creating Variants for Floating Elements

A variant is automatically created when you first apply a Floating Element to 
selected artwork (see Apply Floating Element, p. 115).

To create additional variant prototypes for a Floating Element:
 ■ Select alternate element design artwork.
 ■ Click the Floating Element name in the Typefi Elements panel.
 ■ Choose Apply Element from the Typefi Elements panel menu or alternatively 

click Apply Selected Element at the bottom of the Typefi Elements panel.

Variants are automatically numbered [1], [2], etc., and during page composition 
each variant prototype is considered for placement. 

VARIANT OPTIONS

Variant Options set variant specific settings such as: variant name, layer in which 
the variant is placed during pagination. As well as minimum space allowed 
between variants.

To edit the Typefi Element Variant options:
 ■ Select Element Options from the Typefi Elements panel’s menu.
 ■ Alternatively, double-click the variant in the Typefi Elements panel.

The Typefi Element Variant Options dialog is displayed:
 ■ Enter the Variant Name (if needed).

A variant name will be visible to the author in Typefi Writer and enable the author 
to choose which particular variant is to be used during page composition. Leaving 
the Variant Name empty will not provide the author with the choice of variant. The 
choice of variant is then made during page composition by the Typefi Engine.

A variant must have a name in order for the author to be able to select it 
in the Writer.

A Variant (named ‘Margin’) of a Floating Element (named ‘PaintingDetail’)
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Different variants of an element can carry the same name. For instance, if there 
are right and left page versions for the Margin_Float, similar to the margin notes 
in this user guide. Creating two variants one for the left and one for the right hand 
page designs carrying the same name, will prompt the Typefi Engine to use the 
appropriate design when the element in inserted on either left or right hand page.

Variants that contain significant difference in appearance or layout rules could 
be given different variants names so that the author can distinguish them when 
inserting an Element and choosing its variant. 

 ■ Select the Layer in which the variant should appear.

By default the layer in which the current variant is placed is selected.
 ■ Set Float Spacing.

To prevent multiple Floating Elements placed on individual pages from 
overlapping, enable Float Spacing for the element variant and set the minimum 
space settings. These space settings are acknowledged during page composition.

 ■ Click OK to apply the Variant Options to the selected Variant.

Setting Layout Rules

Each variant has its own set of Layout Rules. These layout rules are considered 
by the layout engine during page composition and play an important role in 
determining where on a page a Floating Element will be placed.

To display a variant’s Layout Rules:
 ■ Select the variant in the Typefi Elements panel. 
 ■ The Layout Rules display in the lower half of the panel.

Layout Rules for variants consist of three different rule components:

1) Align with… rule options that set rules for vertical and horizontal placement of 
the element.

2) Priority bars, that the layout engine uses to prioritize the four Align with… rule 
settings when placing elements.

3) Can appear on… settings that define whether an element can be placed on 
Left, Right or both pages during page composition.

Notes:

The element prototype and all element instances will be placed on that 
layer.

If you move the prototype of a floating element to a different layer in 
InDesign, this setting will be modified as well, moving also all element 
instances to that layer.

Layout Rules for selected variant, with cursor setting 
priority rules for variant alignment.
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ALIGN WITH… RULE OPTIONS

Align with … rule options determine the vertical and horizontal positioning of 
variants during page composition. 

To define the Rule Options: 
 ■ Click the dark gray Align With… bars in the Layout Rules section of the Typefi 

Elements panel.

There are four Align with… rule options that can be set for a variant, namely:

1) Align with top of …

2) Align with middle of …

3) Align with bottom of …

4) Align with … of anchor

The first three rule options: Align with top, Align with middle and Align with 
bottom point to vertical positioning in association to the Text Frame position 
(Main Story Frame) by default. The fourth rule is set to Align with Baseline of 
anchor by default.

VERTICAL ALIGNMENT

Vertical Alignment settings determine the vertical positioning (top/bottom) of the 
Floating Element variant on the page. 

The Align with Top, Middle and Bottom of … rule options define:

a) Which part of the Floating Element Variant (Top, Middle or Bottom) is going to 
align to the Top of either Column Edge, Text Frame (default), Page Margin, Page 
Edge or Prototype Frame.

b) Which part of the Floating Element Variant (Top, Middle or Bottom) is going to 
align to the Middle of either Column Edge, Text Frame (default), Page Margin, 
Page Edge or Prototype Frame.

c) Which part of the Floating Element Variant (Top, Middle or Bottom) is going to 
align to the Bottom of either Column Edge, Text Frame (default), Page Margin, 
Page Edge or Prototype Frame. 

Rule Options (Align With … ).

Vertical Alignment example: Top of float aligned with Baseline of anchor.

Vertical Alignment example: Top of float aligned 
with Top of Paragraph of anchor.
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As an element is inserted in content using Typefi Writer a link is defined between 
the element and the text position where it was referenced in the text. After page 
composition, these links can be made visible in InDesign. The markers that display 
the link are called Typefi Anchors.

To display Typefi Anchors in InDesign:
 ■ Select Show Typefi Anchors from the View Menu.

The Align with… of anchor option defines which part of the Floating Element 
Variant (Top, Middle or Bottom) is going to align to either the Baseline, Cap Height, 
Top of Leading, or Top of Paragraph of the anchor position. The anchor position 
relates to the point at which an author inserts an element into the Word 
document. 

The following table summarizes the anchor based vertical alignment options.

Option Description
Baseline Positions the top, middle or bottom of float to the baseline of the 

Anchor location for the element.
Cap Height Positions the top, middle or bottom of float to the Capital Height of 

the line of text in which the anchor is placed.
Top of Leading Positions the top, middle or bottom of float to the Top of the Leading 

of the line of text in which the anchor is placed. This means that the 
top, middle or bottom of the float is seemingly aligned with the 
bottom of the previous line.

Top of Paragraph Positions the top, middle or bottom of float to the top of the 
paragraph in which the anchor is placed. If the anchor is placed at the 
end of the paragraph, the alignment will relate to the top of the first 
line of that paragraph.

When an Align with… option is edited, the Layout Rules text display for the option 
in the Typefi Elements panel is updated. 

For instance, let’s look at the default Align with top of Text Frame rule option. If we 
change this to Align Top of float to Top of Page Edge, the rule text will change to 
top of page edge.

The Y-offset value defines a further vertical movement for the element after 
placement according to the Align with… rule options. A negative value will move 
the element up; a positive value will move the element down. The value (-0.1 

Vertical Alignment: Top of float to Top of Leading of anchor.

Rule Options for Align with Top of … settings.
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in) assigned for the Y-offset in the previous Rule Options screenshot, moves the 
element outside the page area into the document bleed.

The Top and Bottom Limit options further constrain the positioning of the variant 
vertically. Keep in mind that these options carry the highest level of priority and 
overrule other Vertical Alignment settings. For instance, setting the Top Limit to 
Page Edge and entering a negative Y-offset value (-0.1 in) in the example above 
will push the Element -0.1 in into the bleed area of the document. The Top Page 
Edge value (equal 0 in), would override the negative Y-offset value. 

Vertical Alignment Limit 
Options

Description

No Limit Variant placement can fall inside as well as outside the page 
boundaries. Where No Limit is selected, the Y-offset and Align 
with… options will take precedence.

Column Edge Variant placement must fall within the top and bottom edge of 
the text column position frame on the page. This will be the text 
column that contains the Typefi Anchor to the variant.

Text Frame Variant placement must fall within the top and bottom edge of 
the Text Frame on the page. This will be the main story frame.

Page Margin Variant placement must fall within the top and bottom margins 
defined for the page on which it is placed.

Page Edge Variant placement must fall within the top and bottom edge of 
the page.

Prototype Frame Variant placement must fall within the top and bottom position 
of the actual prototype frame. Setting these limits to prototype 
frame ensures vertical positioning is set to the current prototype 
variant position.

HORIZONTAL ALIGNMENT

Horizontal Alignment options define the horizontal positioning (left/right) of the 
variant on the page. 

The Align with… rule options define:

a) Which part of the Floating Element Variant (Left, Center, Right, Outside, Inside) 
is going to align to the Left, Center, Right, Inside, Outside of either Column Edge, 
Text Frame, Page Margin, Page Edge or Prototype Frame (default).

b) Which part of the Floating Element Variant (Left, Center, Right, Outside, Inside) 
is going to align to the Anchor

Edited Align with… rule.

Horizontal Alignment Options.
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Inside/Outside settings refer only to the documents with facing pages (left/right-
spreads). 

 ■ Inside refers to the spine-side.
 ■ Outside refers to the trim-side. 

The use of Inside/Outside alignment options allows a single variant to be applied 
to Left and Right pages.

The X-offset value defines a further horizontal movement for the element after 
placement according to the Align with rule… options. A negative value moves the 
element to the left; a positive value moves the element to the right. 

The Left and Right Limit, determine the outermost positions at which the variant 
may be placed in the page composition.

Horizontal Left / Right 
Limit Setting

Description

No Limit Variant placement can fall inside as well as outside the page 
boundaries. Where No Limit is selected, the X-offset and Align 
with… options will take precedence.

Column Edge Variant placement must fall within the left/right edge of the text 
column position frame on the page. This will be the text column 
that contains the Typefi Anchor for the variant.

Text Frame Variant placement must fall within the left/right edge of the Text 
Frame on the page. This will be the main story frame.

Page Margin Variant placement must fall within the left/right margins defined 
for the page on which it is placed.

Page Edge Variant placement must fall within the left/right edge of the page.
Prototype Frame Variant placement must fall within the left/right position of the 

actual prototype frame. Setting these limits to prototype frame 
ensures horizontal positioning is set to the current prototype 
variant position.

PRIORITY BARS

Each Align with… rule has its own priority bar. The Priority Bars set the importance 
level of the rule. Priorities can range from none (0), to some (1, 2, 3), to full (4). 

To edit the priority level for an Align with… rule:
 ■ Click on the bars with the mouse. 

Element variant placement in double-sided layouts

Priority Bars indicating rule preferences
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Clicking to the left of the smallest bar sets the priority level to none. 

During page composition, the Typefi Engine considers all rules and priority levels 
set for the variants. It then determines the best possible layout through placement 
of elements according to the highest combined priority levels. When one Align 
with… rule has a priority setting and others don’t, the Typefi Engine will use the 
priority setting and matching Align with… rules for placement of the element 
variant. 

For example, to align an element to the top of the page and never any other 
position, set the align top of frame rule to the highest priority and set the priority 
level to none for all other Align with… rules.

Overall, variants with a higher overall priority setting will take precedence on the 
page during page composition.

CAN APPEAR ON OPTIONS

The Can Appear On left or right page options define whether a variant may be 
placed on a left page, right page or both left and right pages. Select Can Appear 
On … text, to allow placement. Deselect Can Appear On … text, to disallow 
placement. 

More on Fixed Elements
The same Fixed Element can be applied to artwork on different Master Pages used 
as part of a Typefi Section definition. However, content for an individual fixed 
element is only assigned once per section. This means that where an Element is 
repeated on other master pages, the same content is inserted for each occurrence 
of the Element.

Warning: Although this feature works on Element Image frames, Typefi does not provide support for 
use of this feature in Element Content frames, as conflicts with cross-references, bookmarks and Table 
of Contents generation could occur where the same element is repeated across a section.

It is generally recommended that Fixed Elements are used on the Master Page that 
starts a section, rather than on the repeating pages.

Choosing whether an Element can appear on 
left or right-hand pages (or both)

Fixed Element placed on different pages.
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Be consistent in usage of Typefi frame types for Fixed Elements, especially where they are applied to 
different artwork on various Master Pages that are part of sections. In addition, you should refrain 
from using Fixed Elements of the same name more than once, as different pagination results could be 
generated in different versions of Typefi Publish.

Nested Elements
Fixed Elements may be nested inside Fixed, Floating or Inline Elements. An 
example would be a Floating or Inline Element that consists of three 
graphic+caption components. 

Each of these sub-components could be defined as an individual Fixed Element 
and included in the Floating or Inline Element. The Floating or Inline Element must 
contain an Element Content frame (set to be non-printing and made very small) 
in order to populate this with the Fixed Elements it contains. Using this technique 
makes it easier to provide prompts for authors in regards to insertion of multiple 
images or fields in an element.

nested

Three Fixed Elements nested within a Floating Element.
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Anchors are markers that indicate where an element is referenced in the 
content. The location of the element in relation to its anchor is determined 
by the element’s layout rules. 

Displaying Anchors
In a paginated InDesign document that contains placed elements, the relationship 
between an element and its reference point in the text can be displayed by 
selecting View > Show Typefi Anchors.

When displaying a story that contains Typefi Anchors in the Story Editor (Edit 
menu), anchors are displayed using the same icon InDesign uses to display 
Anchored Objects.

For Fixed and Floating Elements, the Story Editor will display a single Anchor icon. 
For Inline Elements, the Story Editor displays two Anchor icons. The first of these is 
the Typefi Anchor and the second is the InDesign anchor. Deleting the first anchor 
will leave the Element artwork in place, but it loses its reference to Typefi. Deleting 
the second anchor will result in total deletion of the Element and both anchors will 
be deleted.

Repositioning Anchors
To edit the Anchor position: 

Drag and Drop Text Editing for the Story Editor must be enabled in Preferences > Type in order to drag 
and drop anchors into new positions.

 ■ Start by displaying the Typefi Anchors.

Floating Element with Anchor relationship displayed.

Inline Element with double Anchor displayed in the Story Editor.

Typefi Anchors
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 ■ Place your text cursor close to the anchor position in the text. 
 ■ From the Edit menu select Edit in Story Editor. 
 ■ The Story Editor window appears. Locate the anchor or anchors and highlight 

them.

To reposition the Anchor:
 ■ Place the cursor roughly in the highlighted area and when the drag and drop 

text icon appears, click and drag the highlighted anchor(s) to their new position.
 ■ Close the Story Editor window when finished.

Creating Typefi Anchors
When a new Element instance is added to an InDesign document post-pagination, 
a Typefi Anchor is not automatically inserted. 

It is important to create Anchors, as without these Element references, elements 
will stay behind during the round tripping process from InDesign back to CXML 
and therefore won’t appear in any new content files that are created or updated 
based on the CXML file.

Note: Anchors created for Inline Elements are always inserted next to the InDesign anchored object 
anchor.

To create Typefi Anchors after placement of new Elements:
 ■  Select the Create At Start of Page or Create At End of Page from the Object > 

Typefi Anchors menu. 

Anchors will be created for all Elements that lack a reference.

Create At Start of Page
Create At Start of Page inserts the Anchors at the start of the first paragraph on the 
page that contains the Element. If this paragraph starts on the previous page, the 
anchor is actually inserted at the end of the previous page. 

Anchor position changed.
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Create At End of Page
Create At End of Page inserts the Anchors at the start of the last paragraph on the 
page that contains the Element. If this paragraph continues on the next page the 
anchor is actually inserted at the start of the next page.

To move an anchor to a different location after creation, use the steps outlined in 
Repositioning Anchors, p. 124.

Remove all Anchors
When performing a lot of post-processing editing tasks in InDesign, such as 
moving elements to different pages or locations, it might be useful to remove all 
anchors prior to (re)creating them.

To remove all anchors:
 ■ Select Remove all Anchors from the Object > Typefi Anchors menu.
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A Table Style is a style that prescribes how a table is to be formatted. When 
you define a table style and apply it to many tables, the tables will take 
on the same formatting as that defined by the style. As you edit the table 
style, any tables formatted with the style will automatically be updated 
throughout the document.

Table Styles include specific properties, such as table formatting and column width 
behavior that is used during pagination. It isn’t often that tables inserted in Word 
by the author have the same number of columns or rows as the table used as the 
source of the Table Style created in the InDesign template.

Typefi Table Styles features are added to the InDesign Table Styles Panel. . Three 
additional settings categories are added: Layout Settings, Width Settings and 
Headers and Footers. 

All of the Table Style settings as well as the settings enabled for a table by the 
author in Word (such as header and footer rows) assist the layout engine in 
working out which formatting it should apply to the various rows and columns of 
the table.

Table Styles must be added to the InDesign template so that the author can use 
them in Word. These tables, once marked-up appropriately with Typefi Writer, will 
then reformat themselves during page composition in accordance with the Typefi 
Table Style settings. Three extra categories are added to the InDesign Table Styles dialog.

Table Styles
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Creating Table Styles
So where do we start when it comes to creating Table Styles with Typefi Table Style 
functionality? 

Table Styles can be created from a base table style design that was created using 
InDesign’s built-in Table Styles, Cell Styles, and Table feature, and then further 
formatted to the design requirements. 

Although not necessary, it would not be a bad practice to create potential 
prototype tables on a separate master page that isn’t used by Typefi Sections. 
In contrast to how Elements work, Table Styles are fully self-contained and don’t 
require the original table to be kept, similar to how paragraph, character and 
object styles work. For example, once you’ve created a new Table Style, which 
could be based on a table style you’d started with, the original table style is no 
longer required for formatting purposes. 

Designing tables for Table Styles
Let’s assume a table design was created by the project designer:

Most project designers will make a table design look the way it needs to look once 
the layout is finished. When designing tables for the automated Typefi Publish 
workflow there is one important thing to keep in mind: The prototype table from 
on which you base the Table Style is not allowed to contain any merged cells. A 
Table Style, when applied, does not generate any merged cells and is used solely 
to determine which formatting is applied where. As any number of cells can be 
merged by the author in Word or editor of an InDesign document, unmerged data 
is required as a reference to this formatting. 

This means that when you’re looking at the previous table design, you’d need to 
recreate the table and count how many rows and columns the table would have in 
its unmerged version, and use this unmerged table as the source design for a new 
Table Style.

In short: to start the development of a Typefi Table Style, generate a table design 
that contains NO merged cells. The author inserting a table with Typefi Writer 
in Word can merge cells, as can the project designer who inserts a new table in 
InDesign.

Table design in InDesign containing Merged Cells.

Unmerged version of the table design, which can be 
used for development of Typefi Table Styles.
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A note of caution: try to use just the minimum of rows and columns to define all necessary repeating 
patterns. Large table prototypes can create problems as soon as the InDesign document would get 
converted to a new version of InDesign or a new version of a plug-in that requires a different plug-in 
specific data format.

To ensure the best level of automation when creating a table design or table style 
that forms the basis for the Typefi enabled Table Style use the following approach:

Insert Table
To insert a new table, ensure you have created a Text Frame first and inserted the 
Type Cursor at the table insertion point. To insert a new table select Table > Insert 
Table. The Table Dimensions dialog appears, prompting you to enter header, 
footer, body rows and columns settings. To create a new table that is not based on 
an existing Table Style, ensure the Table Style option is set to [No Table Style].

Insert table.

Enter at least the minimum rows and columns settings required to create a table 
that can contain all table attributes. For instance, if your table design will have two 
Header Columns and one Footer Column, then a minimum of 3 Columns must be 
included. 

Column and Row Types

Header Rows are rows located at the top of the table and can repeat themselves 
when a table is broke across columns, frames or pages during pagination. Header 
Columns are columns located at the left side of the table. Footer Columns are 
columns located at the right side of the table. Footer Rows are rows located at 
the bottom of the table and can repeat themselves when a table breaks across 
columns, frames or pages during pagination. 

Example of table containing two Header Rows, two 
Header Columns and one Footer Row.
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Table header and footer rows are introduced and managed by InDesign, while header and footer 
columns are introduced and managed by the Typefi Designer plug-ins.

Format table
You’re now ready to continue formatting the table. Start by using InDesign’s Table 
Options and Cell Options to define Table Setup, Alternating Row/Column Stroke or 
Fill Settings, Text Inset, Row Height etc. and format the header rows/columns, 
footer rows/columns and body cells with paragraph styles. In addition, use 
InDesign’s Cell Styles to format rows and columns. 

When formatting the InDesign table keep in mind the following formatting differences between 
InDesign’s native Table Style definition and Typefi’s extended Table Style definitions. InDesign’s Table 
Styles are limited, applying just one cell style for the formatting of Header Rows or Footer Rows. In 
addition, InDesign can only define a different layout for one Left and one Right column. Typefi’s Table 
Style extension allows for different header and footer row designs and multiple header and footer 
column designs. 

New Table Style
Once you’ve created and formatted the Table in InDesign you are ready to create a 
new Table Style.

To create a New Table Style: 
 ■ Select the entire table.
 ■ From the Table Styles panel menu select New Table Style or alternatively click 

the New Table Style icon.

The New Table Style dialog box appears. 
 ■ Enter a unique Table Style Name for the style you are creating. 

This table style name will be available to the author as a table is inserted in content 
using Typefi Writer. 

 ■ Next make the appropriate table attribute changes where required for each of 
the categories listed in the dialog: General, Table Setup, Row Strokes, Column 
Strokes, Fills, Layout Settings, Width Settings, Headers and Footers. 

 ■ Click Ok to add the Table Style to the Table Styles panel.

Table fully formatted.

New Table Style dialog.
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Table Setup, Row/Column Strokes, Fills and Header and Footer settings are 
identical to InDesign’s settings. Creating a new table style from a table style that 
is already formatted in InDesign automatically copies across the Table Setup, Row/
Column Strokes, Fills and Header and Footer settings.

Create Table From Style
The InDesign menu ‘Table’ contains two additional Typefi Publish specific items:

‘Create Table from Style...’: This is an alternative to InDesign’s ‘Insert Table...’. The 
item opens a dialog to allow you to select a table style that is used to apply the 
Typefi table prototype information to a newly-inserted table. The dialog also 
allows you to choose whether the prototype table or a new table instance should 
be created.

‘Typefi Table’ is a sub menu with:

‘Apply Typefi Style Attributes’: Just (re-)applies the Typefi specific table style 
attributes.

‘Avoid Table Cell Oversets’: Active if the selected table has cells with overset text. 
The Typefi plug-ins try to modify the cells of the selected table such that no 
overset occurs (which might ignore the maximum table width setting of the style 
to some extent).

‘Mark as Prototype Table’: Applies the current prototype table settings. Needed to 
specify empty cells definitions. You will need to update the table style setting by 
opening the table style dialog and apply ‘Use Selected Table as Example’ in the 
‘Layout Settings’ panel.

Layout Style Settings
To copy all table attributes from the selected table into the New Table Style:

 ■ Click Use Selected Table as Example. 

Where the new table design isn’t based on a table containing Typefi specific table 
attributes, some settings will require additional setup, as these aren’t defined in 
the current table attributes. For instance, the Header Columns and Footer Columns 
settings default to “0”.
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Reset Typefi Attribute
To clear all Typefi specific table attributes from the Table Style and retain only 
InDesign table attributes, click Reset Typefi Attributes. 

Additional Cell Information
Text inside cells for the table design from which you are creating the Typefi Table 
Style might be formatted using a Paragraph Style or Cell Style that applies a 
Paragraph Style. 

Keep First Paragraph Style

The Keep First Paragraph Style records the paragraph style applied to the first 
paragraph of each table cell as an attribute of the Table Style definition. 

Enabling this option means that regardless of the paragraph style formatting 
applied by the author to first paragraphs in table cells, the style recorded as the 
table attribute is applied. 

This feature is particularly handy for tables that contain fixed formatting of cell 
data, where the cell formatting is predictable, such as those we see in reports. 
However, where the table data must be formatted with a range of different 
paragraph styles, this option should be disabled. It consequently means that no 
paragraph-based formatting is recorded for the table style at all, and an author 
must apply the appropriate paragraph style to each individual table cell.

Keep Horizontal Cell Alignment

This option records the horizontal alignment of each cell in the current table and 
applies these alignment settings to new tables. You can use it to enforce the cell 
alignment in each new table. (This can be useful in financial tables where the cell 
alignments are unlikely to match those provided by default when creating the 
content.) 

Pattern Areas
This section defines how the table style’s header and footer row and column 
behave. If the table design from which you are generating the new Table Style 
already contains header and footer columns, these settings will be grayed out, as 

Layout Settings category.

Additional Cell Information and Pattern Areas.
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the Use Selected Table as Example option has already filtered out these settings 
from the table itself.

Header and Footer Rows

Header Rows defines the number of rows formatted differently at the top of a 
table. Header Rows do not need to have a similar design for each row. For example 
if your table design contains a heading and subheading row, then set the number 
of Header Rows to ‘2’. A table can have a maximum of ‘25’ header rows. Header 
Row information is accessed from the table design that is used as the source of the 
Table Style and cannot be changed in the Table Styles dialog. The number of rows 
is therefore listed grayed out.

Footer Rows defines the number of rows formatted differently at the bottom of a 
table. Footer Rows do not need to have a similar design for each row. For example 
if your table design contains a sub-footer and footer row, then set the number of 
Footer Rows to ‘2’. A table can have a maximum of ‘25’ footer rows. Footer Row 
information is accessed from the table design that is used as the source of the 
Table Style and cannot be changed in the Table Styles dialog. The number of rows 
is therefore listed grayed out.

If the Typefi Table Style contains header rows and the table inserted by the author 
in Word contains more header rows than the Table Style, the header rows data 
from the style is applied cyclically on the additional header rows in the table. 

Let’s say the Table Style defines 2 header rows and the inserted table contains 5 
header rows, the header row data would format as follows: 

In other words, row specifications from the Table Style for header, body and footer 
rows are applied in a cyclic way on the corresponding table rows.

Header and Footer Columns

Header Columns  define the number of columns on from the left side of the table 
that are defined with as being different from the rest of the columns in the current 
table style. As InDesign only supports a single Header Column, you must manually 
set the number of Header Columns when basing your Table Style on an InDesign 
table design. 

Footer Columns set the number of columns on the right side of the table that are 
formatted differently. As InDesign only supports a single Footer Column, you must 
manually set the number of Footer Columns when basing your Table Style on an 

Defined table style (left), applied to table with 5 header rows (right)

Header columns and footer columns are always maintained in the output 
table regardless of the number of body columns



 Table Styles 134

InDesign table design. Just like for Header and Footer Rows, the Footer Column 
designs for each column can be different.

In contrast to Header and Footer Row behavior, where an inserted table can 
contain more Header or Footer Rows than the Table Style, Header and Footer 
Columns behave differently. Header and Footer Column formatting is not applied 
cyclically, Body Columns are applied cyclically. When designing prototype tables 
containing multiple Header and Footer Columns, ensure that the table design 
contains at least one additional column that sets the Body Column formatting.

When tables are inserted and formatted using a Table Style containing Header or 
Column rows keep the following in mind:

1) The first ‘h’ columns of the table will have the Header Columns settings applied 
that were captured by the Table Style, but not more than there are columns in 
the table.

2) If there are more than ‘h’ columns in the table, the last ‘f’ columns will have the 
Footer Columns settings applied that were captured by the Tables Style (from 
last column toward the first column), but not more than the number of table 
columns remaining after step 1. 

3) The columns left after applying Header and Footer Columns formatting are the 
remaining b Body Columns. Body Column formatting is applied cyclically from 
first body column to last body column.

Empty Cells

Empty Cells settings control the cell formatting of cells in a table that contain no 
data. For instance, they might contain a different cell fill or stroke or inclusion of 
diagonal lines. To define how Empty Cells are formatted select which cell or cells in 
the Selected Table are formatted as an empty cell.

Empty Cell formatting is applied during page composition and editing in InDesign 
and applies only to normal tables and will not be applied for tables marked as 
prototype tables.

The Empty Cell settings are:
 ■ None : There is no specific formatting for Empty Cells defined in the selected 

table.

h=number of header columns defined in the Table Style

f=number of footer columns defined in the Table Style

b=number of body columns
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 ■ First Body Row: The prototype table defines an empty cell layout in the first 
body row of the table. 

 ■ Last Body Row: The prototype table defines an empty cell layout in the last 
body row of the table.

With either First Body Row or Last Body Row selected, an additional three options 
become available for selection:

 ■ First Column of Row: Empty cell formatting defined by the single cell of the first 
column of the specified body row of the prototype table.

 ■ Each Column of Row: Empty cell formatting is defined column specific by each 
cell of the specified body row of the prototype table.

 ■ Last Column of Row: Empty cell formatting is only defined by the single cell of 
the last column of the specified body row of the prototype table.

In a table that gets the table style applied, there is either a single empty cell style 
used for every cell of the table that has no content (no matter in which column the 
empty table cell appears), or the empty cell style format is determined by the table 
column that corresponds to the column in the table style’s prototype table. In that 
case, header and footer columns are also considered, and the repeating empty cell 
style selection applies to them as well.

Empty Cells defined in prototype table
First Body Row Last Body Row

First 
Column of 
Row

Empty cell is defined in the first row of the table by giving the very first cell of that 
row the defined formatting.
During page composition empty cells 
are formatted using the cell attributes of 
the first body column of the first body 
row of the prototype table. 

During page composition empty cells 
are formatted using the cell attributes 
of the first body column of the last body 
row of the prototype table.

Last 
Column of 
Row

Empty cell is defined in the first row of 
the table by giving the very last cell of 
that row the defined formatting During 
page composition empty cells are 
formatted using the cell attributes of the 
last body column of the first body row of 
the prototype table.

Empty cell is defined in the last row of 
the table by giving the very last cell of 
that row the defined formatting. During 
page composition empty cells are 
formatted using the cell attributes of the 
last body column of the last body row of 
the prototype table.



 Table Styles 136

Empty Cells defined in prototype table
First Body Row Last Body Row

Each 
Column of 
Row

Empty cell formatting is defined in each 
cell of the first row of the table. 

Empty cell formatting is defined in each 
cell of the last row of the table. 

Each Empty cell of that row could be formatted differently. Empty cells are 
formatted using to the empty cell formatting set in the corresponding column. 
If the number of columns in the table is similar to that of the prototype table, 
the empty cell formatting matches the prototype table. If a table contains more 
columns it will use the column based empty cell formatting in a cyclical pattern, 
only for Body Columns. E.g. 1-2-3-1-2-3-1 etc. using the cell attributes of the 
corresponding column empty cell format.

Last 
Column of 
Row

Empty cell is defined in the first row of 
the table by giving the very last cell of 
that row the defined formatting During 
page composition empty cells are 
formatted using the cell attributes of the 
last body column of the first body row of 
the prototype table.

Empty cell is defined in the last row of 
the table by giving the very last cell of 
that row the defined formatting. During 
page composition empty cells are 
formatted using the cell attributes of the 
last body column of the last body row of 
the prototype table.

Width Settings
Width Settings relate to the width of the table itself as well as the column widths. 

Table Location
Tables are always placed in a paragraph of their own. The Table Location setting 
controls the horizontal positioning of the table within this paragraph as well as 
overall width of the table in relation to its parent Text Frame. 

The horizontal positioning is controlled via an External Paragraph Style or Basic 
Reference Point setting.

External Paragraph Style

The External Paragraph Style setting places the table in a paragraph that is 
formatted using a standard InDesign paragraph style during page composition. 
This paragraph style controls not only the alignment (left,  center, right etc.) and 
indentation setting (left indent, right indent etc.), it can also define other settings 
available to paragraph styles, such as space before/after, widow/orphan protection 
etc. These are settings you can’t include when using the Basic Reference Point 
option. 

Width Settings category including the choice of External Paragraph Style



 Table Styles 137

Column Handling
You can specify that the table creates columns of equal widths, or creates a table 
with specific widths you must set first, and then click the ‘Compute From Table’ 
button to store those widths. Then, when a table is inserted using Writer, those 
widths will be maintained (if possible) up to the limits of the page layout.

Basic Reference Point

When the External Paragraph Style is set to [No Paragraph Style], the horizontal 
positioning within the Text Frame is purely controlled through the Basic Reference 
Point settings.

The Reference Point sets the horizontal alignment to either Left, Center or Right.

The Offset value sets the indentation. A Positive Offset value equals a left indent, a 
Negative Offset value equals a right indent. 

For example: when the Basic Reference Point is set to Left, and the Offset value is 
0.125 in, the table will be moved 0.125 in from the left edge of the Text Frame in 
which it is positioned.

Width Relative to Frame: Defines the total width of the table relative to the parent 
Text Frame width. 

Column Sizes:

Same Width: All columns will have the same width by default. This is similar to 
InDesign’s default when creating a new table through “Table->Insert Table”

Specific Width: The table prototype stores the individual width for each column 
relative to the width of the prototype table. ‘Compute From Table’ will be active if 
the selected table uses any different column width settings.

Click Compute From Table to calculate the Table Location settings based on the 
currently selected table.

On Insert:

Keep Table Width: The width of all columns gets evenly reduced to fit the columns 
into the intended table width.

Choosing to maintain the column widths of the Table – 
up to the specified percentage of column width.
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Keep Column Width: Additional columns may be added to the existing body 
columns The width of the columns directly used from the prototype stays the 
same. ‘Maximum’ will be active in that case and will be greater than or equal to the 
‘Width Relative to Column’ in the table location setting, e.g. the user specifies to 
what extent the overall table width might increase.

On Delete:

Keep Table Width: The widths of all columns get evenly increased to have the 
columns fit into the intended table width.

Keep Column Width: The width of the remaining columns from the prototype stays 
the same. ‘Minimum’ will be active in that case and will be less than or equal to the 
‘Width Relative to Column’ in the table location setting, e.g. the user specifies to 
what extent the overall table width might decrease.

Headers and Footers
Headers are always the top row(s) of a table and can be formatted to repeat across 
columns, frames or pages. Footers are the bottom table row(s) and can also be 
repeated. Refer to the Adobe InDesign User Guide for more extensive information 
on Headers and Footers. 

If you base your new table style on a table that contains InDesign header and 
footer rows, the number of header and footer row settings will be entered 
automatically. 

When the author inserts a table of this style with Typefi Writer and defines a 
number of headers and footers, the table that is generated during the page 
composition automatically formats the header and footer rows based on the Table 
Style settings. For example, when a Table Style is designed with two header rows 
(each with a different format) and a table with four header rows is inserted, the 
four header rows will be formatted.

If the author does not define the header/footer information in Word, only body 
rows are created during page composition for the selected Table Style.

Headers and Footers category.
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Cross-references are textual references within a publication that direct 
the reader to source text located elsewhere in the same publication. An 
example of a cross-reference would be a ‘see also …’ source reference 
that refers to a chapter title or page number the reader may refer to for 
additional information.

Cross-references may be inserted by an author using Typefi Writer and appear 
fully formatted in the paginated InDesign document. They can also be inserted or 
edited post-pagination in the InDesign document. 

The Typefi Designer plug-in allows for easy editing and creation of cross-references 
based on selection of cross-reference sources that point to the following 
categories:

 ■ Project Field: such as a Book Title. (See also Project Fields, p. 95).
 ■ Section Field: such as a particular Chapter Title or Number. (See also Section 

Fields, p. 96).
 ■ Paragraphs: text formatted using a selected paragraph style, such as a Heading, 

Caption etc. The cross-reference actually points to the start of a selected 
paragraph formatted with the selected paragraph style.

 ■ Bookmarks: references pointing to InDesign bookmarks. Bookmarks created as 
InDesign bookmarks can point to page, graphic or text references. 

Note: Bookmarks created from highlighted text in InDesign insert a single reference marker at the 
start of the text as a Bookmark. However, where bookmarks were originally created in Word based on 
some highlighted text, the resulting InDesign file that is published through Typefi Publish will display 
Bookmark markers around the highlighted text.

Typefi Cross-References
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Inserting a Cross-reference
A cross-reference may use selected text as a starting point, or use source text or 
page number details from the selected cross-reference source. Cross-references 
inserted in InDesign can point to any currently open document. The active 
document is the root of the cross-reference source.

To insert a new cross-reference either highlight text or place the text cursor at the 
cross-reference insertion point:

 ■ Highlight text if you’d like to turn the text into a cross-reference hyperlink or if 
you want to ensure that the text is not updated even when the source changes. 

 ■ Use the text insertion point option if you’d like to copy across the source text 
derived from the selected cross-reference source.

 ■ Next, select Typefi Cross-Reference > Insert Cross-Reference… from the Type 
menu. 

The Insert Cross-Reference dialog box is displayed. 

Project Field Cross-Reference

To insert a cross-reference to a Project Field:
 ■ Set the Category to Project Fields. 
 ■ Next, select the relevant Field name from the Type menu. 

The Source indicates the value of the Project Field. 

Set the Value to:
 ■ Source Text, to copy the Project Field value to the insertion point of the cross-

reference. 
 ■ Source Page Number, to copy the Project Field page number to the insertion 

point of the cross-reference. This page reference points to the first page of the 
selected document.

 ■ Selected Text to use the currently highlighted text as the source for the cross-
references.

To turn the cross-reference into an interactive hyperlink that can be used in the 
PDF-output:

 ■ Select Create Hyperlink to Source.
 ■ Click OK, to insert the Project Field cross-reference in the InDesign document. 

Insertion of Project Field cross-reference and cross-reference source text.

Project Field cross-reference inserted.
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Section Field Cross-Reference

To insert a cross-reference to a Section Field, set the Category to Section Fields.  
Next, select the relevant Field name from the Type pop-up menu.

In the example above, we point to a different Document and select the 
ChapterTitle Section Field. The Source indicates the available ChapterTitle sections. 
Select the appropriate cross-reference source from the Source list. For documents 
containing multiple sections, the source list would list different values for the 
selected Section Field.

Set the Value to:
 ■ Source Text, to copy the Section Field value to the insertion point of the cross-

reference.
 ■ Source Page Number, to copy the Section Field page number to the insertion 

point of the cross-reference. This page reference points to the first page of the 
section.

 ■ Selected Text to use the currently highlighted text as the source for the cross-
references.

To turn the cross-reference into an interactive hyperlink that can be used in the 
PDF-output: 

 ■ Select Create Hyperlink to Source.
 ■ Click OK, to insert the Section Field cross-reference in the InDesign document. 

Paragraphs

To insert a cross-reference that points to a paragraph:
 ■ Set the Category to Paragraphs. 
 ■ Next, select the relevant paragraph style name from the Type menu.

In the example shown, the cross-reference will point to a Heading 1. The Source 
lists all paragraphs that are formatted using the Heading 1 paragraph style. Select 
the appropriate cross-reference source (paragraph) from the Source list.

Set the Value to:
 ■ Source Text, to copy the Paragraph value to the insertion point of the cross-

reference. Please note that tables, images and Inline Elements are disregarded, 
whereas paragraph end markers are converted to forced line breaks. In addition, 

Insertion of Section Field cross-reference and cross-reference source text.

Section Field example that points to ChapterTitle and Page Number.

Insertion of paragraph cross-reference.
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any other markers, such as cross-references, bookmarks or hyperlinks that are 
part of the selected paragraph will be ignored.

 ■ Source Page Number, to copy the Paragraph page number to the insertion point 
of the cross-reference. 

 ■ Selected Text to use the currently highlighted text as the source for the cross-
references.

To turn the cross-reference into an interactive hyperlink that can be used in the 
PDF-output:

 ■ Select Create Hyperlink to Source.
 ■ Click OK, to insert the paragraph cross-reference in the InDesign document. 

Bookmarks

To insert a cross-reference that points to an InDesign bookmark, you must first 
ensure that InDesign bookmarks are created. 

 ■ Set the Category to Bookmarks. 
 ■ Next, select the relevant Bookmark text from the Type pop-up menu.

In the example above the cross-reference will point to the “Early life” bookmark. 
The Source will display the names of all available InDesign bookmarks. 

 ■ Select the appropriate cross-reference source (name) from the Source list.

Set the Value to:
 ■ Source Text, to copy the Bookmark value to the insertion point of the cross-

reference. Please note that tables, images and Inline Elements are disregarded, 
whereas paragraph end markers are converted to forced line breaks. In addition, 
any other markers, such as cross-references, bookmarks or hyperlinks that are 
part of the selected paragraph will be ignored.

 ■ Source Page Number, to copy the Bookmark page number to the insertion point 
of the cross-reference. 

 ■ Selected Text to use the currently highlighted text as the source for the cross-
references.

To turn the cross-reference into an interactive hyperlink that can be used in the 
PDF-output:

 ■ Select Create Hyperlink to Source.
 ■ Click OK, to insert the Bookmark cross-reference in the InDesign document. 

Insertion of paragraph cross-reference.

Cross-reference added.



 Typefi Cross-References 143

InDesign Bookmarks and Hyperlinks
Without the Typefi Designer plug-ins installed, InDesign will handle bookmarks 
differently to Typefi. Whereas InDesign will only mark a single location for the 
bookmark reference, the installation of Designer will add start and end markers for 
the Bookmark source text.

To create an InDesign bookmark:
 ■ Select Window > Interactive > Bookmarks panel. 
 ■ Highlight the source text and select New Bookmark from the panel menu. 

Alternatively click the New icon.  Brown Typefi start and end markers appear 
around the bookmark source text. 

Hyperlinks

When cross-references are set to create a hyperlink, InDesign hyperlinks are used. 
However, post-editing in InDesign might see the requirement to insert additional 
InDesign hyperlinks, such as URL links. These can be inserted without any issues, 
and will round-trip as a normal hyperlink. In contrast, hyperlinks created from 
cross-references will remain cross-references that contain additional information 
that turns them into a hyperlink during page composition.

For more detailed information on InDesign bookmarks and hyperlinks please refer 
to InDesign Help. 

Word Hyperlinks: Word documents containing native Word hyperlinks for web and email addresses 
are automatically converted to InDesign hyperlinks during page composition. To format these types of 
hyperlinks differently, add a “Hyperlink” character style to the InDesign template, and apply the style to 
the hyperlinked text.

Editing a Cross-reference
To edit an existing cross-reference:

 ■ Start by inserting the text cursor anywhere in the cross-reference text (between 
the blue cross-reference markers). 

In our example we’ll edit the Section Field cross-reference to a Paragraph cross-
reference. 

InDesign Bookmarks panel.

Editing a cross-reference.
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 ■ Next, select Typefi Cross-Reference > Edit Cross-Reference… from the Type 
menu. 

The Edit Cross-Reference dialog box is displayed. 
 ■ Make the appropriate changes to Document, Category, Type, Source, Value 

settings.
 ■ Click OK. 

The cross-reference has now been updated to reflect the edit. 

Update Selected Cross-references
To update a selected cross-reference, start by inserting the text cursor anywhere in 
the cross-reference text (between the blue cross-reference markers). 

In our example we’ll update the page number. Next, select Typefi Cross-
Reference > Update Selected Cross-Reference from the Type menu. 

The selected cross-reference is now updated. In the above example the page 
number has been changed to reflect the new position of the Biography cross-
reference. 

Update all Document Cross-references
When editing content in the InDesign post-pagination process, cross-references 
can become outdated. Page numbers might no longer be correctly reflected due 
to insertion of new content. Source text might no longer be up to date, due to 
editorial changes to headings etc.

To Update all Document Cross-References for the active InDesign document:
 ■ Select Typefi Cross-Reference > Update all Document Cross-References from the 

Type menu.

After editing.

Cursor placed in the page number cross-reference text.

Page number updated.
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Footnotes are generally notes that have a reference in the text that are 
placed at the bottom of a page. In contrast to endnotes, which generally are 
placed at the end of a document.

Footnotes
Footnotes are used to add some additional information about something referred 
to in the main text and are generally numbered in-text and then referenced by 
that number at the bottom of the page.

Footnotes appear at the bottom of the Main Story text frame during page 
composition.

Typefi Publish has support for both Word and InDesign footnotes:

Word Footnotes
Footnotes inserted in Microsoft Word are passed through to the paginated 
InDesign documents and are formatted using the settings for Type > Document 
Footnote Options… This means that none of the Word footnote settings will come 
across in InDesign. 

When a footnote is inserted in Word, Word automatically generates a Footnote 
Reference and Hyperlink character style. The Footnote Reference in Word formats 
the reference number in the text. As best practice, you might want to add similarly 
named character styles to the InDesign template. 

Footnote inserted in Word.

Footnotes and Endnotes
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The footnotes themselves in Word are formatted using the Footnote Text 
paragraph style. Consider using a similarly named style in InDesign when defining 
the Document Footnote Options...

Although Word supports the use of footnotes inside tables, InDesign does 
not, which means that such footnotes are ignored by the Typefi Engine and 
consequently won’t appear.

In addition, Word supports continuous footnote numbering across sections. 
InDesign only supports numbering across a section, spread or page. This means 
that for a Word document that contains multiple sections and continuous footnote 
numbering, the footnote numbering will be reset according to the InDesign 
footnote options… 

Although InDesign doesn’t support continuous footnote numbering across sections, consider 
setting the InDesign ‘Output for a Job Option’ to ‘Book’ in cases where footnotes must be numbered 
continuously. A script addition to the job option could then automatically set the Start At footnote 
numbering for each InDesign document that is published as part of the book. Alternatively, you could 
make this change manually after-page composition.

InDesign Footnotes
We’ve already seen that InDesign footnotes will always restart their numbering 
at the beginning of each section, spread or page. In addition to this restriction, 
InDesign footnotes always appear in the same text frame as the in-text reference 
and do not span multiple columns unless the footnote reference is in a paragraph 
that spans multiple columns. This means, for example, that footnotes inserted as 
part of an Element by the author, will sit within the Element Content frame. 

InDesign further lacks support for use of footnotes in tables, or nesting of 
footnotes within footnotes. 

Footnotes further are not affected by Text Wrap, which means that where they 
interact with Floating Elements with Text Wrap, the Footnote Text will not wrap 
around the Element.

Footnote in InDesign.

Consider defining a separate footnote Typefi Element, for those 
design scenarios that don’t meet the out-of-the box InDesign footnote 
capabilities.



 Footnotes and Endnotes 147

Endnotes
InDesign has no support for endnotes. However, where endnotes are inserted 
by the author in Word, endnotes are published as footnotes, and numbered 
sequentially based on the InDesign template’s Document Footnote Options . The 
Endnote Reference in Word formats the reference number in the text. As best 
practice, you might want to add similarly-named character styles to the InDesign 
template and format the endnotes using the Endnote Text paragraph style.



 Typefi Preferences 148

Typefi Designer adds five additional preference categories to InDesign’s 
Preference dialog. To access Typefi preferences categories, select InDesign’s 
Preferences from the Edit (PC) or InDesign menu (Mac).

Typefi AutoFit
The Typefi AutoFit preferences ensure that AutoFit relationships and resize settings 
work dynamically. AutoFit is enabled by default (see also Typefi AutoFit, p. 65).

Disabling Typefi AutoFit means that AutoFit relationships and resize settings don’t 
work interactively in the InDesign template. In addition, disabling the setting could 
prevent the proper handling of AutoFit relationships and resizing of frames during 
page-composition.

A situation in which disabling AutoFit could be useful is when a lot of page items 
with AutoFit relations need to be re-arranged without getting the relations 
updated (or also if auto-resize or even limit checks might temporarily hinder you in 
some tasks). 

Allow single column text frames to collapse is a setting that is disabled by default. 
Enabling this setting allows single column text frames with a single column to 
shrink to 3pt height (or as close as possible) when AutoFit is enabled. With the 
default setting as disabled, a single column text frame will use a minimum height 
depending on the font height for the first character of a text frame, i.e. the text 
cursor will then be completely visible if the user clicks in such an empty text frame.

Most of the preferences are stored per document. If no document is 
open, the preferences are stored as InDesign application-wide default 
preferences that are applied for new documents.

This has an effect on the ‘Typefi Borders’ and ‘Typefi Anchors’ preferences, 
which show a check-box to save the document preferences as InDesign 
application-wide preferences, and where ‘Use Defaults’ means to use the 
InDesign application-wide preference settings in case the preferences of 
a document are edited, but to use the Typefi default settings in case the 
InDesign application-wide preferences are edited.

The only preference pane where the preference settings are not 
necessarily document-wide is the ‘Typefi Preferences’ pane.

InDesign Preferences > Typefi AutoFit.

Typefi Preferences
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Typefi Cross-References
The Typefi Cross-References preferences define how cross-references are 
formatted during the page composition process as well as when editing, updating 
or inserting cross-references. 

Unresolved Cross-References
Unresolved Cross-References are those cross-references for which the source 
is not available. This could be because the referenced item, such as a bookmark, 
no longer exists or the source document itself is not available. The referenced 
character style is applied when Update References cannot locate the source. 

To make these cross-references stand out after pagination, consider formatting the 
Unresolved Cross-References with a separate Character Style. Select the preferred 
Style from the Unresolved-Cross-Reference Style menu to assign such a style. 
Leaving the Style setting set [None], formats the cross-reference according to the 
paragraph style to which it belongs.

Hyperlinks
Cross-references can also have hyperlinks associated with them. Hyperlinks enable 
a user of a document to jump from the hyperlink location to a source elsewhere 
in the documents and can be inserted as interactive links in a PDF created from 
InDesign. 

The Hyperlink Character Style setting only affects cross-references that have 
hyperlinks associated with them and formats these cross-references with the 
attributes defined by the character style, not the style itself. This means that the 
character style is not actually applied to the text.

The Hyperlinks Appearance settings have an impact on cross-references that are 
hyperlinks. They do not have an impact on normal InDesign hyperlinks.

The Appearance Type sets the visibility of the hyperlinks. A visible hyperlink is 
marked by a rectangle surrounding the hyperlink text. The appearance of this 
rectangle is controlled by the Width, Color and Style settings. The Highlight setting 
relates to the appearance of the link when the link is clicked. Invert will reverse the 
colors, Outline will display a stroked rectangle and Inset will give the appearance 
of a button being pushed when the link is clicked. 

InDesign Preferences > Typefi Cross-References

Note: InDesign hyperlinks are not formatted by this feature. 

Highlight set to Inset.
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Typefi Borders
Typefi Borders are the visual appearance of Typefi Frames and Element Prototypes 
and Instances (see also Element Prototype, p. 113). Typefi frames are distinguished 
from InDesign frames through their border color, width and opacity.

The Typefi Preferences setting for Typefi Borders sets the frame border 
appearances as well as Element Instance and Prototype appearance General 
border width and transparency percentage may be changed. 

To edit the Typefi Border settings: 
 ■ In InDesign Preferences choose Typefi Borders.
 ■ Set the default Stroke Weight for the Borders.
 ■ Set the default Opacity for the Borders.

To override the default opacity for certain Typefi Borders:
 ■ Enter an Opacity percentage for the individual Border Type.

To View Typefi Borders in InDesign:
 ■ Enable Show Typefi Borders and ensure View > Show Frame Edges in InDesign 

is selected, also ensure that View > Overprint Preview is disabled and View > 
Screen Mode is set to Normal.

 ■ Alternatively select Show Frames from the Typefi Elements or Frames panel 
menu.

To View a selective range of Typefi Borders in InDesign:
 ■ Enable or Disable the View setting for individual Border Types using the 

checkboxes in the Typefi Borders preferences.
 ■ Enable Show Typefi Borders.

To Reset the Typefi Border appearances to their default stroke weight, opacity and 
color:

 ■ Choose InDesign Preferences > Typefi Borders.
 ■ Click Use Defaults.

InDesign Preferences > Typefi Borders.

If a document is open, the panel has an additional check-box: ‘Save as 
default settings’. In the context of an open document, ‘Use Defaults’ 
means to use the settings that had been used as the InDesign 
application-wide default settings.
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Typefi Anchors
Typefi Anchors are the lines and markers that connect an Element with their 
reference in the Text. 

The Typefi Anchor preferences define the color, and weight of the lines and 
markers.

To edit the color of the Anchor markers: 
 ■ Click the color drop-down.
 ■ Pick a color from the list.

Marker and Line stroke weight and opacity of color can be changed:

Anchor Marker
The Anchor Marker is the circular mark linked to the Element, and its size can be 
increased to a maximum circular dot of 8pt.

To edit the Anchor Marker: 
 ■ Change the Weight and Opacity settings in the Typefi Anchor preferences.

Anchor Line
The Anchor Line is the line that connects the Marker to its reference point in the 
text, it can be increased to a maximum stroke weight of 8pt.

To edit the Line:
 ■ Change the Weight and Opacity settings in the Typefi Anchor preferences.

To View Typefi Anchors in InDesign:
 ■ Enable or Disable the Show Typefi Anchors setting.

To store the new settings as InDesign defaults:
 ■ Click Save as Default.

To restore the Typefi Anchor preferences to their original settings:
 ■ Click Use Defaults.

Typefi Element and Anchor line and marker.

InDesign Preferences > Typefi Anchors.
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Typefi Preferences
The Typefi Preferences contain settings for Pagination Options and Interactive 
Options. 

Pagination Options
Enabling Show Document during Pagination is a setting applicable only when 
using InDesign Desktop during Page Composition. Generally all jobs are processed 
on Typefi Server, and enabling this setting has no effect. 

When enabled you’ll be able to see Typefi Publish in action and witness the page 
composition process. It will display text and content run in and formatting of 
content, and show Typefi making layout decisions when placing Floating Elements 
and add more pages until all content has been processed and placed.

Where jobs are processed on by Typefi Server and InDesign Server you’ll not see 
any effect when enabling this option. 

With the Close Document at End of Pagination enabled, the compiled InDesign file 
is closed at the end of the composition process. The file remains open if this option 
is left disabled.

Show Progress Bar: displays a progress dialog during the pagination process.

Interactive Options
The Interactive Options setting is disabled by default. Enabling the Interactive 
Options and Auto Adjust Table Width or Enable Inline Image Sizing can generate 
time consuming operations. So when would you enable or disable these settings?

 ■ Disabled: If no post-page composition processing occurs.
 ■ Disabled: If table widths or Inline image sizes are not allowed to change post-

page composition.
 ■ Disabled: When predominantly editing content in InDesign post-page 

composition, if the size of tables or Inline images is not relevant during the 
editing process. In cases where the resizing of these objects is important, the 
setting(s) should be enabled.

 ■ Enabled: If the main task is to design and test the functionality of InDesign 
templates, for example to discover how the sizing of tables or Inline images 
behaves during pagination.

InDesign Preferences > Typefi Preferences

Progress Bar in InDesign
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 ■ Negotiable: A number of Script-driven post-page composition editing tasks 
are performed through. The selection of this setting would depend on the 
preferred post-editing result.

Auto Adjust Table Width: When enabled, tables that have Typefi Table Styles 
applied to them will automatically adjust in width as they flow into wider or 
narrower Text Frames as a result of post-page composition processing.

Enable Inline Image Sizing: When enabled, changes made to Inline Image Settings 
(see Typefi Inline Image Settings, p. 59) are automatically reflected in the 
InDesign document. For instance, imagine an Inline image setting prescribes that 
the image is 50% of the Text Frame width. If the Inline image setting changes to 
60%, the image resizes dynamically. In addition if the text flows into a Text Frame 
that is wider or narrower, the image will resize accordingly.

Automatically Repair Table Cell Oversets
This preference setting is enabled by default and pagination occurs as it has in 
previous Typefi Publish releases. However, there might be circumstances where 
Typefi Designer encounters a situation where the automatic adjusting of cell 
widths leads to a generated table that differs in width between the PDF and the 
InDesign document. 

Disabling this default preference avoids inconsistent table width, but may lead to 
certain table cells becoming overset.

Export Absolute Image Paths
The Export Absolute Image Paths setting is only visible in Typefi Preferences when 
editing an InDesign file. When enabled, the setting indicates that absolute paths to 
images were used when the document was created using Typefi Publish. Export Absolute Image Path preference setting.
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In order to ensure that your Project template is fully functional, test the 
template. Testing requires access to content and set-up of job options.

To test a template, create a New Typefi Document with the Typefi Writer in Word 
and insert the sections you’d like to test and some sample text and Elements etc. in 
each section. Use the Print Typefi Document command to test to run the content 
into the template. From the Jobs section of your project, check out the InDesign 
file(.indd) that was generated and review this file.

(It is also possible to start-out with an InDesign document; apply the Typefi specific 
mark-up as far as the Typefi additions to the InDesign UI allow; and use round-
tripping to get the initial content for check-in in the server. The only Typefi feature 
that cannot be created this way is Conditions).

Please refer to the Typefi Writer part of this User Guide to learn how to create test 
content. Refer to the Typefi Projects part of this User Guide to learn how to create 
Job Options.

Testing your Template
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Typefi Writer is an add-in for Microsoft Word that makes it easy for you to 
create structured content for the Typefi Publish system using Microsoft 
Word. It allows you to use professional layouts from Adobe InDesign, and 
apply them to Microsoft Word documents without the need to understand 
XML (Extensible Markup Language) or Adobe InDesign. And with just a 
couple of clicks, you can convert a Word document to PDF format to see 
what the publication will look like in its final form. 

Typefi Writer works by attaching a Typefi Project to a Word document. A Typefi 
Project contains paragraph and character styles, sections, elements, tables and 
more. Once a project is attached, you use Typefi Writer to apply simple markup to 
your document to identify different parts of the publication.

A Typefi Writer document in Microsoft Word is not formatted like the final 
publication, but by using the Typefi Print command, you can generate a PDF file to 
see exactly how the final product will look.

You may format the styles in Word to look close to the final product (font, color, 
size, spacing, etc.), but it is not necessary. Avoid manually entering numbers, 
bullets, and similar content, since the InDesign template will add these 
automatically as part of the paragraph styles.

Typefi Toolbar
The Typefi Toolbar provides easy access to most Typefi Writer commands and 
appears in the Add-Ins tab at the top of the screen.

Introducing Typefi Writer
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Typefi toolbar (see button names below)

The Typefi toolbar provides one-click access to the following commands:

A New Document 
B Attached Project 
C Typefi Print 
D Document Explorer 
F Refresh Document  
G Insert Section 
H Insert Element 
I Insert Image 
J Insert Table 
K Paragraph Styles 
L Character Styles 
M Insert Condition 
N Insert Element Reference 
O Insert Cross-Reference 
P Insert Hyperlink

Typefi Menu
The Typefi Menu provides access to all of the Writer features and commands and 
also displays the keyboard shortcuts that can be used to access certain commands. 
It appears in the ‘Add-Ins’ panel.

Typefi Writer menu.
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The Typefi Writer Settings allow you to control settings for the Typefi Writer 
Add-in. You can create a connection to the Typefi Publish Server; choose a 
storage location for PDFs published from Word; and choose whether images 
will appear or not.

To access the Typefi Writer Settings:
 ■ Select Add-Ins > Typefi > Settings…

The Typefi Writer Settings dialog appears.

General
The General Tab in the Typefi Writer Settings dialog is used to:

 ■ manage connections to the Typefi Publish Server
 ■ define the server response timeout; and 
 ■ specify the location in which PDF files are stored when Word documents are 

published to Typefi Publish.

Server Connections
Server Connections are used whenever the Writer needs to exchange information 
with Typefi Publish Server, unless you are working in an off-line environment (see 
Select Project from TSS File, p. 170).

Adding a Server Connection

When you want to add a new Server Connection to the Writer:
 ■ Click Manage… Typefi Writer Settings – General  

Typefi Writer Settings
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 ■ Click Add…

Adding another server to the list of available Typefi Publish servers.

 ■ Enter the URL (http://servername:8080) for the Server Address, and the 
username and password used to sign in to the server.

 ■ Enable Remember my password to ensure that the Writer does not prompt you 
to re-enter your password each time you connect to the Typefi Publish Server.

 ■ Click Test to verify that the Server Connection is working. 
 ■ Click OK to add the new Server Connection to the connections list.

DEFAULT CONNECTION

The Default Connection is the preferred connection Typefi Writer uses when you 
launch Word. With the Remember my password option enabled for the Default 
Connection, connection to the Typefi Publish Server connection happens without 
prompts. The current Default Connection shows the word (Default) after the 
Server Address.

http://servername:8080
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To set the Default Connection:
 ■ Select the connection.
 ■ Click Make Default.
 ■ Once the Server Connections are in place:
 ■ Click Close to return to the Typefi Writer Settings dialog
 ■ Click Close to close the Typefi Writer Settings dialog and finish managing Server 

Connections.

Editing a Server Connection

You can only edit usernames and passwords after a Server Connection has been 
added. In cases where the Server Address must be edited, you must delete the 
Server Connection and add a new Server Connection.

To edit a Server Connection:
 ■ Click Manage…
 ■ Click Edit…
 ■ Make changes to the username or password.
 ■ Click Test to verify that the Server Connection is working.
 ■ Click OK.
 ■ Click Close to return to the Typefi Writer Settings dialog.
 ■ Click Close to close the Typefi Writer Settings dialog and finish editing Server 

Connections.

Deleting a Server Connection

You can delete Server Connections that become outdated or unused.

To delete a Server Connection:
 ■ Click Manage…
 ■ Click Delete.
 ■ Click Yes to Delete the connection or Click No to retain the connection and 

return to Manage Server Connections window.
 ■ Click Close to return to the Typefi Writer Settings dialog.
 ■ Click Close to close the Typefi Writer Settings dialog and finish managing Server 

Connections.

Connecting to a Typefi Publish Server



 Typefi Writer Settings 161

Server Timeout
The Server Timeout setting controls the number of seconds that the Writer will 
attempt to connect to a server before a timeout occurs. For instance, if you are 
setting up a new server connection and you click the Test button, Writer will 
attempt to access the server for the specified number of seconds. If the server 
does not respond in time, a timeout error appears.

To set the maximum number of seconds to wait for a server response:
 ■ Enter the desired number (in seconds) or choose a number from the pop-up 

menu.

The minimum timeout is 2 seconds, and the maximum timeout is 30 seconds.

Print Output Folder
The Print Output Folder is the folder where the PDF files are saved when you use 
the Typefi Print command. You can have the folder on your local machine or on a 
server.

To define the Print Output Folder:
 ■ Click Change…
 ■ Click Browse…
 ■ Navigate to the Folder where you’d like to store the files.
 ■ Select the folder and click Select.
 ■ Click OK.
 ■ Click Close.

The folder location can be dependent on your local computer account settings and network settings. 
Consult with your Network Administrator in cases where you can’t select the desired output folder.

Typefi Style Sheet (.TSS)

The Typefi Style Sheet (TSS) is an XML file that describes properties of a Typefi 
project. Typefi Writer needs a TSS file to populate its dialog boxes and to make 
decisions while working with a Typefi project.

In an offline environment where a project cannot be selected from a server, a TSS 
file can be used as an alternate way of selecting Typefi projects.

The number of seconds listed depends on the Server Timeout setting.

Note: In a normal environment where a connection to a Typefi Publish 
server is available, TSS files are handled automatically; as projects 
are selected on a server, Typefi Writer reads information from a 
corresponding TSS file.
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To allow projects to be selected from TSS files:
 ■ Enable Allow projects to be selected from Typefi Style Sheet (.TSS) files.
 ■ Click Close.

View
The View setting controls whether images (supported by Microsoft Word) inserted 
in Word will be visible.

Document Images
The Document Images setting controls how images are displayed in Typefi Writer 
documents. 

If you have this setting enabled, Typefi Writer will show previews of Typefi images 
in Word documents if the file name is found and if the file name is compatible 
with Microsoft Word. If the file name cannot be located, or if the file name is not 
compatible with Microsoft Word, the Writer will display the file name instead of the 
image. 

If you have this setting disabled, the Writer will only display the file name of each 
inserted image.

Keep in mind that enabling this option may increase the amount of time it takes to 
manipulate some Writer documents, so you should keep this option disabled if you 
want to maximize speed.

To show image previews in Word:
 ■ Add-Ins > Typefi > Settings…
 ■ Click View Tab.
 ■ Enable Show document images.
 ■ Click Close.

To hide image previews in Word:
 ■ Typefi > Settings…
 ■ Click View Tab.
 ■ Disable Show document images.
 ■ Click Close.

Typefi Writer Settings – the choice to view images 
(but only those supported by Word).
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Image file formats

Typefi Writer will only attempt to display images whose file names have one of the 
following extensions:

 ■ eps, gif, gfa, jpg, jpeg, jfif, jpe, tif, tiff, bmp, dib, rle, bmz, pct, pict, png, emf, wmf.

Though any file name can be specified, it is recommended that you insert only file 
formats that are supported by Typefi Publish. Typefi Publish uses Adobe InDesign 
Server as part of its automated publishing solution. Adobe InDesign supports the 
following additional file formats that are not supported by Microsoft Word:

 ■ Portable Document Format (.pdf):
 ■ Photoshop document (.psd; .pdd)
 ■ Illustrator document (.ai)
 ■ InDesign document (.indd)

And less common formats .ct .trp, .dcs, .pmg and .pcx

Other Media Formats

InDesign further adds support for interactive, movie and sound files in the 
following formats: 

 ■ Sound (.aiff; .au; .wav)
 ■ Video (.avi; .mpeg; .mov; .swf)

Although Typefi supports the inclusion of these file-formats with the Typefi Writer, there is no support for 
further defining interactive options for these media formats.

Save
This new section of the Typefi Writer Settings dialog is provided to avoid the 
problems associated with using the Word .doc format. As the dialog explains, 
Word documents that are uploaded to a Typefi server must be RTF (Rich Text 
Format) for the process to work properly. (Older Word files were converted to RTF 
automatically, but retained the DOC extension, to avoid worrying those unfamiliar 
with the format). But it is not necessary if the Word files are remaining where they 
are. Therefore, the setting only ‘encourages’ you to use the format.

The new Save settings that makes Word ‘encourage’ users 
to save files as RTF – by making it the default format
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Authoring in Word often starts well before any Typefi markup is added to 
the Word documents. You will now learn how an author can start preparing 
a standard Word document for use with Typefi Publish.

It is common to break long Word documents into ‘sections’ in order to have 
different layouts; have different headers and footers; or to allow different column 
layouts. Typefi Sections serve a similar function…

Sections and Page Breaks
Sections are generally used in Word documents to distinguish unique parts of 
a publication. Typefi Publish also uses the concept of sections. Where you have 
inserted Word sections in a document you will probably replace them with a 
Typefi Writer section. Word Page Breaks are not converted to Typefi Publish, so you 
should remove them from the document.

Formatting Text
A normal Word document prepared correctly will make use of paragraph and 
character styles as way of applying consistent and predictable text formatting. If 
you use styles, then ‘mapping’ (assigning each style correctly) them to Typefi styles 
becomes a much easier task. The best practice is to use Word templates that 
contain identical style names to the Typefi styles in the related InDesign template. 
Then write the document using just those styles. Doing so means that no 
conversion for text formatting is required when the document becomes ‘Typefied’.

Microsoft Word Paragraph Styles Panel showing some 
examples of Typefi Paragraph and Character Style Names

Preparing Word 
documents for Typefi
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Tabs
When you insert tabs to align text in columns, ensure that only one tab character 
is inserted, and use the Ruler in Word to Define Tab Types and Tab positions. The 
reason for this is that multiple tabs will transfer through to the InDesign template, 
and will cause the alignment to be incorrect. It doesn’t matter what it looks like in 
Word!

Special Characters
Typefi Publish has full Unicode character support, which means that all of the 
Special Characters you insert in Word are fully supported and retained. The one 
exception is the No-Width Non Break character, which has no support in InDesign.

Symbols
A little care must be taken when inserting symbols (such as icons) as part of your 
text. There is no guarantee that the font you are using in Word is the same font 
that is used during page composition in InDesign. If there are a large number of 
icons you’d like to be able to insert as part of your text, then consider developing 
a special icons-only font, linked to a character style, that’s installed both on your 
computer and the Typefi Publish Server (or the computer where InDesign Server 
is installed if it is a different computer)  and incorporated in the InDesign template 
created by the production designer.

Hyperlinks
Word automatically converts e-mail addresses and web-links to hyperlinks. 
These hyperlinks are retained during Typefi’s page-composition process, and 
can become interactive hyperlinks in a PDF if the specified Job Option uses PDF 
Settings that retain these hyperlinks. Word hyperlinks to bookmarks or document 
locations are not maintained during page composition.

Bookmarks
Bookmarks are generally used as a document navigation tool in Word. They 
can be inserted as empty anchors or around some text that is highlighted. 
Word bookmarks convert to InDesign bookmarks or PDF Bookmarks during 

Note: Tab positions must also be set by the production designer for the 
selected paragraph styles in the InDesign templates, otherwise the text 
will not align correctly. 

Note: The No-Width Optional Break character becomes the Non-Joiner 
character in InDesign and will therefore not be round-tripped from 
InDesign because of its use as a text marker.
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page-composition. In addition Word bookmarks can be used by Typefi’s Cross-
References and Hyperlinks as destinations.

Footnotes
Word footnotes are automatically converted to InDesign footnotes when Word 
content is published to Typefi Publish. However there are some differences and 
limitations you should keep in mind.

Footnote Format
Footnote formats you set in Word, such as number format, start at or numbering 
method are not retained when you publish through Typefi Publish. Instead 
InDesign is limited to a single footnote numbering style for each document.

Only one Number format, such as “1, 2, 3” or “a,b,c” is supported per document. 
Although only one numbering format is supported per document, all of Word’s 
numbering formats are supported in InDesign. (In fact, InDesign even adds an 
additional “*, **, ***” numbering option.) Custom marks are not supported.

Footnote and Endnote Numbering > Continuous setting from Word is not retained 
- instead InDesign restarts footnote numbering at least for each Typefi Section. 
Continuous footnote numbering can be support via a small configuration addition 
where needed. (However, in case of book pagination, the Typefi Designer currently 
doesn’t automatically reset the counter for each document of the book.)

Footnotes and Tables
Native Word footnotes added in tables are ignored during page composition. A 
good alternate method to use for table-based footnotes is to ask the production 
designer working on the template for the Typefi project to design a special 
footnote element that may be used. In Word you would then insert a footnote 
marker such as an asterisk, and an element in which you would enter the footnote 
text.
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Endnotes
Word Endnotes are handled as if they are Word Footnotes when you publish a 
Word document to Typefi Publish and therefore encounter similar exceptions 
or limitations. Where both Endnotes and Footnotes are used in a document, 
the Endnotes will be merged within the Footnotes and numbered sequentially 
according to the InDesign Document Footnote Option settings.

Where footnotes and endnotes must co-exist, consider using a third party application to generate 
Endnotes as literal text in the word document, for instance Thomson Reuter’s EndNote: http://www.
endnote.com

Index
An index generated by Word is ignored by Typefi Publish. Typefi can add 
configuration components that will build an index during page composition 
where required. Please contact your local account manager or Typefi contact for 
more information.

Cross-References
Word’s native cross-references are ignored by Typefi Publish, although bookmarks 
to which cross-references refer are retained during the process.

It is advised that you use the Typefi Writer Cross-References command instead of 
Word’s native Cross-References.

Tables
Your Word tables can be converted to Typefi tables. Depending on the table 
designs created by the production designer, some paragraph style formatting and 
proportional distribution of columns might need to be applied to tables to get the 
best-looking result when the Word document is put through the Typefi process.

Images
Word drawings, clip-art, charts, pictures etc. do not convert to Typefi Publish. 
You should create graphics and illustrations outside Word, and save them in a file 
format that is supported by Typefi Publish (see also Image file formats, p. 163) and 
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insert them either as a Typefi Inline Image (see Insert Image, p. 205), or part of a 
Typefi Element. (See Typefi Elements in the Typefi Designer User Guide).

The same applies to pictures such as digital camera images, or images selected 
from Word’s Clip Art pane, or other locations on your workstation or server.

Track Changes
Word’s ‘Track Changes’ feature is supported by Typefi Publish. Inserted or deleted 
content is marked-up with a Typefi Condition (see Insert Condition, p. 202) such 
as ‘Deleted’ or ‘Added’. When a Word document with tracked changes enabled 
is published through Typefi, the default publishing behaviour is to ‘accept all 
changes’ during the publishing process. However, the Word document and its 
tracked changes remain unaltered, and different publishing behaviour can be 
configured. For instance you might want to publish two different versions, one 
that shows the document as Final, and one that shows all the inserted text in 
green, and removed text in red strikethrough.



 Linking Word Documents to Typefi Projects 169

In order to mark up your Word document through the Typefi Writer, the 
project must be linked to a Typefi project.

You can associate your Word documents with a Typefi project in two different 
ways:

 ■ through project attachment
 ■ through the use of a Typefi Stylesheet File (.tss).

 ‘Attached Project’ dialog – a document with no project attached.

Linking Word Documents 
to Typefi Projects
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Attaching a Typefi project
In order to attach a project to an existing Word document,  you must have access 
to the Typefi Publish Server from your workstation and be a member of the project 
(see Starting a Project in the Typefi Server User Guide).

To attach a Typefi project to a non-Typefi Word document: 
 ■ Open the Document in Word.
 ■ Choose Typefi > Attached Project… or click the ‘Attached Project’ icon in the 

Typefi toolbar.

The Attached Project dialog appears.
 ■ Click Attach…

A list of all the Typefi projects to which you have access appears. 
 ■ Select the appropriate project and click OK.

The Attached Project dialog reappears, this time displaying the Name, Server 
Address and Date that the project was last modified on the Typefi Publish Server.

 ■ Click Close to associate the Word document with the Attached Project. 

Once a Typefi project is attached to the Word document you can use the Typefi 
menu to markup the Word document by inserting Typefi objects, such as Sections 
and Elements, and format the text using Typefi Paragraph and Character Styles. 
When the markup is completed you can publish the document through Typefi 
Publish. 

Select Project from TSS File
Another method you can use for associating an existing Word document with 
a Typefi project is through linking the document to a .tss file. One thing to 
remember is that although you will be able to markup the Word document for 
use with Typefi Publish, you will not be able to publish the document until you’re 
connected to the Typefi Publish Server.

In order for a Word document to be associated with a project through its .tss file, 
the Typefi Writer Settings must first have the Allow projects to be selected from 
Typefi Style Sheet (.TSS) file option enabled (see Typefi Style Sheet (.TSS), p. 161).

To select a project from a TSS file:

Select Project.

Attached Project dialog showing the name and location of 
the project attached to the document. (They are dimmed 
to indicate they cannot be manually altered).
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 ■ Open the Document in Word.
 ■ Choose Typefi > Attached Project… or click the Attached Project icon in the 

Typefi toolbar.

The Attached Project dialog appears.
 ■ Click Attach...
 ■ Click Typefi Style Sheet (.TSS).
 ■ Click Browse… and
 ■ Navigate to a .tss file on your system.
 ■ Select File.
 ■ Click Select.
 ■ Click OK.
 ■ Click Close.

Alternatively:
 ■ Choose previously accessed .tss from the drop down list.
 ■ Click OK.
 ■ Click Close.

The .TSS files drop down list stores each .tss file path that is accessed. To clear the 
list of .tss file paths from this drop down:

 ■ Choose Clear List.

New Typefi Document
You can create new and empty Typefi documents in two different ways. They can 
be created from within Word, or they can be created directly on the Typefi Publish 
Server.

New Document from Word
When the Typefi Writer is added to Word, the Typefi menu and toolbar contain a 
‘New Document’ option.

To create a new Typefi document from Word: 
 ■ Choose Typefi > New Document... or click the New Document icon in the 

toolbar.
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A dialog prompts you to select a project from Typefi Publish Server. This is how 
you proceed:

Typefi Server
A list of Projects available on the selected server appears.

 ■ Select a Project from the Project List. 

Note: To change the Server selection, click Change... and from the Server Selection list choose another 
Server then click OK to return to the Select Project dialog

The ’Include content from’ drop-down at the bottom of the dialog gives you the 
option to create a new document that is an exact copy of an existing document 
that is part of the selected Typefi project. 

New document based on other document

If you want to start your new document from another Typefi document that is part 
of the selected project, select the preferred .doc or .rtf file from the Include 
content from drop-down. 

 ■ Next click OK.

If you’ve opted not to base your new document on an existing document, the 
Select Typefi Section dialog will appear, asking you to choose the first Typefi 
Section to insert in your Word document (see Typefi Sections, p. 69).

To choose the first Typefi Section of your document:
 ■ Choose a Section from the list.
 ■ Click OK to insert this selected Section as the first in the document and follow 

the Section Properties prompt, then click OK to return to the Word document or 
Click Cancel to return to an empty Word document.

The Word document has now been linked to a Typefi project.

New Document from Server
Another way in which a new document can be created is from the Typefi Server. 
You’ll need to be authorized to have ‘Browser access’ to the Typefi Publish Server in 
order to use this feature (see Starting a Project in the Typefi Publish Server Guide).

Selecting a Project from a server, with ‘Include 
content from’ option enabled.
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To create a new document on the server:
 ■ Connect to Typefi Publish Server from your web browser.

After you’ve signed into the server:
 ■ Click the Project within which you’d like to create a new document.
 ■ Click Content.
 ■ Click New...
 ■ Enter the document name. You don’t need to add the .doc extension; Typefi will 

do that for you.
 ■ Set the Options.
 ■ Click Create.

A new Word document has now been created in the content repository on the 
Typefi Server. To edit the document in Word with Typefi Writer, you must ‘check 
out’ the document (see Check out in the Typefi Publish Server Guide).

Create Document Options
The document options are only needed when you plan to create a new document 
based on existing data that was extracted to the Sections repository from 
other documents in the project. (This may be very useful to create a composite 
document from a number of Word files, rather than making a whole new Word 
file.)

Selecting Sections

Available Sections list all the sections that are extracted from Word documents 
(or added from a XML repository) to a Typefi project Content/Sections repository 
on the Typefi Publish Server.. Available Sections may be used as a source for data 
when publishing jobs directly from the Typefi Publish Server. )

To include sections in the Word document you are creating from the available 
extracted sections:

 ■ Select the sections from the ‘Available Sections’ list, then click , to add them 
to the ‘Selected Sections’ list. To Add All Sections from ‘Available Sections’ to 
‘Selected Sections’, click . 

To exclude sections from the Selected Sections list:

Creating a New Typefi Document within the Typefi Server Project.
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 ■ Select the section name to be removed, then click . The removed section 
is moved back to the ‘Available Sections’ list. To Remove All Sections from 
‘Selected Sections’, click . All sections are now listed under ‘Available Sections’.

Next you must choose whether you’re going to create a single Word document, 
and whether you want to use copies of the current sections, or use the original 
section data as part of the Word document(s) you are creating.

Single document

Choose Single Document, to create a single Word document that contains zero or 
more selected sections.

When you disable the Single Document option and have selected two or more 
sections, Typefi will create a Word document for each of the selected sections, 
using the Document Name as a prefix for the document names and the Section 
Names for the rest of the document names.

Use Copies of Selected Sections

The Use Copies of Selected Sections when enabled will create a new Word 
document based on copies of the available sections. You then check out the 
created document and later on check it back in after making changes to the 
document. When you check in the document and click ‘Update Sections’, new 
sections will be added to the Content/Sections repository.

Disabling the Use Copies of Selected Sections means that when you check in 
changes to the document and click Update Sections, existing sections will be 
updated.

Writer Theme
With the creation of a Writer Theme file you can control the default look of Word 
documents created from the Typefi Publish Server. By default, when you create a 
New Document on the Typefi Publish Server from source Section XML you might 
have noticed that the newly created Word documents contain little to no 
formatting. Headings won’t appear in bold or in a larger font and you can’t tell 
when a character style is applied, as there is no visual cue that shows you 
something is bold or italic. With a little effort you can actually change this.

myWriterTemplate.rtf added to Content/Documents as Writer theme.
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What’s needed is a slight configuration change on the Typefi Publish Server that 
must be done by your server administrator. Secondly, a Rich Text Format (.rtf) 
Word theme file must be created that contains all of your preferred formatting. 
For different Typefi projects, there can be formatting differences. However the file 
name must always be the same.

A sample file called WriterTemplate.rtf that includes the core Typefi styles for 
Sections, Elements, Tables etc. has been added to the Server/context/conf 
directory. It’s recommended you use this one as a starting point.

To create a WriterTemplate.rtf file:
 ■ Create a copy of the sample WriterTemplate.rtf file (Server/context/conf) and 

save it somewhere (such as the Desktop).
 ■ Sign-in to the Typefi Publish Server and choose the project to which you’d like 

to add the file.
 ■ Click Add Files, then (when prompted by the FileManager) browse to the file 

and add it.

The file is uploaded to Content/Documents.
 ■ Check out the file and attach it to the project.
 ■ Next you’ll be able to insert all of the paragraph and character styles, and then 

use Word’s Styles and Formatting panel to modify the look and feel of the styles 
(only necessary if it helps).

 ■ When done, save and close the file and check it back in.

For this file to behave as a theme that is applied to newly created Word 
documents, the server must be reconfigured slightly:

 ■ Contact your server administrator and inform the administrator of the file-name 
(e.g. myWriterTemplate.rtf).

The administrator can then make the required changes to the server configuration, 
so that Typefi Publish knows that if a file of that particular file name exists in 
a project it must be used as a theme that formats the Word document as it is 
created.

Administrator task: Edit the Server/context/conf/static.properties file on the Typefi Publish Server and 
define the .rtf file name provided as the cxml2rtf.template setting. The server must be restarted for the 
changes to take effect. 
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Check for Updates
The Check for Updates command is used to resynchronise a Word document 
with its Typefi project and update all Typefi Writer settings available to the author 
in Word. A Word document can become outdated – for instance, when the 
production designer makes amendments to the InDesign template that is part of a 
Typefi project. 

When a paragraph style name is changed or a new paragraph style is added to 
the template while you’re working on the Word document, the changes will not 
be reflected in your document until you’ve resynchronised the document with the 
project.

To check whether any updates are available:
 ■ Choose Typefi > Attached Project or click the Attached Project icon in the Typefi 

toolbar.
 ■ Click Check for Update…

If there is an update available the Writer prompts you with a message stating the 
date and time that the last version of the project was created. It then gives you an 
option to attach the newer version of the project to your Word document.

 ■ Click Yes to attach the new version, click No to leave the Word document 
unchanged.

 ■ If there are no updates available a message window appears stating “No update 
is available”, and you can click OK to return to the Word document. 

Detach Project
There might be a need to permanently remove the link between a Word 
document and a Typefi project. For instance, the Word document might need to 
be resubmitted to an author so that a start can be made with the authoring of a 
next edition for a publication. If the author doesn’t have Typefi Writer installed in 
his copy of Word, there is no need to have this attachment.

To detach a project from a Word document:
 ■ Check out the Word document from the Typefi Publish Server, or open the Word 

document if stored external to the Typefi Server.
 ■ Choose Typefi > Attached Project, or click the Attached Project icon in the 

Typefi toolbar.
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The Attached Project dialog appears.
 ■ Click Detach.

A message appears asking you if you’re sure you want to detach the project from 
the active Word document.

 ■ Click Yes to detach the project, or click No, to leave things as they were and 
return to Word.

Converting Typefi 4.0 documents to Typefi 5.0
Typefi Writer 5.0 has been fully re-engineered and quite a few things are structured 
differently, requiring that any earlier Typefi Writer documents are updated in order 
for them to be published through Typefi Publish 5.0. The conversion to Typefi 
Publish 5.x takes place automatically.

To convert a Typefi 4.x document to Typefi 5.x:
 ■ Check out or open the Word document that is associated with a Typefi project.

The document is automatically converted as indicated by the message window 
that appears.

 ■ Click OK, to continue working in the updated document.

If you don’t want to update the document, simply don’t save the Word document 
when you close it.

The Typefi > Refresh Document command also removes any old Typefi 4.x markup 
it finds in a document and updates or deletes any obsolete markup (see Refresh 
Document, p. 219).

Document updated to work with newer version of Typefi Publish System
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Every Typefi Publication is made up of one or more sections. Similar to Word, 
Typefi Sections are used to create distinct parts within a publication that 
contains an unbroken flow of content. Individual Sections may also have a 
different layout or page numbering format.

The first Typefi component that you must insert in a Word document is a Typefi 
Section. This is also the reason you’re prompted to insert a section when creating 
a new document (see New Document from Word, p. 171).Typefi uses the sections 
to determine what the page designs and numbering format must be used when 
pages are being designed and populated with the content you’re writing in Word.

Insert Section
To mark each new major segment of a document, you insert a new section. 
Sections can exist for many different publication segments. For instance: a Chapter, 
a Prelim, an Appendix, but also a two-page flyer; a four-page flyer with different 
front and back design; etc. Depending on the project you’re working on you’re 
likely to encounter different sections. 

To insert a section:
 ■ Choose Typefi > Insert Section or click the Insert Section icon in the Typefi 

toolbar.

The Select Section Type dialog appears.
 ■ Choose the Section Type.
 ■ Click OK.

Choice of Section Type.

Sections
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The Typefi Section is now inserted at the cursor position location in the Word 
document.

For Sections that make reference to Section Fields, or documents that contain 
Conditions (see Typefi Sections, p. 69) the Section Properties dialog appears after 
clicking OK. The dialog prompts you for additional data before the section is 
added to the document.

Typefi Field data entered at section level is unique to the section. The data entered will populate the 
field placeholders the production designer has inserted in the InDesign template that is used during 
automated page-composition.

In the Section Properties dialog:
 ■ Enter any of the required field data, such as the ChapterTitle in the example 

above.
 ■ If the project you’re working on contains conditions, you also have the option 

to conditionalize the entire section, by selecting the relevant condition from the 
Conditions list.

 ■ Click OK.

Your Word document will now include a Section. Continue to insert the rest of the 
content for this segment of your publication immediately following the Section 
marker.

Edit Section
You can edit the Section Type, Field data and Condition settings after insertion: 

Change Section Type
To change the Section Type:

 ■ Double click the Section marker in the Word document. This displays the Edit 
Section dialog.

 ■ Click Change.
 ■ Choose a new Section Type.
 ■ Click OK.
 ■ Edit any Fields or Conditions settings if required.
 ■ Click OK.

ChapterTitle added (left) and Condition selected for entire Section (right).

Typefi Section added to the Word document with Typefi Writer.
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The Section Type in the Word document has now been amended.

Edit Section Fields
To edit a Section Field: 

 ■ Double Click the Section Field label preceding the field data, for example 
‘ChapterTitle’.

 ■ The Edit Section dialog appears.
 ■ Change the field data.
 ■ Click OK.

Edit Condition
To edit a condition: 

 ■ Double Click “Conditions:” in the Section marker.

The Edit Section dialog appears.
 ■ Change the Condition settings.
 ■ Click OK.

Edit Section with Typefi Document Explorer
The Typefi Document Explorer (see Typefi Document Explorer, p. 220) can also 
be used as a tool for editing Typefi Sections. Especially when you need to edit 
multiple sections and don’t wish to endlessly scroll through your document 
looking for them, the Document Explorer is a great time-saver.

To edit sections with Typefi Document Explorer:
 ■ (Optional) Click a particular section component.
 ■ Choose Typefi >Explore Document… or click the Explore Document icon in the 

Typefi toolbar.

In the structure tree, the selected section component is automatically highlighted. 
If this isn’t the right component, click the section component you want to edit. 

 ■ Click Edit.

The Edit Sections dialog appears.
 ■ Make the changes.

Typefi Document Explorer allows quick access to, and editing of sections.
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 ■ Click OK to return back to the Typefi Document Explorer.

As long as the Explorer window is open, you can continue to navigate through the 
structure tree and edit other sections.

 ■ When you’ve finished editing click Close to return to the Word document.

Delete Section
When you delete a Section from a document, it only deletes the Section marker 
and its field information from the document. The content that was part of the 
Section will remain and become part of the previous Typefi Section.

To delete a Section from your document:
 ■ Double click the Section marker in the Word document. The Edit Section dialog 

appears. 
 ■ Click Delete. The Delete Section message appears.
 ■ Click Yes to delete the Section or click No to return to the Edit Section dialog.
 ■ Click OK to return to the Word document.

Alternatively:
 ■ Locate the Section in the Typefi Document Explorer.
 ■ Click Delete. The Delete Section message appears.
 ■ Click Yes to delete the Section or click No to return to the Document Explorer.
 ■ Click Close to return to Word.

The Section marker has now been removed from the document.

Converting Word section breaks to Typefi Sections
You should remove Word section breaks from the Typefi Writer document and 
replace them with Typefi Sections where suitable.
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Word has many layout and design features, but you will mostly use Word to 
author or edit text. Styles for paragraphs, characters, tables and lists in Word 
enable you to apply accurate and consistent text formatting.

Typefi distinguishes three different text based styles. Paragraph, Character and 
Table Styles. Table styles we’ll discuss in a separate chapter (see Tables, p. 187). List 
styles, such as bulleted and numbered lists, are incorporated in Typefi’s Paragraph 
Styles. In contrast to Word, which adds some 150 styles to the Normal.dot 
template, Typefi will only display those styles provided by the production designer 
for use.

Paragraph Styles
Paragraph Styles are used to apply text formatting to entire paragraphs. You’re 
probably used to using Paragraph Styles through the Styles and Formatting pane 
in Word, or else the Style menu in the Styles and Formatting toolbar. 

Typefi Paragraph Styles do not appear in the Styles and Formatting pane until they 
have been used at least once in the document. (However, they can all appear in 
the Styles and Formatting list when the Word document was created from existing 
Typefi content, or has had a Writer or Word Theme applied to it.)

Applying Typefi Paragraph Styles
To apply a paragraph style to text in Word:

 ■ Place the cursor within a paragraph, or highlight the entire paragraph.
 ■ Choose Typefi > Paragraph Styles... or click the Paragraph Styles icon in the 

Typefi toolbar. The Typefi Toolbar: Typefi Paragraph Styles icon

Formatting Text
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 ■ Click the Style Name.
 ■ Click Apply.

Bulleted and Numbered Lists
As we mentioned at the start of this chapter, Word List Styles are absorbed into 
Typefi Paragraph Styles. So how do these work?

 ■ The production designer must define unique Paragraph Styles in the InDesign 
template that forms the basis for the page composition. The numbering, bullet 
symbol and hanging indentation settings are all included within these styles.

 ■ Instead of using a normal paragraph style and then applying the list attribute in 
Word when authoring/editing text, you must apply the appropriate paragraph 
style.

 ■ To properly have these list styles recorded in the XML that is extracted behind 
the scenes when publishing content from Word, you must ensure that the 
formatting of the styles in Word contains Bullets or Numbering. 

Multiple paragraphs within list item

Typefi does not support use of multiple paragraphs within a single list item. 
Instead you can simulate it by inserting a forced line break (Shift+Enter) where 
you’d like to see a paragraph inserted within a list item.

List Levels

In Word you create different levels for numbered and bulleted lists by using the 
Increase Indent button. This does not work in a Typefi document...

You must inform the production designer of the levels of numbers and bullets that 
will be needed, so that the InDesign template provides the necessary paragraph 
styles to meet your needs.

Restart numbering

The numbering of lists is controlled by the paragraph styles in the InDesign 
template. For instance, a Level 2 paragraph style might have a setting included by 
the production designer that resets the numbers for this style after each higher 
level. (For example 1-a-b-2-a-b.) Using the restart numbering option in Word 
has no effect on numbering during page-composition in InDesign. Again, the 
production designer must be made aware of your document numbering needs.
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Nesting of lists

Nesting of lists may result in incorrect numbering as the numbering is controlled 
by the paragraph styles in InDesign. Multiple nesting of lists is quite possible 
through correct application of Paragraph Styles provided by the production 
designer.

Character Styles
Character Styles apply text formatting to selected text within paragraphs. In 
contrast to Paragraph Styles, they are not used for the text formatting of entire 
paragraphs, but merely to make certain characters, words, phrases or sentences 
stand out. For example, there might be words or phrases that need to appear in 
bold or italic. 

Applying Typefi Character Styles
To apply a character style to text in Word:

 ■ Within a paragraph that already has a Paragraph Style applied to it, highlight 
some text. 

 ■ Choose Typefi > Character Styles... or click the Character Styles icon in the Typefi 
toolbar. 

 ■ Click the Style Name.
 ■ Click Apply.

Word’s Repeat Style Command
Once Typefi Paragraph or Character Styles have been added to the Word Styles 
and Formatting menu, you can use Word’s Edit > Repeat Style command  to 
reapply the last applied style elsewhere in your document. (Keyboard Shortcuts F4 
or Ctrl+Y or Alt+Enter will also work again at that stage.)

Soft Styles
Manual (or ‘soft’ – as opposed to ‘hard’ styles) formatting applied at character level 
in Word (such as Bold, Italic or Underline) can be passed through to Typefi Publish. 
However, the project settings in Typefi Server may filter out any of the supported 
soft-styles. 

The Typefi Toolbar: Typefi Character Styles icon
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The soft-style formatting is only passed to the Typefi Publish engine if this feature 
is enabled as part of the Job Option against which content is published.

You should communicate with the person responsible for Job Option definition 
and InDesign template design regarding support for soft-styles, prior to using 
them.

The following soft-styles are supported: 
Bold, Italic, Underline, Outline, Strikethrough, Superscript, Subscript, All Caps and Small Caps

Converting Word Styles to Typefi Styles
There are easy ways to convert Word Paragraph Styles or Character Styles to Typefi 
Styles. 

Let’s take a look and see how through a simple example we can replace all text 
that has “Heading 1” applied to it with a Typefi Paragraph Style called “Heading1” 
(no space). 

In your document and with your project, just replace these style names with 
relevant style names.

 ■ Ensure the Format > Styles and Formatting pane is displayed.
 ■ Locate the First “Heading 1” paragraph in the document and insert your cursor 

within the paragraph.
 ■ Choose Typefi >Paragraph Styles or click the Paragraph Styles icon in the Typefi 

toolbar.

The Typefi Paragraph Styles dialog appears.
 ■ Click the Style you want to replace ‘Heading 1’ with.
 ■ Click Apply.

The new style is added to the Word’s Styles panel (and may be chosen from there 
in future).

Next you can replace all the other occurrences of ‘Heading 1’ (old style) with 
‘Heading1’ (new style).

 ■ Place your cursor within a paragraph that has the ‘old’ style applied to it 
occurrence of the style you want to replace (such as Heading 1 in the example). 

Typefi Paragraph Styles being applied.
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 ■ In Styles and Formatting click the drop-down and choose Select All ‘n’ Instances. 
(there may be hundreds!) 

 ■ All of the text within the word document that has this style applied to it is now 
selected (a clever Word trick!).

 ■ Click the new paragraph style name in the Styles list (“Heading1” in the example 
here) and all text formatted with the old style is now formatted with the new 
style. 

Converting Soft-Styles to Typefi Character Styles
Word soft-styles are easily recognizable in the Styles panel, when all of the Typefi 
Paragraph styles have been applied. They appear as a style override, listing the 
paragraph style name followed by a plus (+) symbol and the soft-style name (if the 
Styles Options is set to show Font Formatting). 

To select all soft-style instances for a particular paragraph style and apply a Typefi 
Character Style to them: 

 ■ First check that the Typefi Character Style is listed in the Word Styles and 
Formatting pane. If the style isn’t available, then apply it to some text in the 
document to add it.

 ■ Next for each of the Styles containing soft-style overrides, locate the style 
override in the list. 

 ■ Click the drop-down arrow and choose Select All ‘n’ Instances. 

All of the text formatting with the soft-style is now selected.
 ■ Click the Typefi Character Style name from the Pick formatting to apply list in 

the Styles and Formatting pane.

Selecting all instances of text that have a particular style applied.

Paragraph Style with soft-style override showing as ‘+ Bold’.
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Tables format text inside a grid of columns and rows. When using Typefi 
Publish, table designs are controlled by the production designer who 
prepares the InDesign templates that are used during automated page-
composition. 

Cell coloring applied to tables in Word is ignored by Typefi Publish and for 
certain table styles even paragraph style formatting may be ignored. In order 
to understand which level of table formatting must be applied within Word, it’s 
advised that you consult with the production artist responsible for developing the 
Table Styles in the Typefi template being used by the project. 

Insert New Table
Let’s first look at an insertion and formatting of a newly created Typefi Table. 

To insert a new table:
 ■ Choose Typefi > Insert Table.

The Insert Table dialog appears asking you to set all of the properties for the new 
table. These will be explained in more detail later.

 ■ Set all Table Size specifications.
 ■ Set additional Options.
 ■ Click OK.

A new table has now been created with a brown-shaded Typefi markup above: 

Insert Table dialog

Tables
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Newly created Typefi Table

Table Size
The Table Size settings in the Insert Table dialog control the number of rows and 
columns the table will have as well as the number of header and footer rows.

Header Rows
Header Rows are the top one or more rows of a table. Generally they stand out in a 
design through use of thicker lines, different background color, or text formatting. 
The data you enter in any header row will repeat when a table covers more than 
one page. In some cases, depending on the template design created by the layout 
designer, you might even see the header row repeating itself across columns. This 
repeating behaviour is only seen upon completion of page composition. Word 
itself will not repeat the header rows when your table exceeds the page length in 
Word.

Footer Rows
Footer Rows are similar to Header Rows, but are positioned at the bottom of a 
table. (Perhaps there needs to be a special ‘totals’ row in a financial table or a table 
notes row.) Like Header Rows, Footer Rows will repeat themselves across pages 
when tables continue on next pages during page-composition.

Options
The Options settings enable the author to override some of the table formatting 
otherwise controlled by the table style designs set up by the production designer 
in InDesign. This is not necessary unless the formatting in the final job output is 
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unacceptable. The usual Option chosen is ‘Keep proportional column widths’, since 
the column content is so variable.

Keep proportional column widths 

To override any column width settings captured in the Table Style by the 
production designer, start by applying your own proportional distribution of table 
columns in Word, using Word’s native column editing tools.

To maintain the proportional column distribution you’ve set in Word: 
 ■ Select the Keep proportional column width setting in the Typefi Table dialog.

Keep vertical cell alignment 

The Keep vertical cell alignment is used when you want to control the vertical 
alignment of data within its table cells from Word. Enabling this setting will 
override any vertical alignment settings defined as part of the Table Style itself.

To maintain the vertical cell alignments you’ve set in Word:
 ■ Select Keep vertical cell alignment in the Typefi Table dialog.

Keep horizontal cell alignment

The Keep horizontal cell alignment settings allows you to change the alignment 
settings of text in a table cell and retain this alignment change even if it is an 
override for a paragraph style alignment.

To maintain the horizontal cell alignment you’ve set in Word:
 ■ Select Keep horizontal cell alignment in the Typefi Table dialog.

Word’s Table Properties and Typefi Tables
Once you’ve inserted a Typefi Table in a Word document, you can use some of 
Word’s table editing features to set table attributes.

Paragraph Styles
Typefi Table styles can have the first paragraph style defined as part of a table 
style. That means that no matter what formatting you apply to the first paragraph 
in a table cell, the formatting set by the production designer in the InDesign 
template will override your formatting.

Choosing to retain the set column widths when converting to Typefi table.

You may want to keep cell contents vertically 
aligned the way they were in Word.
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However additional paragraphs must have their formatting  set in Word. In 
addition it could be that the table design isn’t suited to locking in this first 
paragraph style setting. In this case you’ll have to ensure that you apply 
appropriate paragraph and character style formatting to the data retained in your 
table.

Cell Merging
Cell Merging is not controlled by Typefi Table styles. This means that any cell 
merging (for instance in header rows or column cells) must be set in Word. Use 
Word’s Tables > Merge Cells command to merge cells.

Table Properties
Some of the settings you can apply to a table through Word’s native Table > Table 
Properties dialog are ignored during page composition.

Cell Alignment settings are retained only if the Keep vertical cell alignment option 
is enabled in the Typefi Table set-up, however, cell inset settings are not retained.

So what are some of the settings that have no effect? Setting Preferred width has 
no effect on the eventual table width, as the width setting is defined as part of the 
Typefi Table style. Word’s Positioning and Alignment settings are not used. 

Typefi Tables are inline with text, meaning the tables will always sit in a paragraph 
of their own, and their alignment and overall width settings are controlled by the 
production designer who designed the InDesign template. Table Break points set 
in Word are also ignored.

The fact that none of these settings comes across doesn’t necessarily mean there 
is no use for them in Word. For example in cases where you’ve enabled the Keep 
proportional column widths setting in the Typefi Table dialog, and have a series of 
tables in Word that require the same amount of columns and column distribution, 
you might want to define exact table width or column width settings, to ensure 
that each table appears identically during page composition.

Edit Table
Tables can be edited after they’ve been created. 

You should be careful not to merge cells of a header row with cells of 
a body row (or even footer row), or to merge cells of a footer row with 
cells of a body row). While Typefi Publish hopefully will handle the case 
with just some warnings, neither the XML representation for tables nor 
InDesign support the merging of cells of different areas of a table (i.e. 
header row area, body row area and footer row area).
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To edit the number of columns or rows a table has, use Word’s table formatting 
tools. Also column distribution, width, merged cells settings are all controlled 
through use of Word’s native table formatting tools.

To edit any of the Typefi specific table settings: 
 ■ Double click the Typefi Table header or locate the Table in the Typefi Document 

Explorer.
 ■ Click Edit.

The Edit Table dialog appears. With exception of the number of body columns and 
rows any of the Typefi Table settings can be altered. 

 ■ Make the required changes for Table Settings and Options.
 ■ Click OK (and Close if editing via the Document Explorer).

Delete Table
When deleting a Typefi Table from Word, a core Word table including table data 
stays behind in Word. 

To delete a table:
 ■ Double click the Typefi Table header or locate the Table in the Typefi Document 

Explorer.
 ■ Click Delete and Close if editing via the Document Explorer).

Applying a Typefi Table Style to a standard Word 
table
Word tables don’t have to be deleted or recreated in order to turn them into Typefi 
Tables, because you can turn them into Typefi Tables.

To convert a Word table to a Typefi Table:
 ■ Place your cursor at the end of the paragraph preceding the table.
 ■ Tip: Show hidden characters in word, to verify the cursor is placed before the 

paragraph return.
 ■ Choose Typefi > Insert Table.

The Insert Table dialog appears. 

You may edit a Typefi table’s settings after inserting it, but not 
the number of columns or rows. Do that the usual way.
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 ■ For the Table Size specifications merely set the number of Header or Footer 
Rows. You don’t need to set the number of body columns or rows, since Typefi 
will do that automatically.

 ■ Set additional Options.
 ■ Click OK.

A new Typefi Table is now inserted preceding the Word table.
 ■ Place your cursor in the first cell of the Typefi table.
 ■ Click and drag down and select all of the table rows as well as the blank 

paragraph the Typefi Table inserted above the Word table.
 ■ Press Delete.

You have now linked the Word table to a Typefi Table style. To check that the 
column and row settings have been amended properly edit the Table and check 
the Table Size settings.
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You add Hyperlinks to documents for navigational purposes. You can 
include them in Cross-References or set them as individual navigational 
links. 

Hyperlinks consist of two components: text to display and a target. The hyperlink 
text to display is the content that is displayed in the Word document and the 
target is the ‘address’ to which the hyperlink points when it is clicked in an 
interactive PDF.

Insert Hyperlink
Word web and email hyperlinks are automatically converted during page 
composition. However, you must re-create other Word hyperlink types (such as 
links to bookmarks or paragraph styles as targets) as Typefi Hyperlinks. 

To insert a new hyperlink: 
 ■ Highlight the content that is to be the source of the hyperlink.
 ■ Choose Typefi > Insert Hyperlink or click the Insert Hyperlink icon in the Typefi 

toolbar. The Insert Hyperlink dialog appears.
 ■ Click Select…. The Select Hyperlink Source dialog is displayed.
 ■ Choose the document to which you’d like the Hyperlink to go. 

By default the Active Document is selected. However, if you check out other 
documents that are part of the same Typefi project, you may choose that. When 
publishing a job containing inter-document hyperlinks, you must publish content 
from the Typefi Publish Server. During the page-composition the hyperlink will 
then be resolved.

 ■ Next click either Bookmarks, Paragraphs or Section Fields.

Choose a source for a Hyperlink by clicking the 
‘Select’ button in the Insert Hyperlink dialog.

Hyperlinks
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 ■ Choose the target from the list. 
 ■ Click OK and Click OK again.

Sorting: To make it easier to choose a hyperlink destination in a long list, click the Sequence, Style 
and Text labels. This orders the list by the content listed under the label. Clicking the same label again 
toggles the sort order between ascending and descending order.

The Typefi Hyperlink is now created and recognisable through its mark-up in the 
text. 

Hyperlink display text can be edited at any time.

Bookmarks
Bookmarks are another document navigation tool. You can insert them as empty 
anchors or around some text that is highlighted. To use a Bookmark as a target for 
a Hyperlink, you must first Insert > Bookmark and name the Bookmark in Word.

Paragraph
To use a paragraph that has a particular paragraph style applied to it as a hyperlink 
target, you must first ensure that the paragraph style is enabled as an allowable 
source in the Typefi project’s Cross-references settings. Those paragraph styles 
allowed as a Cross-reference source will be listed as possible hyperlink targets. This 
can only be done by someone who has access to the project files on the Typefi 
Server.

Section Fields 
As with Paragraphs, you must first ensure that the Section Fields are allowed as 
a Cross-reference Source in the project’s Cross-references configuration. Those 
Section Fields listed as an allowable Cross-reference Source are available as a 
hyperlink target. Again, this can only be done by someone who has access to the 
project files on the Typefi Server.

Note: You cannot hyperlink to a Project Field, but you can create a Cross-Reference to one.

Having chosen the current document and the type of source 
(Paragraph Styles), the particular heading can then be selected.
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Edit Hyperlink
You can edit Hyperlink display text and target settings.

To edit the Hyperlink display text:
 ■ Either insert the cursor between the ‘<’ and ‘>’ markers or highlight the current 

text displayed between the markers in the text and make the relevant changes.

To edit the Hyperlink target:
 ■ Double click the Hyperlink marker in the Word document. The Edit Hyperlink 

dialog appears.
 ■ Click Select to display the Select Hyperlink Source dialog.
 ■ Choose the new target.
 ■ Click OK to return to the Edit Hyperlink dialog.
 ■ Click OK to update the Hyperlink.

Alternatively, you can use the Document Explorer to edit the hyperlink:
 ■ Locate the Hyperlink in the Typefi Document Explorer and click Edit. The Edit 

Hyperlink Dialog appears.
 ■ Next click Select to display the Select Hyperlink Source dialog.
 ■ Choose the new target.
 ■ Click OK to return to the Typefi Document Explorer.
 ■ Click Close to return to Word.

Delete Hyperlink
To delete the Hyperlink Destination:

 ■ Double click the Hyperlink marker in the Word document. The Edit Hyperlink 
dialog appears. 

 ■ Click Delete. The Delete Hyperlink message appears.
 ■ Click Yes to delete the Hyperlink or click No to return to the Edit Hyperlink 

dialog.
 ■ Click OK to return to the Word document.

Alternatively, you can use the Document Explorer to delete the hyperlink:
 ■ Locate the Hyperlink in the Typefi Document Explorer.
 ■ Click Delete. The Delete Hyperlink message appears.

Editing the source of a Hyperlink
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 ■ Click Yes to delete the Hyperlink or click No to return to the Document Explorer.
 ■ Click Close to return to Word.

The display text for the hyperlink is no longer a hyperlink, but the text remains.
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Cross-References are used to point the readers of a document to other 
sources of information located elsewhere in the same chapter or another 
chapter. We’re using Cross-References in this user guide as a way of directing 
you to locations in the text where you can find related information or more 
in-depth information about topics discussed.

Typefi Cross-References enable the author to mention sources such as other 
documents; particular paragraphs; bookmarks; and even Section and Project 
Fields. The Cross-Reference text can either be defined by the author, or can be 
taken from the source. Cross-references can point to text or page-numbers and 
may be converted to hyperlinks on the fly.

Insert Cross-Reference
Cross-References get their content from the Cross-Reference Source. For instance, 
a Cross-Reference could point to a particular heading in the text and copy the text 
of this heading into the cross-reference text, e.g.: (see ‘Cross-References’ on p.45).

New technique: In earlier versions of Typefi Publish you could turn existing highlighted text into a cross-
reference. If you want to convert existing text into a link that points to a position elsewhere in your 
document in the current version of Typefi Publish you must use a Hyperlink. 

To insert a Cross-Reference:
 ■ Place your cursor within a paragraph at the cross-reference insertion point. 
 ■ Choose Typefi > Insert Cross-Reference or click the Insert Cross-Reference icon 

in the Typefi toolbar. The Insert Cross-Reference dialog appears.
 ■ Click Select…. The Select Cross-Reference Source dialog is displayed. Selecting a Cross-Reference Source, using Paragraph Styles as Source.

Cross-References
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 ■ Choose the Document that contains the source for the Cross-Reference.

By default the Active Document is selected. However, if you check out other 
documents that are part of the same Typefi project, you may choose that. When 
publishing a job containing inter-document cross-references, you must publish 
content from the Typefi Publish Server. During the page-composition the cross-
references will be resolved.

 ■ Next click either Bookmarks, Paragraphs, Section Fields or Project Fields.
 ■ Choose the Cross-References Source from the list.
 ■ Click OK.
 ■ Choose the Cross-Reference Result  from the two choices that appear, and 

Select Hyperlink to turn the Cross-Reference into a Hyperlink.
 ■ Click OK again. 

A Cross-Reference marker has now been inserted in the text and stands out by its 
default orange background color.

Result
The Result section of the Insert Cross-Reference dialog determines what content is 
inserted at the cursor. Cross-References will contain either source text or a page 
number. (Usually, authors insert a text cross-reference followed by the page 
number cross-reference.)

Note: In Word, you will not see the actual content of the cross-reference – only the Typefi markup 
indicating a CROSS-REF and the type of content it is a reference to. The correct content will appear in 
the final job output.

Source Text
Depending on whether a Cross-Reference points to a Bookmark, Paragraph Style, 
Section or Project field, the Cross-Reference text will contain one of the following:

 ■ Paragraph Text: all of the text set in the paragraph that is selected as a source 
is inserted as source text. Generally you would direct your Cross-References 
to headings of various levels, but be careful.  If you choose a paragraph that 
contains many lines, the entire content will be inserted as your cross-reference 
source. You might want to consider using a Hyperlink in that case.

Example of a Cross-Reference to a Section field, followed by another 
Cross-Reference to the page number of the same Section field.

Insert Cross-Reference, with Result set to 
Paragraph text, and Hyperlink enabled.
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 ■ Bookmark text: the text that was selected in Word when the bookmark was 
created.

 ■ Section field text: content of the field inserted at the start of a Typefi Section.
 ■ Project field text: content of one of the Project fields (such as Author). This is 

either sourced from the Typefi project settings on the Typefi Publish Server, or 
from the Typefi Print dialog in Word (see Project Fields, p. 227).

Source Page Number
The source page number inserts the page number where the cross-reference 
source commences. For example, if a source runs over multiple pages, the page 
number of the page where the source starts is inserted.

Source page numbers can point to the page location of the Bookmark, Paragraph, 
Section field, or Project Field, and are listed as:

 ■ Bookmark page number
 ■ Paragraph page number 
 ■ Section field page number
 ■ Project field page number

Hyperlink
Enabling the ‘Include Hyperlink’ setting modifies a Cross-Reference to include an 
interactive hyperlink during page composition.

Edit Cross-Reference
Cross-Reference sources can be edited after insertion.

To edit a Cross-Reference:
 ■ Double click the CROSS-REF marker in the Word document. The Edit Cross-

Reference dialog appears.
 ■ Click Select to display the Select Cross-Reference Source dialog.
 ■ Choose a new source.
 ■ Click OK to return to the Edit Cross-Reference dialog.
 ■ Click OK to update the Cross-Reference.

Alternatively, you could use the Document Explorer:
Editing a Cross-Reference.
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 ■ Locate the Cross-Reference in the Typefi Document Explorer and click Edit. The 
Edit Cross-Reference Dialog appears.

 ■ Next click Select to display the Select Cross-Reference Source dialog.
 ■ Choose a new source.
 ■ Click OK to return to the Typefi Document Explorer.
 ■ Click Close to return to Word.

Delete Cross-Reference
To delete the Cross-Reference:

 ■ Double click the CROSS-REF marker in the Word document. The Edit Cross-
Reference dialog appears.

 ■ Click Delete. The Delete Cross-Reference message appears.
 ■ Click Yes to delete the Cross-Reference or click No to return to the Edit Cross-

Reference dialog.
 ■ Click OK to return to the Word document.

Alternatively, you could use the Document Explorer:
 ■ Locate the Cross-Reference in the Typefi Document Explorer.
 ■ Click Delete. The Delete Cross-Reference message appears.
 ■ Click Yes to delete the Cross-Reference or click No to return to the Document 

Explorer.
 ■ Click Close to return to Word.

The CROSS-REF tag disappears from the text.
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You may need to produce a version of a document that has some 
differences to the original, yet is largely the same. Rather than maintain 
two or more files, you can use ‘conditional’ markup in the one file, and print 
whichever one you need. Conditional formatting of content allows the 
mark-up of Sections, Elements, Images and Text for inclusion or exclusion 
when content is published through Typefi Publish.

When could you use conditional formatting?
 ■ When publishing a teacher and student edition of a publication, you would 

want the answers to the questions to appear only in the teacher edition.
 ■ When writing marketing or technical documents in a combined US English and 

UK English document. (You’re reading an example. Typefi publishes its User 
Guide in US and UK English language, and indeed different spellings like colour/
color are both inserted and marked up with conditions so that the correct 
version appears in the particular edition of the publication.)

 ■ When developing software documentation for an application that runs on 
Mac or Windows OS and you would like to publish unique editions for each 
Operating System.

 ■ When working on catalogues or product factsheets that you must produce with 
prices in either Euros, US Dollars or Australian Dollars. 

 ■ Or creating a Limited Edition and a Full Edition of a publication, where the 
Limited Edition excludes all graphics.

These are just some examples of where conditions could become useful and allow 
you to use a single content file to produce different editions of a publication.

Conditions
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Conditions are only available to the Typefi Writer in Word when they have been 
inserted at Typefi project level (see UNRESOLVABLE CROSS-REFERENCE in the 
Typefi Server User Guide) first. Any content marked up with a condition not only 
sits between condition markers, but is also highlighted in a condition-specific 
color. These colors are also defined at project level on the Typefi Publish Server.

Insert Condition
You can use conditions at various levels with Typefi Writer. The highest level of 
content that can be marked up with a condition is a Typefi Section.

Conditions and Sections
When you markup a Typefi Section with a condition, it means that all content 
within that section is included as part of the condition. For instance, in a Teacher/
Student publication, the teacher edition might have additional sections included 
at the back of the publication with in-depth answers to end-of-chapter questions; 
or specific training instructions.

You can set a condition for a Section when inserting the section, or when editing 
the section. (see Sections, p. 178).

 ■ Click the Condition tab in the Insert Section/Edit Section dialog to view the 
conditions.

 ■ Select the condition(s) that must be applied to the section.
 ■ Click OK.

Conditions for other content
Conditions contain two components: the content and the condition that marks up 
this content.

To insert a Condition:
 ■ Highlight the content that is to be conditionalized or insert the cursor at a 

location where you would like to add some content after the Condition is 
added.

 ■ Choose Typefi > Insert Condition or click the Insert Condition icon in the Typefi 
toolbar. The Insert Condition dialog appears.

 ■ Click the Condition you want to use.
Inserting a Condition.
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 ■ Click OK.

The condition has now been inserted in your document and is recognisable by its 
distinctive markup.

If you’ve not yet inserted the conditionalized it is now time to insert the content:
 ■ Insert your cursor between the ‘<’ and ‘>’ markers.
 ■ Insert the content that is to be conditionalized .

A word about Conditions and Nesting
Where a condition is ‘nested’ (one condition fully encapsulates a second condition), 
the content of the nested condition can not be published on its own.

Let’s look at an example. A sentence within a paragraph marked-up with a Student 
condition is also marked up with a Teacher condition.

When publishing to Typefi Publish with the Only Teacher Condition & non-
conditional content included for output you’ll find that no data is published for this 
paragraph.

When publishing with only the Student condition & non-conditional content, both 
Student and Teacher content are published.

This behaviour is identical when a condition is entered at Section level and other 
conditions are inserted within the section.

Edit Condition
Conditional content and the Conditions themselves can be altered after they’ve 
been added to the document.

To edit the Conditional content:
 ■ Either insert the cursor between the ‘<’ and ‘>’ markers or highlight the current 

text displayed between the markers in the text and make the relevant changes.

To change the Condition:
 ■ Double click the Condition marker in the Word document. The Edit Condition 

dialog appears.
 ■ Choose the new condition.
 ■ Click OK to update the Condition.

Condition applied to highlighted text.

Nesting Conditions: publishing inner condition.

Nesting Conditions: publishing outer condition.



 Conditions 204

Alternatively, you could use the Document Explorer:
 ■ Locate the Condition in the Typefi Document Explorer and click Edit. The Edit 

Condition Dialog appears.
 ■ Choose the new condition. 
 ■ Click OK to return to the Typefi Document Explorer.
 ■ Click Close to return to Word.

Delete Condition
To delete a Condition:

 ■ Double click the Condition marker in the Word document. The Edit Condition 
dialog appears. 

 ■ Click Delete. The Delete Condition message appears.
 ■ Click Yes to delete the Condition or click No to return to the Edit Condition 

dialog.
 ■ Click OK to return to the Word document.

Alternatively:
 ■ Locate the Condition in the Typefi Document Explorer.
 ■ Click Delete. The Delete Condition message appears.
 ■ Click Yes to delete the Condition or click No to return to the Document Explorer.
 ■ Click Close to return to Word.

The content stays in the Word document, but it is no longer marked up as a 
condition and will always appear when the content is published through Typefi 
Publish.

Editing Conditions.
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Typefi’s Insert Image command always generates inline images. Inline 
images are graphics that are placed within a paragraph’s content. They flow 
with the text as more content is inserted or when content is removed. 

About Images
As we discussed earlier, images inserted either as Inline Images, or as part of Typefi 
Element data, must be saved in a file format that is supported by Typefi Publish 
(see Image file formats, p. 163).

Typefi does not embed images in Word, but it does create a link to the image file. 
(This means that when you insert images in the documents you must have access 
to the files.) Each image that is placed is automatically added by the FileManager 
application to the Images repository that is part of the Typefi project to which your 
Word document belongs. (see Images in the Typefi Publish Server Guide ). Typefi 
then uses the images from this repository when publishing the content.

If an image in its original storage location is updated (possibly by a graphic 
designer who created the image), and you publish the Word document again, 
you’ll be prompted by FileManager asking you if you’d like to update the image.

Insert Image
You can insert images anywhere within a paragraph and they will resize according 
to the inline image resize behavior the production designer has defined for inline 
images as part of the paragraph style. Inline images can also sit in a paragraph on 
their own, and as with images placed within a paragraph image resize controls are 
defined by the paragraph style and not visible until you publish the document. 

FileManager warning about an updated image.

Inline Images
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To insert an image:
 ■ Insert the cursor at the image insertion point in a paragraph.
 ■ Choose Typefi > Insert Image or click the Insert Image icon in the Typefi toolbar. 

The Insert Image dialog appears.
 ■ Click Browse…, the Select Image dialog appears.
 ■ Navigate to the Image and select it.
 ■ Click Select. You return to the Insert Image dialog and the filename and path are 

inserted. Enter a Comment (optional).
 ■ Click OK.

The image is now inserted. Depending on whether you have the ‘Show document 
images’ setting enabled in Typefi Preferences (see Document Images on p.162), 
you’ll either see an IMAGE: marker followed by the filename, or an image preview 
(with limitations, such as Word not being able to display certain valid file types). 

Comments
The Comments field in the Edit/Insert Image dialog can contain text. When Typefi 
Publish can’t locate an image during page-composition, the text found in the 
Comment field is inserted instead.

Comment field text could also be used in cases where documents are published 
to InDesign as well as to HTML (Web). The data could be used to populate the “Alt” 
tag required for accessibility reason.

Edit Image
Images can be replaced by other images, or comments may be edited at any time.

To edit the image: 
 ■ Double click the IMAGE marker in the Word document or double click the image 

itself if you are previewing it in Word. The Edit Image dialog appears.
 ■ Click Browse. The Select Image dialog appears.
 ■ Navigate to the replacement image and select it.
 ■ Click Select to return to the Edit Image dialog, and make a change in the 

Comment if needed.
 ■ Click OK to update the Image.

Typefi Inline IMAGE marker (top), previewed (bottom)

Inserting or editing the link to an image.
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Alternatively, you could use the Document Explorer:
 ■ Locate the Image in the Typefi Document Explorer and click Edit. The Edit Image 

dialog appears.
 ■ Click Browse. The Select Image dialog appears.
 ■ Navigate to the replacement image and select it.
 ■ Click Select to return to the Edit Image dialog, and make a change in the 

Comment if needed.
 ■ Click OK to return to the Typefi Document Explorer.
 ■ Click Close to return to Word.

Delete Image
To delete an Image:

 ■ Double click the Image marker in the Word document, or double click the image 
itself when you are previewing the images in Word. The Edit Condition dialog 
appears. 

 ■ Click Delete. The Delete Image message appears.
 ■ Click Yes to delete the Image or click No to return to the Edit Image dialog.
 ■ Click OK to return to the Word document.

Alternatively, you could use the Document Explorer:
 ■ Locate the image in the Typefi Document Explorer.
 ■ Click Delete. The Delete Image message appears.
 ■ Click Yes to delete the image or click No to return to the Document Explorer.
 ■ Click Close to return to Word.

The image has now been removed from the document.
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Elements are objects or groups of objects that are distinguished from the 
core text in a publication by their difference in design. Element content is 
built-up dynamically during page composition before it is placed on the 
page by the Typefi Publish System. 

As an example, some of the element components might resize as other related 
components change in size - based on the content they receive. For instance, 
if an image is related to a caption and the image is made smaller during page 
composition, the distance between the bottom of the image and the caption 
should probably be maintained. The Element design and resize behaviour is 
defined by the production designer working in InDesign.

Element Types
There are three different types of Elements: fixed, floating and inline. Each Element 
type has its own characteristics and functionality in page design. However, the 
method of Element insertion in the Word document is similar for each of the 
Element Types.

Fixed Elements
A Fixed Element is an element that is inserted at the start of a section and is 
inherently linked to that section. Therefore a Fixed Element will only be available 
for insertion when you are indeed inserting the Element in its related section. 
Additionally a Fixed Element can only be inserted once in a section. This means 
that if you’ve already inserted it in a section, the Element will no longer be listed as 
an available element for the section. 

Elements
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An example of a fixed element could be:
 ■ A special object on the first page of a chapter (new Section) containing the 

Objectives information (Educational sample).
 ■ Placement of an author’s photo with caption at the start of each Article (Typefi 

Section).

Inline Elements
Inline Elements are elements that are inserted in, and move with the text.  
Additionally, they may be located in ‘anchored object’ positions defined by the 
production designer (such as outside the text column). Inline elements may be 
inserted as often as needed, and may contain a variety of content (such as an 
image and caption).

Floating Elements
Floating elements are elements that are placed as individual objects during the 
page-composition process. They are positioned based on pre-defined layout rules 
added by the production designer to the InDesign template that is used as the 
basis for the page-composition. Like Inline Elements, Floating Elements may be  
used more than once per section, and may contain a variety of content for each 
occurrence in a document.

Variants

In contrast to Inline Elements which have one appearance, Floating Elements can 
be designed by the production designer to have multiple appearances. Each of 
these appearances is referred to as a Variant. When the variants are named, you 
may choose (during the insertion process) which of them Typefi Publish must use 
during page composition.

Example of Variants:
 ■ A Figure Element that has both a Portrait (vertical) and a Landscape (horizontal) 

variation. Depending on the orientation of the image you are using, you will 
select the relevant variant when inserting the element.

 ■ A Margin Note Element that has a slightly different design for left and right 
pages. In this case, the production designer would design the variations and 
you would insert the Margin Note without making reference to a specific 
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variant. (Typefi Publish will choose the correct variant based on whether the 
note appears on a left or right hand page.)

Insert Elements
You should insert Elements at the end of a paragraph, as inserting elements mid-
paragraph results in the paragraph ‘breaking’ at that point. In cases where an 
Element must be placed as close as possible to related topic content in the text, 
you may add an Element Reference in that location after inserting the element. 
This reference may appear anywhere within paragraph text.

Elements can prompt you for three different types of content:
 ■ Text
 ■ Image data
 ■ Field data

Depending on the complexity of an element (which is controlled by the 
production designer) you might be prompted to provide specific content as you 
insert the Element into Word.

Let’s have a look at inserting a simple element that contains each of the three 
content types: a photo with caption and photographer’s name added as field data 
to the side of the element during page-composition. 

To insert an Element: 
 ■ Insert the cursor at the end of a paragraph, before the paragraph return 

character.
 ■ Choose Typefi > Insert Element or click the Insert Element icon in the Typefi 

toolbar. The Select Element dialog appears.
 ■ Choose the Element you want to insert.
 ■ Click OK.
 ■ The Insert Element dialog appears, displaying the Element Structure from top to 

bottom on the left side.

Insert Element
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Entering information about a Typefi element, 
including choosing the Variant.

Change Variant (Floating Elements Only)
If you’ve inserted a Floating Element, you have the option to choose the required 
Floating Element Variant at this stage. For Fixed and Inline Elements this option is 
not available. The default Variant setting is Automatic, which means that the Typefi 
Engine will decide which Variant to place during page-composition. In this sample 
element there is the option to choose a Portrait or Landscape variant.

To change the Variant Setting:
 ■ Click Change… The Select Variant dialog appears.
 ■ From the List of available Variants choose the Variant you want to use.
 ■ Click OK.

You will then return to the Insert Element dialog.

Element Fields
A good method for assigning values or data to the different content types that are 
part of an element is to work your way from the top down in the Element structure 
view. Elements can be pretty complex, especially when they contain nested 
Elements and using this top-down approach assists in ensuring the content for all 
the element objects listed in the structure is set.

Select the Variant from the list.
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To set Field values:
 ■ Click the Fields node in the Element structure.
 ■ Enter field values for each field.
 ■ Select the next item in the Element structure, or click OK if you’ve finished 

setting all of the Element data, and the Element will be inserted.

Setting Field information in sequence.

Element Image
If an Element contains an image, a link to the image on your computer or a server 
volume must be established.

To set the Image link and comments:
 ■ Click the Image node in the Element structure.
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Insert Element - specifying image location.

 ■ Click Browse…, and the Select Image dialog appears.
 ■ Navigate to the image and select it.
 ■ Click Select. You will return to the Insert Element dialog and the full filename is 

inserted. Enter a Comment (optional). 
 ■ Click OK (or continue clicking through the rest of the Element Structure if there 

are more items listed that need information entered).

The Element now appears in the Word document, recognisable by its ELEMENT 
and END ELEMENT markers. 

Edit Elements
If at any stage you want to change an Element’s image link, content, or field values, 
you have the option to edit the element. 

To edit an Element:
 ■ Double click the ELEMENT marker in the Word document. The Edit ELEMENT 

dialog appears.

Element inserted in Word
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 ■ Click on the component you’d like to edit (e.g. click Fields if you want to edit the 
Field values).

 ■ Make the changes and click OK to return to the Word document.
 ■ Click Close to return to Word.

If you know in advance that you’d like to edit a particular content component that is part of the element, 
you can start by double-clicking that component marker within the Element and the Edit Element dialog will 
open with the correct object already selected in the Element Structure.

Alternatively, you can use the Document Explorer:
 ■ Locate the ELEMENT in the Typefi Document Explorer and click Edit. The Edit 

ELEMENT dialog appears. (You can also locate the component within the 
Element Structure and select that first, then click Edit.)

 ■ Click on the component you’d like to edit (e.g. click Fields if you want to edit the 
Field values).

 ■ Make the changes and click OK to return to the Typefi Document Explorer.
 ■ Click Close to return to Word.

Delete Element
When you delete an Element, only the text content stays behind in the Word 
document. Images and fields are removed from the Word document.

To delete an Element:
 ■ Double click the ELEMENT marker in the Word document. The Edit Element 

dialog appears.
 ■ Click Delete. The Delete Element message appears.
 ■ Click Yes to delete the Element or click No to return to the Edit Element dialog.
 ■ Click OK to return to the Word document.

Alternatively:
 ■ Locate the Element in the Typefi Document Explorer.
 ■ Click Delete. The Delete Element message appears.
 ■ Click Yes to delete the Element or click No to return to the Document Explorer.
 ■ Click Close to return to Word.
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Element Reference
An Element Reference is a marker that links a Typefi Element to a specific location 
in the text. These markers are used during the page-composition process in 
conjunction with placement rules assigned to the element by the production 
designer to determine where the Element is best placed on the page. 

For instance, a keyword note displayed in the margin of a publication that defines 
a keyword used in the text might have its element reference set just after the 
keyword is mentioned, so that the margin note will line up with the keyword 
during page-composition.

Insert Element Reference
As discussed earlier you should not insert an Element mid-paragraph as this would 
result in insertion of a paragraph break. Element References are the best way to 
link an element to any location within a paragraph.

To avoid page-composition errors, don’t insert multiple Element References that point to the same 
element.

To insert an Element Reference
 ■ Place the cursor at the insertion point in the text.
 ■ Choose Typefi > Insert Element Reference or click the Insert Element Reference 

icon in the Typefi toolbar. The Insert Element dialog appears, listing all elements 
that have been inserted in the active Typefi Section.

 ■ Select the relevant Element.
 ■ Click OK.

An ELEMENT REF marker appears at the insertion point in the text.

Edit Element Reference
If you want to change the Element Reference to a different Element, then edit the 
Element Reference.

To edit the Element Reference:
 ■ Double click the ELEMENT REF marker in the Word document. The Edit Element 

Reference dialog appears.

Insert Element Reference
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 ■ Choose the new Element Reference.
 ■ Click OK to update the Element Reference.

Alternatively, you can use the Document Explorer:
 ■ Locate the Element Reference in the Typefi Document Explorer and click Edit. 

The Edit Element Reference Dialog appears. 
 ■ Choose a different Element Reference. 
 ■ Click OK to return to the Typefi Document Explorer.
 ■ Click Close to return to Word.

Delete Element Reference
To delete an Element Reference:

 ■ Double click the ELEMENT REF marker in the Word document. The Edit Element 
Reference dialog appears. 

 ■ Click Delete. The Delete Element Reference message appears.
 ■ Click Yes to delete the Element Reference or click No to return to the Edit 

Element Reference dialog.
 ■ Click OK to return to the Word document.

Alternatively, you can use the Document Explorer:
 ■ Locate the Element Reference in the Typefi Document Explorer.
 ■ Click Delete. The Delete Element Reference message appears.
 ■ Click Yes to delete the Element Reference or click No to return to the Document 

Explorer window.
 ■ Click Close to return to Word.

The ELEMENT REF marker has now been removed from the text.

Changing or deleting an Element Reference.
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Typefi Markup is the code that is added to the Word file as you insert Typefi 
objects.

Typefi markup is formatted to stand out from normal Word content. Each of 
the Typefi Markup styles is listed with a TPS acronym prefix in the Styles and 
Formatting list in Word, and you may modify their appearance (e.g. Make the 
background a different color).

Convert to Tags 
It is possible to change the Typefi markup to ‘Tags’ rather than ‘Fields’. When Tags 
are displayed you will not be able to edit the Typefi components by double 
clicking them. Take great care when editing Typefi components in this mode. 
Deleting a component’s Start or End Markers causes errors in the document that 
would result in page-composition errors or publishing failure. Use the Typefi 
Document Explorer (see Typefi Document Explorer, p. 220)  to verify that all Typefi 
components are still valid.

Global find/replaces
Tags can be useful, such as a situation in which you want to globally change 
Typefi markup. For example: (a) assign a new Element to an old Element; (b) apply 
a condition with a new name to old conditions; or (c) change a path reference 
for images. When displaying the document markup tags in the Word document, 
you will be able to perform global search and replace tasks throughout your 
document.

Typefi markup converted to Tags.

Writer Markup and 
Document View
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Convert to Fields 
Fields are the default Writer markup that is used to display Typefi components in 
Word. Unless you want to specifically see the code behind the scene or the xml 
tags, you would always work in Field view mode when editing a Word document 
with the Typefi Writer. 

View Field Codes
Viewing the Field Codes will display all of the complexity behind the default Field 
view. It’s a little daunting to look at a Word document marked up with Typefi 
Writer in this mode. 

Don’t worry, your document is easily viewed in its default Field view again:
 ■ Choose Typefi > Mark-up > View Field Codes.

This command behaves as an on/off toggle and Shows/Hides the codes depending 
what is active or not. 

Note: When Field Codes are displayed you will not be able to edit Typefi components by double-clicking 
them.

Re-Apply Styles
If your document contains any style overrides on Typefi Markup styles, the 
Re-Apply Styles command will reset these styles to match the Style and 
Formatting they have in the Pick formatting to apply list in Word.

To re-apply Typefi Markup Styles:
 ■ Choose Typefi > Markup >Re-Apply Styles.

Reset Styles
It could be that you’ve altered the appearance of the Typefi Markup styles in the 
Active Document, but want to reset these styles to their standard appearance. The 
Reset Styles command does just that.

To reset the Typefi Markup styles to their original settings:
 ■ Choose Typefi > Markup >Reset Styles.

Convert to Fields, View Field Codes disabled.

Field Codes displayed.
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Refresh Document
The Refresh Document option performs a series of tasks on a Word document that 
is linked to a Typefi Project:

1. Ensures all condition colors are properly applied.

2. Updates any obsolete document markup to the version 5.x format.

3. Repaints all markup fields and markup tags using correct markup styles.

4. Removes any obsolete 4.x templates if found.

5. Updates all fields in the document.
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The Typefi Document Explorer is a tool that can be used to view and 
navigate a document’s structure. In addition, the Document Explorer is 
useful for editing purposes as well as a tool for checking the validity of a 
Typefi Writer document.

Navigation from Explorer
The Document Explorer may be used as a document navigator. There is a choice of 
two views – Outline or Category.  You may find the Category view useful when 
dealing with one type of Typefi content, such as Elements. Whenever you click on 
an item in the structure part of the Explorer the cursor position jumps to this item 
in the Word document.

To display and use the Document Explorer:
 ■ Choose Typefi > Explore Document or click the Explore Document icon in the 

Typefi toolbar.

Expanded Outline View in Explorer

Typefi Document Explorer
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Explorer’s Category View with Elements expanded

 ■ Choose whether to view the Outline or Categories.
 ■ Click the ‘+’ icon to expand individual Sections/Categories, or display object 

structures such as an Element structure containing Fields, Image etc.
 ■ Click the ‘-‘ icon to collapse an item in the structure.

To navigate using the Document Explorer:
 ■ Ensure you can see the document structure.
 ■ Click an object in the structure and the cursor will jump to that location in the 

document.
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Editing from Explorer
You have seen in most of the previous chapters that the Document Explorer may 
also be used as an Editing tool. Not only can you locate an object in the document 
structure and select it, but then you can edit it. 

Editing from Document Explorer.

When your cursor is inside the Typefi Markup on the Word page and you open the 
Document Explorer, the Explorer automatically jumps to the active object.

To edit a Typefi object using the Document Explorer:
 ■ Either place your cursor in the Typefi markup for the object, then choose 

Typefi > Explore Document or click the Explore Document icon in the Typefi 
toolbar.

Alternatively:
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 ■ Choose Typefi > Explore Document or click the Explore Document icon in the 
Typefi toolbar and navigate to the object you want to edit.

 ■ Next, click Edit to display the Object’s Edit dialog and make the appropriate 
changes.

 ■ Click OK and Click Close to return to the Word document.

Replacing with Explorer
Explorer is very useful for rapid replacement of any Typefi component (Sections, 
Elements, Conditions, Character and Paragraph Styles). You can use Explorer to 
replace ALL instances of one element with a different element type. With the 
exception of Paragraph and Character Styles, you can replace a component with 
nothing, thereby removing all instances of that component.

To replace all instances of any Typefi component:
 ■ Click the Explore Document icon in the Typefi toolbar.
 ■ In the Explorer toolbar, click the ‘Replace’ button.
 ■ Select the type of Typefi component you want to replace from the ‘Find What’ 

list on the left.
 ■ Select the particular component sub-type from the list on the right (this list 

changes automatically to suitable choices). 
 ■ Choose its replacement from the ‘Replace With’ list below. (Leave it empty to 

just delete the component type.) 
 ■ Click the ‘Replace All’ button.

Deleting from Explorer
To Delete a Typefi object using the Document Explorer:

 ■ Either place your cursor in the Typefi markup for the object you want to delete, 
then choose Typefi > Explore Document or click the Explore Document icon in 
the Typefi toolbar.

Alternatively:
 ■ Choose Typefi > Explore Document or click the Explore Document icon in the 

Typefi toolbar and navigate to the object you want to delete.
 ■ Next, click Delete. The Delete ‘Object type’ message appears.
 ■ Click Yes to delete the Object or click No to return to the Explorer.

The Explorer Toolbar: the Replace button

Replacing all instances of an element with a different 
type of element is possible using the Explorer.
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 ■ Click Close to return to Word.

Finding Errors
The Explorer checks whether Sections, Fields, Elements, Hyperlinks, Conditions 
and Cross-References in the active Word document are valid and will display a 
Warning or Errors in the Word document structure.

A warning appears as a yellow icon. It is advised to fix warnings although they will 
not prevent a document from being published.

An error appears as a red icon. It indicates a fault in a Typefi object that will cause 
the page-composition to fail. You must fix all errors prior to publishing the Word 
document.

To display additional information about an Error or Warning: 
 ■ Click the item that is preceded by the warning or error icon.
 ■ The Messages part of the Document Explorer will now display a more detailed 

message of what’s not quite right in the document. 

Typefi Document Explorer with warning symbol indicating 
an error (missing start field from element content)
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The ultimate goal of authoring your documents in Word with the Typefi 
Writer is to publish the content and create the professionally designed 
output. 

Saving Word documents
As with any digital document your files must be stored somewhere. Where you 
store Word files marked up with the Typefi Writer and linked to a particular Typefi 
project depends on the work processes used by your organisation. 

To simplify things we’ll look at two basic scenarios.

Typefi Server
Saving and storing your files with the Typefi project on the Server assists in 
keeping all the project-related files in one location and allows you to publish 
content directly from the server by extracting sections from the Word documents 
and including them in a contents list for publication.

Non-Typefi Server Locations
Files do not have to be stored on the Typefi Publish Server, and may be stored 
elsewhere on the network. However, to publish the documents through 
Typefi Publish, the Word user opening the marked-up documents must have a 
connection to the Typefi Publish Server and be a member of the project to which 
the file belongs.

Publishing Content 
to Typefi Publish
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Publishing from Word
When publishing a document from Word to Typefi Publish, you should be aware 
that only the content from the document itself will be published and the Typefi 
Engine will not be able to resolve Cross-References and Hyperlinks that point to 
other Word documents that are part of a project.

Typefi Print
To publish a document from Word: 

 ■ Choose Typefi > Typefi Print or click the Typefi Print icon in the Typefi Toolbar.

If the document contains any warnings or errors, Typefi Writer will alert you with a 
message.

 ■ Click Yes to view the warnings in the Typefi Document Explorer and fix errors/
warnings first. Or click No to ignore the warnings and proceed with the Print 
command.

The Typefi Print dialog appears. This dialog allows you to specify the Job option, 
PDF preset and Field data, and where the resulting PDF will be saved (click the 
‘Settings…’ button). 

Job Option

The Job Option controls which particular template is used during the page-
composition process, whether the document must start with a particular page 
number, how unresolvable cross-references are handled and more. Basically the 
choice of job option determines how the eventual output will appear.

PDF Preset

PDF Presets define the type of PDF file that is created upon completion of the 
page-composition process. The choices available are related to the settings 
installed and configured on the Typefi Publish Server.

Generally PDF Presets are characterised by quality and purpose. For instance, a 
PDF Preset called “For Internet”, might be defined to create a PDF file that is small 
enough to be used online and that also adds some interactivity, such as hyperlinks, 
cross-references to interactive links, or a series of navigational bookmarks.

Typefi Writer print warning dialog.

Typefi Print dialog.
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Project Fields

For Typefi projects that contain project field data, you’ll be prompted to enter the 
field values for the project fields. The default field values are sourced from the 
Typefi project that is on the Typefi Publish Server.

RESET FIELDS
 ■ Click Reset Fields to reset the Field values to the same values as the values on 

the server. Alternatively enter your own values. These are typically used to set 
text content such as a document title, copyright year, ISBN code,  or book title as 
a running header during page-composition.

Settings

The Settings allow you to override the default location in which Word will save the 
PDF that is output during page-composition.

To change the location of published PDF documents:
 ■ Click Settings…
 ■ Click Browse…
 ■ Navigate to the Folder in which you’d like to store the files.
 ■ Select the folder and click Select.
 ■ Click Ok to return to the Typefi Print dialog.

FileManager messages
Once the Print command commences, the FileManager will display a series of 
messages.

When processing the job for printing, FileManager will prompt you to replace 
any images that have been modified or updated since they were last uploaded to 
the images directory. You can click ‘No’ if you are sure that the images have not 
changed. This can save upload time…

FileManager pop-up messages
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Image warning (this will happen regularly).

Click Yes to replace the image on the Typefi Publish Server, click No to retain the 
older image on the Typefi Publish server.

At this point, the Word document is converted to CXML which is loaded to the 
Typefi Publish server and is used as content during page-composition.

During the page-composition process on the Typefi Publish Server, you can 
continue to work in Word. When the job has been successfully published the 
FileManager will briefly display a message that the Print Job is finished.

Cancelled jobs

When a print job is cancelled during page-composition the Typefi FileManager will 
display a ‘cancelled’ message.

Publishing from Typefi Server
The second method you can use to publish content to Typefi Publish is to upload 
the Word documents to the Typefi Publish Server and publish them from the 
uploaded content. 

You can disregard this topic if you are only working with Typefi Writer, and do not have access to the 
Typefi Server.

The advantage of publishing from the Typefi Server is that you have the ability 
to extract content from multiple Word documents (for instance a series of book 
chapters), and publish some or all of this content as a single job to a single PDF. In 

FileManager - Print job cancelled message
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addition, cross-document hyperlinks, cross-references between documents,  and 
table of contents will be resolved.

To publish from the Server you must:
 ■ Have browser access to the Typefi Publish Server; be a member of the Typefi 

project; sign in to the Typefi Publish Server; and click the project to which the 
Word documents belong.

 ■ Add all Word files from which content is to be used to the Typefi project on the 
Typefi Publish Server.

 ■ Update the sections from the Word documents into a Content/Sections 
repository.

 ■ Assign Content to be used as part of a Job Option.
 ■ Run Job.
 ■ Navigate to the Jobs Monitor and access the resulting PDF as part of the 

published job.

Word documents to Server
To add files to the Typefi Publish Server and make them part of a project:

 ■ Sign in to the Typefi Publish Server (if you have access permission).
 ■ Click the project name of the project to which the Word document(s) belong.
 ■ Click Add Files.
 ■ Next locate the Word file(s) on your system and select the one(s) to be added. 
 ■ Click Choose (on Mac) or Open (on Windows) to add the file to project 

Templates folder.

Once the Word documents are loaded to the Server, you must extract the content 
from the Word documents, so that it can be used as content in a Job Option.

Update Sections
The Update Sections command extracts Section-based XML from selected Word 
documents and places this in the Content/Sections repository.

To update sections:
 ■ Click the project name of the project to which the Word document(s) were 

added.
 ■ Click Content.
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 ■ Select the Word documents from which content must be published.
 ■ Click Update Sections.
 ■ The Word documents will appear to be “checked-out” whilst Typefi Publish 

extracts content. When content has been successfully extracted the files appear 
“checked-in” again.

Editing Word documents: Once you’ve added Word documents to a Typefi Project that publishes 
content from the Server, we advise that you edit the Word documents by checking them out from their 
project. Make the changes, save the document, check the file back in and then Update the Sections prior 
to re-publishing a job that uses the Word document’s content.

Job Option
With the Sections data extracted you can now publish the content from multiple 
Word documents to Typefi Publish.

 ■ Click the project name of the project to which the Word document(s) were 
added.

 ■ Click Job Options.
 ■ Select the Job Option you’ll use to publish the extracted sections.
 ■ Click Edit.
 ■ Move the Sections you want to publish from ‘Available Sections’ to ‘Used 

Sections’.
 ■ Click Save, to update the Job Option with the content.

You are now ready to publish the job to Typefi Publish.

Run Job
 ■ Click Job Options.
 ■ Select the Job Option to which you previously added the content.
 ■ Click Run Job.

The Typefi Publish Server window automatically jumps to the Jobs Monitor for the 
selected Job Option. Here you can monitor the page-composition progress. When 
the Job is completed you can access the published components.
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Job Monitor
 ■ Click the completed job link in the Job Monitor for the job you’ve just published 

to display the published files.

Typefi Publish creates the InDesign file, a log file, a .CXML file and (usually) a PDF 
file.

No PDF file? If you don’t see a PDF file after the page-composition has been completed, then check that 
the Create PDF option is enabled for the Job Options you’ve used to publish the job.

Viewing the PDF file
To view the PDF file that was created as part of a published job:

 ■ Access it from the Job Monitor
 ■ Check out the PDF
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‘Roundtripping’ involves the process of publishing your Word content 
through Typefi Publish; making changes in produced InDesign files; and 
transferring these changes back into the Word content file.

Roundtrip process diagram

One of the requirements for roundtripping is that the Word documents you work with must be stored 
on the Typefi Publish Server and their sections extracted. (If you don’t have access to the server, you can 
disregard this topic.)

Roundtripping
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Step-by-step Roundtrip process
The diagram above gives a full process overview on how Roundtripping works. 
These are the steps involved:

Step 1: Editing Content in Word
Check out a Word document that has been added to a Typefi project, and make all 
of the required changes to the document.

Step 2: Save, Close, Check In
When you’re finished editing the document, save the file, close the file and check 
the file back into Content/Documents.

Step 3: Update Sections
In order to publish the content from the checked in Document, select it in the 
Document repository and click Update Sections. The section data is now extracted 
and visible in the Document / Sections repository.

Step 4: Add content to Job Option
Edit a Job Option that is going to be used and ensure the extracted content is 
added as part of a Job Option’s content. Next publish the job.

Step 5: Editing in InDesign
Locate the Published job in the Job Monitor and check out the InDesign file. 
Make changes in the InDesign file, and ensure you retain the Typefi content of the 
document.

Step 6: Save, Close, Check In
When finished with the edits in InDesign, save the file, close it and check it back in.
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Step 7: Update Sections
Now it’s time to extract an updated content version from the InDesign document 
and replace the old content in the Content/Sections repository. Select the 
InDesign File and click Update Sections.

Step 8: Updating the Word document (full circle)
Time for the roundtrip stage. In Content/Documents, select the Word document 
you edited originally and click Update. Leave the Selected Sections as they are, 
leave ‘Use Copies of Selected Sections’ disabled and click Update. The Word 
document has now been updated.

Step 9: Roundtrip complete
To verify that the roundtrip has been successfully completed, check out the Word 
document.
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Anchors
Markers that indicate where an element is referenced in the content. The 
relationship between element and its anchor within the content is defined by the 
element’s layout rules. The Anchor consists of an Anchor Marker and an Anchor 
Line. The Anchor Marker is the circular mark linked to the Element. The Anchor 
Line is the line that connects the Marker to its reference point in the text

Anchor Line
(see Anchors)

Anchor Marker
(see Anchors)

Bookmarks
Expandable panel to the left of a PDF page that contains a series of structured 
links, normally derived from headings. These links provide quick access to related 
PDF pages and are viewable with the free Adobe Reader.

Character Styles
See Styles

Glossary
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Conditions
Qualifications used to mark up specific parts of content for inclusion or exclusion 
when a job is published.

Conversion process
Process of transferring Microsoft Word data from original data format to Typefi 
Writer enabled format. 

Cross-Reference
A textual references within a publication that directs the reader from a source 
point in the text to a destination located elsewhere in the same publication.

Designer Scripts
InDesign Scripts that are installed in the InDesign CS3 Server/Scripts folder, 
developed in JavaScript (Mac or PC compatible), AppleScript (Mac) or VB Script 
(Windows).

Field Value
The data that populates a Project, Section or Element Fields during page 
composition.

Filler
A page that is inserted at the end of a section to ensure the following section can 
start on a required left or right hand page.

Fixed Element
Typefi Elements for which each instance appears in a predefined context and 
location.
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Floating Element
Individually placed and designed objects or groups that are placed separate to the 
main content thread, and positioned on the page according to predefined layout 
rules and priorities.

Footers
Footers consist of text information placed at the bottom of the page. This text 
repeats itself across pages of the full project or document section (see also Typefi 
Section). Footers can include text such as division title, version number, page 
number etc.

Footnotes
Notes located at the bottom of document pages. They are used to add some 
additional information about something referred to in the main text and are 
generally numbered in-text and then referenced by that number at the bottom of 
the page.

Headers
Headers are generally descriptive information about a document section (see 
Typefi Section), placed at the top of the page. Header information repeats itself 
across pages of the full project or document section. For example a chapter title 
might replicate itself across the pages of a chapter.

Inline Element
Individually placed and designed objects or groups that compare with InDesign’s 
inline or anchored objects. They are inserted into the main story text flow during 
page composition.

Inline Images
Images inserted at the cursor position inside a paragraph that behave as an 
individual character does.
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Job Monitor
Lists all failed Typefi Publish jobs, jobs in progress, pending jobs, jobs that were 
round-tripped and completed jobs.

Job Scripts
Server based scripts that are installed in the script folder inside the Typefi/Publish/
Server folder. Job Scripts are invoked by the Typefi Publish Server either before a 
job is run, or on completion of the job.

Paragraph Styles
See Styles

PDF Export Presets
Typefi Engine Type’s reference to PDF Settings files (.joboptions) installed on 
InDesign Server

Prefix
A label that precedes the automatic page numbering in InDesign

Project Field
Field that carries the same value throughout a publishing project, for example a 
publication title.

Rendering
Process of generating InDesign and PDF output by means of automated 
pagination using the Typefi Publish system.

Script
A set of instructions written in a programming language such as JavaScript, that 
can be run at various times during automated pagination and provide additional 
client-specific customisation requirements.
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Section Field
Fields that carries the same value throughout a section. For example a Chapter 
Title is unique to its own chapter. 

Styles
Styles apply various text formatting attributes to text. Paragraph styles defines 
all character and paragraph specific text formatting attributes. Character styles 
define character specific attributes and are generally applied after paragraph style 
application. An example of a Character style would be application of “bold” or 
“italics”. Table Styles define formatting attributes for tables.

Template
An InDesign document that has been prepared by a production artist for 
automatic page composition using the Typefi Designer plug-ins.

Typefi Borders
The visual appearance of Typefi Frames and Element Prototypes and Instances 

Typefi Designer
Plug-ins for Adobe InDesign that enable production artists to develop intelligent 
layouts, without sacrificing professional design quality or requiring complex 
coding. By embedding layout rules and dynamic elements directly into InDesign 
templates, designs can be rapidly prototyped and adjusted to accommodate 
highly variable content.

Typefi Engine
Typefi Engine brings high volume throughput and fast processing to high-quality, 
dynamic page composition using Adobe InDesign Server. The Engine uses both 
rules-based and template-driven page composition.
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Typefi Elements
Typefi Elements are dynamic building blocks consisting of text and graphic 
components that are automatically placed, resized and positioned during 
automated pagination. Elements are designed once and reused many times with 
varying data throughout pagination process.

Variant
A variation of a Floating Element. A variant has its own set of layout rules that 
control variant selection and placement during page composition and inclusion of 
additional data.

Typefi Fields
Typefi Fields are content place holders that can be included at Project, Section or 
Element level. Project level fields are automatically populated through pagination, 
Section fields are consistent throughout a individual Typefi Section, Element fields 
are specific to the element occurrences throughout the paginated documents.

Typefi FileManager
A small Java-based helper application that facilitates all file transfers to and 
from the Typefi Publish Server. It further monitors publishing jobs initiated from 
Microsoft Word. Without this application no communication between user 
workstations (client) and Typefi Publish Server takes place.

Typefi Job Options
Typefi Job Options define which extracted Typefi sections, conditions, templates 
scripts etc. and must be applied during the composition process.

Typefi Publish Server
Web-based interface that makes it easy to setup publishing projects, manage 
project content and monitor the Typefi Publish workflow. From the server projects 
and their assets (templates, content, images, job options, jobs) can be defined, 
accessed or monitored throughout the publishing cycle.
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Typefi project
The whole of a publication, from content to template to finished artwork. Typefi 
projects are setup from the Typefi Server and provide access to related project 
templates, content, images, job options and jobs 

Typefi Publish
Typefi’s professional platform developed for design-driven automated publishing. 
Built on industry standard tools and technologies, Typefi Publish delivers a scalable 
solution for authoring and publishing more efficiently and cost effectively, without 
sacrificing design or typographic quality

Typefi Sections
Sections are distinct parts of a publication e.g. Table of Contents, Front Cover, 
Chapter, Division, Part. Typefi Sections control which page design sequence is used 
during the automated pagination process as content is flowed into pages. For 
instance a first page of a new Chapter might have a different design from following 
pages.

Typefi Template
Adobe InDesign template prepared with Typefi Designer. This template provides 
all the dynamic building blocks required for automated pagination and defines 
how XML is generated for content run-in.

Typefi Writer
Add-in for Microsoft Word that makes the mark-up of Word documents for use 
with Typefi Publish a simple process. A Typefi menu and Typefi tools are added to 
the familiar Word interface that enable an on-the-fly conversion from Word to XML 
as editorial content is checked back into the server-based repository by an author 
or published to Typefi Publish directly from Word.

XML
Extensible Markup Language..
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